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электродинамического моделирования FEKO.  
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больших электрических размеров. В книге рассмотрены разные аспекты методов расчета и 
установок опций, во время черчения и моделирования рупорных, печатных, а также 
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1.Введение 
 
 

Обзор САПР электромагнитного моделирования излучаемых 
структур 

 
В последние десятилетия продолжается интенсивное развитие систем 

автоматизированного проектирования (САПР) радиоэлектронной аппаратуры 
(РЭА). Современная радиоаппаратура всё более явно делится на две части: 
СВЧ часть и систему цифровой обработки. Одновременно с цифровой 
частью, можно отметить возрастание роли СВЧ РЭА. Данная тенденция 
обусловлена большим количеством систем, функционирующих на СВЧ: 
мобильная связь, навигация (GPS, ГЛОНАС), спутниковое телевидение, 
телекоммуникационные системы, системы специального назначения и т.д. С 
другой стороны, многие вопросы функционирования радиосистем, например, 
электромагнитная совместимость различных подсистем, должны решаться 
методами, характерными  для диапазона СВЧ. Поэтому, если еще несколько 
десятилетий назад аппаратура СВЧ воспринималась почти исключительно 
как аппаратура специального назначения, то теперь это совсем не так. Такое 
расширение области применения СВЧ РЭА отразилось на развитии 
соответствующих САПР.  

Начиная с девяностых годов прошлого столетия, стали появляться 
первые программы проектирования, ориентированные на СВЧ диапазон 
(Touchstone, Libra). Они отличались сравнительной простотой 
математического обеспечения и текстовым описанием исследуемой схемы. 
Последующее развитие САПР СВЧ было связано с совершенствованием 
интерфейса, а также с переходом к электродинамическому анализу 
устройства. Здесь можно назвать САПР Microwave Office фирмы Applied 
Wave Research, в которой сочетаются электродинамический анализ 
устройства (EM Sight) с его представлением в виде набора базовых 
элементов (Schematic). Следует отметить, что система Microwave Office 
содержит также практически полный набор инструментов, характерных для 
низкочастотной САПР, таких как нелинейный анализ схемы, её оптимизация, 
анализ чувствительности, статистический анализ. Здесь видна тенденция к 
созданию интегрированных САПР, поддерживающих весь цикл 
проектирования РЭА вплоть до изготовления схемы. В ряду таких систем 
необходимо отметить Advanced Design System (ADS), содержащую блок 
электродинамического анализа ADS Momentum.  

Системы Microwave Office и ADS не являются в полной мере системами 
трехмерного электродинамического моделирования, так как они 
ориентированы на анализ многослойных печатных схем. Такие системы 
называют также 2.5-мерными системами. Максимальной универсальностью с 
точки зрения решения трехмерных задач электродинамики обладают такие 
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системы как High Frequency System Simulator (HFSS) [3] и Microwave Studio 
(MWS) [4].  

В современных САПР реализуются разные математические методы. 
Среди них можно отметить прямые методы решения граничных задач, такие 
как метод конечных элементов (МКИ) и метод Finite Difference Time Domain 
(FDTD). Отличительной и наиболее привлекательной их чертой является 
универсальность, то есть возможность анализировать практически любую 
структуру. Платой за универсальность являются большие затраты 
компьютерных ресурсов. С точки зрения пользователя наиболее 
существенным недостатком является большое время необходимое для 
анализа СВЧ структур. Причина этого обусловлена дискретизацией 
пространства, лежащей в основе МКИ и FDTD. Количество элементов 
разбиения определяет размерность решаемой задачи и в методах МКИ и 
FDTD оно является максимально возможным из всех известных методов. 
Отметим, что МКИ используется в HFSS, а FDTD в CST MWS. 

 
 
Альтернативным направлением в решении задач электродинамики 

являются непрямые методы. Среди них следует отметить метод моментов 
(МОМ). Отличие его от упомянутых выше подходов состоит в том, что 
численное определение поля основывается на аналитическом решении 
некоторой ключевой задачи, а именно задачи о возбуждении структуры 
элементарным источником тока. Такое решение в математике получило 
название функции Грина. МОМ оказывается эффективным, если функция 
Грина может быть записана аналитически в простой форме. В этом случае 
дискретизации подвергается уже не пространство, а лишь поверхность, что 
сильно снижает размерность задачи. К сожалению, функция Грина может 
быть достаточно просто найдена лишь для ограниченного числа структур. К 
ним можно отнести плоскослоистые структуры и свободное пространство. 
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По этой причине именно для таких структур были разработаны САПР на 
основе МОМ. Данный метод используется в следующих системах: Microwave 
Office, ADS, FEKO. К числу таких систем следует отнести программу ЭДЭМ 
(Электродинамика экранов из металла), автор А.Г.Давыдов[5].  

Особое место среди задач, решаемых САПР РЭА занимают задачи 
излучения и рассеяния электромагнитных волн. Их отличие от задач анализа 
печатных или волноводных схем состоит в необходимости определения поля 
в области больших электрических размеров (под электрическим размером 
понимается отношение геометрического размера к длине волны в свободном 
пространстве). Дискретизация больших областей порождает задачи огромной 
размерности. Поэтому использование таких методов, как МКИ и FDTD здесь 
заведомо неэффективно. Более того, часто оказывается неэффективным 
существенно более экономичный МОМ. В этом случае строгие методы 
электродинамики необходимо дополнить, так называемыми, 
асимптотическими методами: физической оптики (ФО), геометрической 
теории дифракции (ГТД) и т.д. Гибридные подходы, использующие ФО и 
ГТД, реализованы в системе FEKO. 
 Программа FEKO [1,2] предназначена для решения широкого круга 
задач, связанных с проектированием СВЧ устройств и антенн, рассеянием 
электромагнитных волн на сложных объектах, распространением радиоволн 
в городских условиях и т.д.  
 Главной особенностью программы FEKO, отличающей ее от других 
коммерческих программ электромагнитного проектирования, является 
удачное сочетание базового метода моментов (МОМ) [8], с приближенными 
аналитическими методами: методом физической оптики (МФО) [9,10] и 
однородной теории дифракции (ОТД) [9]. Такое сочетание позволяет 
преодолеть главный недостаток программ компьютерного моделирования 
высокочастотных структур: большие затраты ресурсов при моделировании 
объектов с размерами много большими длины волны. В результате 
появляется возможность решения таких задач, как рассеяние радиоволн на 
самолете или корабле и распространение радиоволн в городских условиях с 
хорошей точностью.  
     Остается важным вопрос, насколько точны результаты расчетов на 
электродинамическом уровне. Имеется ряд путей проверки точности расчета: 

• сравнение с точными результатами, если они доступны 
• сравнение с другой программой, которая основана на другом методе 
вычисления 
• сравнение с измеренными результатами 
• правдоподобие, например отрицательные реальные входные полные 
сопротивления не существуют.      
• Выполнение базовых физических законов, таких, как закон 

сохранения энер-гии, теорема взаимности  и т.д. 
   В последнее время опыт СВЧ проектирования все больше обогащается и 
приводит к тому, что на многих этапах проектирования вывод из цикла 
экспериментальных работ не ухудшает конечный результат. Это означает, 
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что точное моделирование приведет, в конце-концов, к полностью 
компьютизированному проектированию радиотехнических систем большой 
сложности. 

Опыт внедрения САПР СВЧ показал, что лучшей программой для 
разработчика  становится та, которую он лучше всего знает, быстрее 
осваивает. Жизнь описания программ соизмерима с жизнью очередной 
версии программы и сокращается до года. Поэтому, представляя эту книгу, 
мы отмечаем, что не вносим в неё теоретический материал, а ограничиваемся 
тщательным описанием особенностей программы и базовыми понятиями.  

          
   Сложная конфигурация радиолокационной системы и размеры вертолета, значительно большие длины 
волны, требует применения нескольких методов расчета антенной системы 
 

В настоящее время существует несколько книг, которые можно 
рассматривать в качестве пособий для пользователей САПР Microwave Office 
[4] и HFSS [5]. Необходимо иметь в виду, что описание программы, даже 
такой многосторонней, как FEKO, никоим образом не может 
рассматриваться как альтернатива стандартным курсам электродинамики и 
техники СВЧ, которые позволяют получить действительно глубокие знания 
по данному кругу вопросов. Наша задача состоит в том, чтобы, опираясь на 
эти дисциплины, познакомить читателя с вопросами, которые получают 
визуальное и ясное подтверждение в процессе проектирования и изучения 
программы. При этом пояснения физических основ процессов, основанные 
на достаточно сложных математических преобразованиях в книге 
практически отсутствует. Большинство результатов берется в качестве 
готовых выводов. По этой причине материал книги носит описательный 
характер. Мы надеемся, что данная книга будет удобным дополнением к уже 
имеющейся литературе по САПР СВЧ РЭА, которое окажется полезным для 
студентов радиотехнических специальностей и инженеров, 
специализирующихся в области проектирования широкого класса устройств 
СВЧ и антенн. 

Работа над книгой распределилась следующим образом. Д.т.н. Банков 
С.Е. написал Введение, Разделы 3.1-3.5. Сбор и перевод подготовительных 
материалов выполнил к.т.н. Курушин А.А. Главы 2, 4-8 написаны авторами 
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совместно. Авторы благодарят к.т.н. Давыдова А.Г., н.с. Папилова К., д.т.н. 
Юханова Ю.В., к.т.н. Касьянова А.О., к.т.н. Кисель Н.Н. и др. сотрудников 
кафедры АУ ТРТИ (г. Таганрог) за большую помощь и обсуждение 
рукописи. 

Отзывы просим направлять в адрес ЗАО «НПП «РОДНИК», по эл. 
адресам: anisimov@rodnik.ru, kurushin@mail.ru. 

 

2. Характеристика системы FEKO 
 

    Название программы FEKO происходит от немецкой фразы 
«FEldberechnung bei Korpern mit beliebiger Oberflache» (Расчет поля с учетом 
тел произвольных форм). Название раскрывает, что FEKO может 
использоваться для расчета электромагнитных волн в пространстве, 
включающем объекты произвольных форм. 
    Базовым методом FEKO является метод моментов (MoM). Метод 
моментов – это способ решения интегральных уравнений (иногда его 
называют методом Галеркина или Бубнова-Галеркина). В отличие от метода 
конечных элементов [3], где пространство расчета замкнутое и ограниченное, 
метод, в основе которого лежит решение интегральных уравнений, не 
ограничивает величину задачи. Метод МоМ – базовый, но не единственный 
метод, реализованный в FEKO (рис. 2.1). 

 
Рис. 2.1. Применение различных методов, реализованных в FEKO для 

решения различных задач 
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     Электромагнитные поля вычисляются после расчета токов на проводящих 
поверхностях и эквивалентных электрических и магнитных токов на 
поверхности диэлектрического твердого тела.  
    Токи находятся, используя линейную комбинацию базовых функций, а 
коэффициенты при них получаются, решая систему линейных уравнений. 
Как только распределение тока найдено, может быть рассчитаны ближнее 
поле, дальнее поле, диаграмма направленности излучения, направленность и 
входное сопротивление антенн. 
    Задачи, включающие большие объекты, обычно решаются с помощью 
метода физической оптики (PO) и её вариантов, или используя однородную 
теорию дифракции (UTD). В комплексе FEKO (рис. 2.2) эти решения 
объединяются с MoM на уровне матрицы взаимодействий. 

Рис. 2.2. Композиция комплекса FEKO 
 

     Этим делается существенный шаг к решению задач, когда 
рассматриваемый объект слишком большой (в терминах длин волны) чтобы 
его моделировать методом MoM, но слишком маленький, чтобы применять 
только асимптотическую аппроксимацию UTD. Используя гибридизацию 
методов MoM/PO или методов MoM /UTD, критические области структуры 
могут рассматриваться, используя MoM, а остающиеся области (обычно 
большие, плоские или искривленные металлические поверхности) 
используют аппроксимацию PO или UTD. 
    В FEKO предусмотрен вывод сигналов во временной области, для чего в 
ней имеются гармонические источники. Преобразования из частотной во 
временную область выполняется с помощью оператора ejt. Различные 
источники  позволяют описывать возбуждение как падающую плоскую 
волну, напряжение в разрыве структуры (между проводными сегментами), и 
магнитным кольцевым током (TEM-Frill), которым может быть 
смоделирован коаксиальный фидер. 
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    Программа CADFEKO содержит основной интерфейс комплекса и исполь-
зуется, чтобы управлять решением задачи, черчением сложной геометрии, 
импорта и экспорта отдельных ее частей. С другой стороны, ту же задачу, и 
более гибко, можно решить в редакторе EditFEKO. Программа PREFEKO 
обрабатывает и готовит входной файл (*.fek) для программы FEKO, которая 
является фактическим кодом вычисления поля. PREFEKO дает возможность 
пользователю создать сложные конфигурации простой командой, например 
спираль, состоящую из сегментов провода, или плоские, цилиндрические или 
сферические плоскости, состоящие из треугольников. 
  Эта геометрия может также быть создана в программе CADFEKO.  
     Ядром программы FEKO является алгоритм решения трехмерных задач 
электродинамики в частотной области. Для решения электродинамических 
задач используются три метода, отмеченных выше.  
 

Метод моментов 
 

 Метод моментов (MОM) предусматривает следующие этапы решения 
электродинамической задачи. Металлические элементы анализируемой 
структуры заменяются эквивалентными электрическими поверхностными 
токами. Затем решается задача возбуждения окружающей среды данными 
токами. При этом среда может быть сложной, то есть может содержать 
магнито-диэлектрические слои. 

Решение задачи возбуждения среды осуществляется с помощью 
аппарата тензорных функций Грина. После того, как задача возбуждения 
решена и найдено электрическое поле, используются граничные условия на 
металлических элементах. Это условие используется для определения 
эквивалентных токов. Важным моментом решения является разбиение 
поверхности металла на элементарные площадки и аппроксимация 
электрического тока в пределах площадки. Пример разбиения показан на рис. 
2.3.  

 
Рис. 2.3. Микрополосковая антенна, состоящая из 4-х плат, разбитая на 

элементы программой Mesher 
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  В программе FEKO для аппроксимации тока используются постоянные, 
линейные и треугольные функции, которые принято называть базисными 
функциями. Граничные условия на поверхности металла в МОМ 
выполняются приближенно, а именно в нескольких точках в пределах 
каждой элементарной площадки (строго эти условия должны выполняться во 
всех точках). В результате задания граничных условий в дискретных точках 
получается система линейных алгебраических уравнений (СЛАУ) 
относительно коэффициентов при базисных функциях, которые имеют смысл 
амплитуд токов, текущих в пределах элементарной площадки. Данная СЛАУ 
решается ЭВМ с помощью известного метода исключения Гаусса.  
 В программе FEKO элементарная площадка имеет треугольную форму, 
что позволяет хорошо описывать, в том числе и искривленные поверхности. 
 Точность МoМ тем выше, чем меньше размер площадки разбиения. Из 
опыта расчета найдено, что для получения приемлемой точности размер 
площадки не должен превышать /10, где  длина волны в свободном прост-
ранстве. Количество уравнений в СЛАУ равно числу элементарных 
площадок N, которое неизбежно увеличивается при увеличении размеров 
анализируемого объекта или при увеличении частоты. Поэтому легко 
увидеть, что непосредственное решение задачи типа рассеяния радиоволн на 
автомобиле с помощью МoМ потребует решения СЛАУ огромной 
размерности. На практике оно просто невозможно из-за ограниченной 
оперативной памяти ЭВМ.  

 
Метод физической оптики 

 
    Метод физической оптики (МФО) – это классический метод 
приближенного решения электродинамических задач, который еще 
называется методом Кирхгофа.  

 
Рис. 2.4. Антенная система радиолокационной станции на вертолете, 

анализируемая методами MoM и MФО 
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   В рамках этого метода задача поиска токов на металлических поверхностях 
исключается, а ток приближенно вычисляется через магнитное поле 
падающей на объект волны. Конкретно его полагают равным удвоенному 
касательному магнитному полю падающей волны. Далее рассеянное поле 
вычисляется с помощью аппарата функций Грина через заданное 
распределение токов. МФО хорошо работает при решении задач рассеяния 
плоских волн на объектах больших размеров. При уменьшении размеров 
объекта аппроксимация тока магнитным полем падающей волны становится 
неверной. 

 
Однородная теория дифракции 

 
 Однородная теория дифракции (ОТД) – более современный метод 
приближенного решения задач рассеяния волн на больших объектах. В 
рамках этого метода поверхность объекта представляется набором плоских 
многоугольников, имеющих общие ребра. Поле, рассеянное 
многоугольником, разделяется на две составляющие: геометро-оптическая 
часть, порожденная плоской поверхностью и поле порожденное ребрами. 
Метод ОТД считается более точным, чем МФО и имеет примерно те же 
пределы применимости. 
 

Виды структур, анализируемые программой FEKO 
 

 Программа FEKO позволяет анализировать сложные устройства на 
основе СВЧ линий передач: полосковых, микрополосковых линий и 
волноводов.  

 
Рис. 2.5. Структура микрополоскового фильтра, работающего по принципу 

дуплексного и диплексного фильтра 
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   Пользователь описывает геометрию структуры (топологию проводников и 
структуру слоев) и материальные параметры (магнитные и диэлектрические 
проницаемости сред, проводимости проводников), определяет расположение 
и вид портов. Программа с помощью МoМ находит токи на проводниках, на 
основе которых определяются внешние параметры устройства: матрицы 
рассеяния, Y, Z параметры и т.д. Программа может анализировать 
многослойные печатные схемы. Анализ проводится с учетом конечных 
потерь в элементах конструкции, то есть предполагается, что проводники 
имеют конечную проводимость, а диэлектрические слои ненулевой тангенс 
угла потерь. На рис. 2.5, 2.10 показаны примеры микрополосковых фильтров 
и их частотные характеристики, полученные с помощью программы FEKO.  

 

 
Рис. 2.6. Рассчитанные S-параметры микрополоскового фильтра 

 
    Программа FEKO позволяет разбивать структуру как на однородные, с 
одинаковым размером, а также на ячейки, сильно отличающиеся по размеру. 
Это позволяет создавать структуры, которые по форме значительно 
отличаются от традиционных линий, поворотов, т.е. иметь нетрадиционную 
форму, и создать, таким образом, фильтры с псевдо дуплексной и диплексной 
характеристиками, как показано в рассмотренном примере.  
 

Электромагнитная совместимость  
 

 FEKO позволяет рассчитывать поля, наводимые информационными 
линиями (коаксиальные кабели, витые пары, двухпроводные линии и т.д.), а 
также их взаимное влияние. Кроме того, подпрограмма CableMod содержит 
средства, поддерживающие решение задач прохождения информационных 
сигналов через информационные линии передачи. На рис. 2.7 показан пример 
решения задачи о связи проволочных линий над металлической плоскостью 
конечного размера. 
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Рис.2. 7. Связанные линии передачи над металлической плоскостью сложной 
формы 

 
Одиночные планарные и объемные излучатели 

 
 Планарные излучатели, например, печатные дипольные и 
микрополосковые антенны  (рис. 2.8) на основе многослойных магнито-
диэлектрических подложек могут моделироваться с помощью программы 
FEKO. Задачи данного класса решаются с помощью МoМ.  
   Для повышения эффективности решения используется специальный 
алгоритм вычисления функции Грина многослойной среды. В программе 
также предусмотрена возможность учета конечных размеров подложки, что 
является существенным фактором в ряде случаев. Вместе с излучающей 
структурой одновременно может анализироваться схема питания антенны. 
 

 
Рис. 2.8. Антенна излучатель – бабочка в диэлектрической среде 
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     FEKO позволяет рассчитать параметры антенны как СВЧ 
многополюсника (матрицы S,Y,Z) и как излучателя: диаграмма 
направленности в дальней зоне, коэффициент направленного действия, 
поляризационные характеристики.  

 
Рис. 2.9. Частотные характеристики входного импеданса антенны 

 
    На рис. 2.10 показана рупорная антенна с волноводным питанием, и его 
диаграмма направленности. На рис. 2.10 показано также распределение 
интенсивности электрических токов на поверхности антенны. 

 
Рис. 2.10. Рупорная антенна 

    
    FEKO предусматривает разные способы возбуждения антенн: 

- источник напряжения, включенный в проволочный элемент или между 
элементами сетки; 

- коаксиальный возбудитель; 
- источник тока; 
- плоская волна. 

 Объемные излучатели типа открытого конца металлического волновода 
или рупора также могут анализироваться с помощью программы FEKO.  
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Решетки излучателей 
 Одиночные излучатели часто используются в антенной технике в 
качестве элементов решеток. Поэтому важной задачей является их 
эффективное моделирование, учитывающее эффект взаимной связи 
излучателей через свободное пространство. На рис. 2.11 показана антенная 
решетка для базовой станции, состоящая из шестнадцати вибраторных 
излучателей и 32 проволочных экранов, которая моделировалась с помощью 
программы FEKO. 

 
Рис. 2.11. Фазированная антенная решетка, реализующая 

функции смарт-антенны, перестраиваемой диаграммы 
направленности базовой станции системы связи 

 
Зеркальные антенны с облучателями 

 
 Удачным сочетанием МОМ и МФО является анализ 
зеркальной параболической антенны с облучателем в виде 
рупора (рис. 2.12). Особенностью анализа такой структуры 
является то, что малоразмерные элементы (облучатель) 
моделируются с помощью МОМ, а параболическое зеркало 
больших электрических размеров описывается с помощью 
МФО. 

 
Антенны мобильных телефонов и расчет поля в голове 

пользователя 
 

 Большой интерес представляют на современном этапе задачи 
оптимизации антенн мобильных телефонов, а также расчет поля, наводимого 
такой антенной в теле человека. Основную сложность представляет здесь 
расчет поля в голове человека, поскольку последняя с точки зрения 
электродинамики является сложной структурой, состоящей из различных 
сред с потерями. 
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Рис. 2.12. Зеркальная антенна с облучателем в виде рупора 

 
Для анализа подобных структур в программе FEKO используются метод 
эквивалентных поверхностных токов и метод объемных токов поляризации. 
Сочетание этих методов позволяет осуществлять расчет электромагнитного 
поля в салоне транспортного средства и голове человека с достаточно 
хорошей точностью. На рис. 2.13, 2.14 показаны модель человека с 
мобильным телефоном, и зависимости напряженности электрического поля в 
биологическом объекте (голове) в зависимости от расстояния от поверхности 
объекта. Кривые получены методом МОМ и экспериментально. 
Биологический объект представляет собой сферу радиусом 0.1 м, с прони-
цаемостью 42 и проводимостью 0.855 См/м. Расчеты хорошо совпадают с 
экспериментальными данными, причем на больших расстояниях от 
поверхности программа FEKO дает лучшее совпадение с экспериментом. 
    В радиолокации важной задачей является дифракция электромагнитной 
волны на объекте (самолет, корабль, автомобиль и т.д.) и определение его 
эффективной площади рассеяния. В подобных задачах наиболее полно 
раскрываются преимущества программы FEKO, использующей 
приближенные методы решения электродинамических задач для объектов 
больших электрических размеров (все перечисленные объекты относятся 
именно к классу таких объектов). 
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Рис. 2.13. Рассчитанное ближнее поле пользователя сотового телефона, 

находящего в замкнутом корпусе транспортного средства 
 

   С методической точки зрения к такому же классу задач относится, 
например, задача об излучении антенны мобильного телефона установленной 
на крыше автомобиля. Данная структура содержит относительно 
малоразмерные элементы: антенна и прилегающая к ней часть крыши 
автомобиля и элементы с большими размерами: собственно автомобиль. На 
рис. 2.14 показана схема, поясняющая решение такой задачи. Собственно 
антенна и часть крыши автомобиля описываются методом МoМ.  

 
Рис. 2.14. Структура антенны, установленной на корпусе транспортного 

средства. Указаны лучи распространения радиоволн, моделируемые 
методом оптической физики 
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    Оставшаяся часть крыши описывается в приближении заданных токов 
МФО и наконец рассеяние остальными элементами конструкции автомобиля 
моделируется в приближении ОТД, то есть вычисляются траектории лучей, 
падающих на плоские поверхности и кромки, а далее и поля рассеянные 
этими поверхностями и кромками. 
    Описание такой сложной структуры осуществляется в FEKO с помощью 
так называемых карт геометрии, то есть специальных подпрограмм, которые 
пишутся пользователем на внутреннем языке FEKO, имеющем достаточно 
простую и естественную структуру. Сложные конфигурации целесообразно 
описывать также с помощью других программ, предназначенных для 
формирования трехмерных сеток, в CADFEKO. Программа FEKO допускает 
импорт стандартных файлов, описывающих трехмерные структуры и их 
разбиения на сетки (ACIS, Parasolid, IGES, SAT, DXF).  
    Описание структуры в виде карт на первый взгляд кажется архаичным 
подходом, идущим от традиций командной строки DOS. Однако такое 
построение геометрии, а затем исполнительных карт имеет и свои 
преимущества. Так, возможно более точно, безошибочно проконтролировать 
и найти ошибки. Текст задания можно проверять отдельно от графического 
редактора, особенно важно это при создании сложных структур со многими 
источниками возбуждения. Проектировщик, по сути имеет перед собой текст 
задания, который он может сразу же откорректировать. Очень важен такой 
подход при оптимизации структуры по заданным характеристикам. Задание в 
виде текста дает универсальность, поскольку все задание записано в 
текстовом файле, и не нужно обращаться к различным программам анализа и 
оптимизации, как сделано, например, в программе HFSS [3,17]. 

 
    Визуализация результатов выполняется в FEKO на этапе 
постпроцессорной обработки данных. Это может быть: 

- распределение электрических токов на металлических поверхностях; 
- распределение поля в объеме; 
- параметры многополюсников (матрицы S,Y,Z и т.д.); 
- диаграммы Смита; 
- параметры антенн (диаграмма направленности, коэффициент направ-

ленного действия, поляризационные диаграммы); 
- относительная поглощенная мощность (для случая биологических 

объектов); 
- визуализация лучей (при решении методом ОТД); 
- реакция цепей во временной области (при анализе переходных 

процессов). 
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Рис. 2.15. Рассчитанные S параметры выводимые на диаграмму Смита 

     
    Программа FEKO является программой, в которой сосредоточены все луч-
шие качества, достигнутые и развитые в настоящее время в программах 
проектирования СВЧ устройств. Точный метод моментов с добавленными 
методами оптической оптики открывает широкие возможности расчета 
большеразмерных антенных систем, в присутствии больших металлических 
объектов со сложной формой.  
    Изящный и мощный метод построения геометрии, описание различных 
возбуждаемых источников, дискретных, волноводных и в виде планарных 
волн, позволяет рассчитывать управляемые диаграммы направленности 
антенных фазовых решеток. Программа FEKO легка для освоения, имеет 
возможности контроля точности описания задачи. Фирма-производитель 
EMSS [1,2] дает возможность оценить мощность программы, давая 30-
дневную лицензию для работы на полноценной версии программы, и её 
можно рекомендовать для обучения студентов и разработчиков СВЧ 
устройств. 
 
 

3.Метод моментов - базовый метод моделирования 
в FEKO 

 
     Если сформулировать операторную задачу, которую можно решить с 

помощью МОМ [8], в виде: 

    gfL )(       (3.1), 
то в этом выражении можно считать, что L(f) – оператор, роль которого 
выполняют дифференциальные уравнения Максвелла, f – токи, текущие по 
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проводящим поверхностям, а g известная функция, описывающая источники 
возбуждения.  
     В электродинамике чаще используются интегральные операторы. О том, 
как они получаются, будем говорить ниже. Сейчас же рассмотрим основную 
идею МОМ. При этом чисто математические вопросы об области 
определения оператора L(f), сходимости МОМ оставляем в стороне, 
рассматривая только конструктивную часть метода. Под оператором в 
математике понимают действие, ставящее в соответствие функции функцию. 
Наиболее простым примером оператора может служить дифференцирование, 
которое исходной функции ставит в соответствие другую функцию – ее 
производную. Другой класс операторов – интегральные. Среди них наиболее 
известным является преобразование Фурье: 

  




 dxexffL xi)()(       (3.2) 

 Нетрудно видеть, что оператор из (3.2) ставит в соответствие исходной 
функции f(x) новую функцию, которая называется Фурье образом и 
определяется правой частью (3.2). 
  Для компактного изложения схемы МОМ необходимо привлечь 
некоторые понятия из функционального анализа. К числу таких понятий 
относится скалярное произведение. Пусть мы имеем две функции f и g. Их 
скалярное произведение gf ,  должно удовлетворять следующим условиям: 

fggf ,,  ,       (3.3) 
 

hghfhgf ,,,   ,    (3.4) 
 

f f* ,  0 , если  f  0 ,      (3.5) 
 

f f* ,  0 , если  f  0 ,      (3.6) 
 где    и   - постоянные, а * означает комплексное сопряжение. 
Определение скалярного произведения неоднозначно. Его можно строить по-
разному. Часто под скалярным произведением двух функций определенных в 
области S понимают следующий интеграл: 

   
S

fgdSgf , .       (3.7) 

 Легко видеть, что определение (3.7) удовлетворяет всем условиям (3.3)-
(3.6). Однако нам ничего не мешает добавить в (3.7) некоторую известную 
функцию, которую называют весовой функцией w. Тогда скалярное 
произведение изменится следующим образом: 
   

S
wfgdSgf , .       (3.8) 
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 Оно по-прежнему удовлетворяет всем условиям (3.3)-(3.8). Свободу в 
выборе скалярного произведения можно эффективно использовать, чтобы 
строить более эффективные алгоритмы решения уравнения (3.1). Перейдем 
далее непосредственно к МОМ. 
 Представим неизвестную функцию f  (токи) в виде разложения следую-
щего вида: 
   

n
nnAf         (3.9) 

где n  известные функции, получившие название базисных функций, а nA  
неизвестные коэффициенты. Пусть функция f определена в некоторой 
области S. Подставим формулу (3.9) в (3.1): 
    

n
nn gLA )(        (3.10) 

 Введем еще одну систему функций n , которые назовем тестовыми 
или пробными функциями. Умножим (3.10) последовательно на пробные 
функции с разными номерами и вычислим соответствующие скалярные 
произведения: 
    

n
mnmn gLA  )( .     (3.11) 

 Итак, в формуле (3.11) мы получили систему линейных алгебраических 
уравнений (СЛАУ) относительно неизвестных коэффициентов mA . Если 
решить эту СЛАУ и найти mA , то мы автоматически находим искомую 
функцию f. Собственно говоря, в этом и состоит метод моментов, который 
позволяет свести исходную операторную задачу к СЛАУ, которые 
эффективно решается в FEKO. 
 Запишем СЛАУ (3.11) в матричной форме: 
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   (3.12) 

 Используя (3.12), можно записать выражение для искомой функции f: 
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В формулах (3.9)-(3.12) мы умышленно не  указывали пределов сумми-
рования. Дело в том, что, строго говоря, для точного описания неизвестной 
функции f требуется бесконечный набор базисных функций. На практике 
приходится ограничиваться конечной суммой: 
   

   



N

n
nnN Af

1
 .       (3.14) 

 При этом предполагается, выполнение следующего соотношения: 

   



N

Ff N )lim( ,       (3.15) 

где F – точное решение уравнения (3.1). Формула (3.15) подразумевает, что 
предел существует и равен решению (3.1). В этом случае говорят о том, что 
метод сходится. Поскольку функция F неизвестна, то в качестве критерия 
сходимости соотношение (3.15) использовать нельзя. На практике 
используют следующее соотношение: 

  




N
ff NN ,0)lim( 1        (3.16) 

которое утверждает лишь то, что итерационный процесс сходится и функция 
f при увеличении N меняется всё меньше, что не всегда означает, что 
сходится она к точному решению уравнения (3.1). Обоснование равенства 
(3.15) относится к доказательной части МОМ и мы его рассматривать не 
будем.  
 Для остановки итерационного процесса, то есть выбора N можно 
использовать соотношение следующего типа: 
   

S
NN dSff 2

1 ,       (3.17) 

где   - некоторое наперед заданное число, называемое критерием остановки. 
Формула (3.17) не является единственно возможным правилом для выбора N. 
Более того, часто на практике применяют другие критерии, но смысл их тот 
же самый: некоторая величина на N шаге должна стать меньше некоторого 
фиксированного значения. 
Базисные и тестовые функции. Существует большое разнообразие 
используемых базисных функций. Метод моментов не накладывает на 
систему базисных функций таких жестких требований, как ортогональность. 
Достаточно удовлетворить требованию полноты системы функций, которое 
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означает, что бесконечный ряд вида (3.9) сходится в функциональном 
пространстве, в котором определена функция f.  
 Существуют два подхода к выбору базисных функций. Первый подход 
ориентирован на решение конкретной задачи. В этом случае базисные 
функции выбираются так, чтобы быть максимально похожими на точное 
решение уравнения (3.1). Для этого приходится учитывать априорную 
информацию о свойствах решения. Возьмем в качестве примера оператор 
следующего вида: 
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        (3.18) 

 Уравнения вида (3.18) часто встречаются в теории полосковых линий 
передачи, а также при анализе волноводных диафрагм. Известно точное 
решение уравнения (3.18): 
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    (3.19) 

 Из (3.19) следует, что функция f(x) при 1x  имеет особенности типа 

x
1 , определяемые первым множителем. Второй сомножитель из (3.19) 

описывает некоторую гладкую функцию. Присутствие особенностей на краях 
интервала [-1,1] относится к априорной информации о поведении функции f 
и может быть использовано для правильного выбора базисных функций. 
Например, удачным примером правильного выбора базисных функций 
является следующая система: 
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 .        (3.20) 

 Мы видим, что базисные функции определены на всем интервале 
задания оператора L(f) и они стремятся к бесконечности на краях интервала 
также как строгое решение. Подставим выражение (3.20) в (3.9) и приравняем 
его строгому решению (3.19). В результате имеем следующее соотношение: 
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 Сокращая общие множители, получаем: 
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 Из формулы (3.21) видно, что задача определения неизвестных 
коэффициентов nA  эквивалентна разложению функции, стоящей в правой 
части (3.21), в ряд Фурье. Так как эта функция гладкая, то коэффициенты её 
Фурье-разложения убывают не медленнее, чем 2

1
n

.  

 Совсем другая картина наблюдается при ином выборе системы 
базисных функций. Определим ее следующим образом: 
  )cos()( nxxn   .        (3.22) 
 Проделав операции аналогичные предыдущим, получаем равенство 
эквивалентное (3.21): 
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 Мы вновь имеем дело с разложением в ряд Фурье. Однако сейчас нам 
нужно представить рядом функцию с особенностями. Без доказательства 
отметим, что в этом случае коэффициенты nA  убывают как 

n
1 , то есть 

намного медленнее чем раньше. С практической точки зрения это означает, 
что для удовлетворения критерию (3.18) во втором случае придется взять N 
много большее, чем в первом. Платой за это будет большой порядок 
решаемой СЛАУ и, следовательно несравненно большие затраты 
компьютерного времени и памяти. 
 К сожалению, обычно платой за быструю сходимость МОМ является 
потеря универсальности. Действительно, в каждой конкретной структуре 
будут свои подходящие базисные функции. Поиск их является 
неформализуемым процессом, который трудно превратить в компьютерную 
программу. Поэтому разработчики программного обеспечения отдают 
предпочтение базисным функциям способным решать более широкий набор 
задач даже в ущерб сходимости решения. Это не означает, что учет 
априорной информации совсем не нашел себе применение в реальных 
системах проектирования. Это не так. Например, анализ регулярных 
полосковых линий передачи почти целиком построен на использовании 
функций (3.20). Однако при переходе к более сложным структурам 
приходится использовать другие базисные функции. 
 Примером такой универсальной системы функций являются 
импульсные функции. Они вводятся следующим образом. Для простоты 
будем считать, что функция f является функцией одной переменной x, 
заданной на некотором интервале [a,b]. Тогда этот интервал разделяется на N 
подинтервалов nS , ],[ 1 nn xxx , которые могут иметь, вообще говоря, 
разную длину nx . Тогда базисные функции определяются следующим 
образом: 

  








. ,0
, ,1

n

n
n Sx

Sx
          (3.24) 
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 Применение базисных функций (3.24) приводит к кусочно-постоянной 
аппроксимации функции f(x). На рис. 3.1 показан результат такой 
аппроксимации функции  

  
2

2

2

1

x







  

для разных N=10,25. 

  
Рис. 3.1. Аппроксимация ступенчатыми функциями 

 Коэффициенты аппроксимирующей функции равны значениям f(x) в 
центрах интервалов nS . Таким образом, для аппроксимирующей функции 
F(x) получается следующее представление: 

  



N

n
nn xxfxF

1
0 )()()(  .       (3.25) 

Недостатком импульсных функций является то, что получаемая в результате 
их использования аппроксимирующая функция разрывна. Последнее 
обстоятельство в электродинамике в ряде случаев неприемлемо, так 
разрывные функции могут порождать сингулярные поля, не отвечающие 
физической реальности. Тем не менее, рассматриваемая система базисных 
функций нашла достаточно широкое применение. 
 Из рис. 3.1 также следует правило, относящееся также ко всем другим 
системам функций. Точность решения зависит от скорости изменения 
неизвестной функции f. Это вывод верен для процедуры аппроксимации 
вообще и для МОМ в частности, так как, вообще говоря, решение по МОМ 
является аппроксимацией функции f рядом (3.9). Только коэффициенты 
аппроксимации ищутся несколько нетрадиционным путем, а именно как 
решение СЛАУ (3.12). 
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 Широко применяются в МОМ треугольные функции. В англоязычной 
литературе для них используется термин, дословный перевод которого 
звучит как «крышечные» функции. Мы будем далее использовать 
русскоязычное название для этих функций. Ниже приводится определение 
треугольной функции: 
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    (3.26) 

 При записи (3.26) предполагалось, что интервал [a,b] разбит на 
подинтервалы, которые могут иметь разную длину. На рис. 3.2 показан 
результат аппроксимации той же функции, что и раньше (кривая 1) рядом 
(3.25), в котором в качестве функций n  взяты функции (3.26) (кривая 2). 
Величина N равна 20. Кривые 3 представляют элементарные функции n . 
Из рис. 3.2 видно, что мы получаем линейно-ломаную аппроксимацию 
исходной функции, которая точнее аппроксимации импульсными функциями 
и не имеет разрывов.  
 Базисные функции одной переменной применяются для решения 
практических задач достаточно редко. Из таких применений можно отметить 
моделирование регулярных линий передачи. Задачи расчета 
многополюсников, антенн и задачи рассеяния требуют использования более 
сложных базисных функций двух переменных. Это связано с тем, что, как 
правило, роль неизвестной функции в МОМ играет распределение 
поверхностных токов, текущих по металлическому телу. Поскольку 
поверхность характеризуется двумя координатами, то и соответственно для 
описания функции, заданной на поверхности нужны базисные функции двух 
переменных. 
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Рис. 3.2. Аппроксимация треугольными функциями 

  
 Для простоты изложения будем считать нашу поверхность плоской. 
Пусть функция f определена в прямоугольной области S: 

dycbxa   , (см. рис. 3.3). Введем в этой области прямоугольную сетку, 
то есть разделим ее на элементарные прямоугольные площадки Snm: 

11  ,   mmnn yyyxxx .  

 
Рис. 3.3. Область определения функции f  

 



 28 

 Элементарные площадки не обязательно имеют квадратную форму. 
Они могут быть и прямоугольниками. Не составляет труда определить 
импульсную функцию в двумерном случае. Для нее сохраняется определение 
(3.24). Только вместо интервала nS  следует использовать область nmS . 
Аппроксимирующая функция представляется теперь в виде двойного ряда: 

 
 


N

n

M

m
nmmn yxyxfyxF
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00 ),(),(),(  .    (3.27) 

 В формуле (3.27) под mn yx 00 ,  понимаются координаты центра 
элементарной площадки.  
 Сложнее обстоит дело с треугольными функциями. В двумерном 
случае использовать термин треугольная функция, вообще говоря, не имеет 
смысла, но правильнее говорить о функциях, позволяющих получить 
линейно-ломаную аппроксимацию. К числу таких функций относится 
пирамидальная функция. Будем её называть двумерной треугольной 
функцией. Эта функция описывает пирамиду, вершина которой имеет 
координаты mn yx , . Приведем далее определение двумерной треугольной 
функции для случая одинакового шага по x и по y: 
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   (3.28) 

где  - размер элементарной площадки. 
 

 
Рис. 3.4. Двумерная треугольная функция 
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 Пирамида, соответствующая функции ),(00 yx показана на рис. 3.4. 
Результат аппроксимации двумерными треугольными функциями 
параболоида вращения, поверхность которого описывается функцией 
   2221),( yxyxf   
представленой на рис. 3.5. На этом рисунке показаны разные сечения двух 
функций (точной и аппроксимирующей), соответствующие разным коорди-
натам y. Аппроксимация проводилась в области 10,10  yx . Общее 
число элементарных N2 площадок равно 400. 

 
Рис. 3.5. Аппроксимация двумерной треугольной функцией 

 
 Из рис. 3.5 видно, что и в двумерном случае треугольные функции 
дают хорошую непрерывную аппроксимацию. 
 Обсудим теперь вопросы, связанные с тестовыми функциями. В 
качестве тестовых могут использоваться все рассмотренные выше функции. 
Здесь необходимо отметить, что когда в качестве тестовых функций 
используются функции, совпадающие с базисными функциями, то такая 
реализация МОМ имеет специальное название - метод Бубнова-Галеркина. 
Метод Бубнова-Галеркина обладает рядом замечательных свойств, 
отличающим его от общего случая МОМ, которые мы рассмотрим ниже. 
Отметим, что термин МОМ в русскоязычной литературе часто заменяется 
термином «Метод Галеркина» по имени одного из авторов. 
 В качестве тестовых функций часто используются дельта - функции. 
Последние, вообще говоря, могут использоваться и как базисные. Однако, 
считается, что они дают весьма грубое приближение и поэтому применяются 
в этом качестве редко. Поэтому дельта – функции рассматриваются 
преимущественно как тестовые.  
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 Если мы имеем интервал [a,b], разделенный на элементарные 
интервалы точками nx , то система тестовых функций n  в виде дельта – 
функций имеет следующий вид: 
  )( nn xx   .        (3.29) 
 Благодаря известному свойству дельта - функции скалярные произ-
ведения в МОМ преобразуются следующим образом: 
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 Из (3.30) видно, что СЛАУ, получаемая по МОМ  
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выражает условие точного выполнения операторного уравнения (3.1) в 
дискретных точках mx . Таким образом, использование дельта – функций 
эквивалентно поточечному выполнению равенства (3.1). Такая процедура 
получила название метод коллокации. В электродинамике этот метод чаще 
всего связан с выполнением граничных условий в ряде дискретных точек на 
некоторой поверхности. 
Метод Бубнова-Галеркина и вариационные принципы. Рассмотрим в 
данном разделе одно важное свойство метода Бубнова-Галеркина, а именно 
его связь с вариационными методами решения операторных уравнения (3.1). 
В дальнейшем изложении потребуется понятие сопряженного оператора. 
Пусть мы имеем исходное операторное уравнение 
  gfL )( .         (3.32) 

 Оператор aL  будет сопряженным оператору L , если выполняется 
следующее равенство: 
  )(,),(  aLffL  .       (3.33) 

 Пусть далее функция   удовлетворяет следующему уравнению: 

  aa gL )( .        (3.34) 
 Поставим задаче (3.32) в соответствие функционал: 
  agffgfLfZ ,,),(),(   .    (3.35) 
 Под функционалом в математике понимается операция, ставящая в 
соответствие функции (функциям) скаляр (число). Таким образом, Z – это 
просто число. Замечательным свойством функционала (3.35) является его 
вариационная устойчивость на решении операторного уравнения (3.32). 
Поясним, что под этим понимается.  
 Допустим, что 0f  - это точное решение задачи (3.32), а fff  0  - 
некоторое приближенное решение, отличающееся от точного. Тогда ),( 0 fZ  
соответствует точному решению, а ZfZ  ),( 0  соответствует прибли-
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женному решению. Величина Z  называется вариацией функционала. 
Можно показать, что малые вариации решения f  порождают изменения Z  
пропорциональные лишь 2f , то есть величинам второго порядка малости. 
Это свойство получило название вариационной устойчивости функционала. 
 На практике это свойство широко используется. Дело в том, что многие 
интересные параметры реальных устройств могут быть представлены в виде 
вариационно устойчивых функционалов. К числу таких параметров 
относятся характеристическое сопротивление линии передачи, входное 
сопротивление ряда неоднородностей в линиях передачи и т.д. После 
представления в виде такого функционала, в него можно подставить 
приближенное решение уравнения (3.32) и получить весьма точное значение 
искомого параметра. Таким образом, можно сделать вывод, что погрешность 
определения параметра, представляемого в форме  (3.35), намного меньше 
погрешности определения самой функции f.  
 Рассмотрим далее связь функционала (3.35) со СЛАУ, получаемой по 
методу Бубнова-Галеркина. Для этого допустим, что функции f  и   
описываются следующими суммами: 
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 Подставим (3.36) в (3.35): 
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 Будем искать коэффициенты nA  таким образом, чтобы функционал 
(3.37) был стационарным на приближенном решении задачи (3.32), 
определяемом рядом (3.36). Для этого потребуем выполнения следующих 
равенств: 
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 Дифференцирование (3.37) приводит к следующей СЛАУ: 
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 ,    (3.39) 

которая полностью совпадает со СЛАУ (3.12), если взять одинаковые 
базисные и тестовые функции, то есть применить метод Бубнова-Галеркина. 
Таким образом, этот метод автоматически дает решение, на котором 
функционал (3.35) стационарен.  
 
 
 
 



 32 

3.2. Интегральные операторы электродинамики 
и интегральные уравнения 

 
 В этом разделе рассмотрим некоторые операторы и соответствующие 
уравнения, к которым сводятся граничные задачи электродинамики. Начнем 
с простейших случаев двумерных задач, в которых поля не зависят от одной 
координаты. Известно, что решение уравнений Максвелла в двумерном 
случае распадаются на две группы: Е и Н-волны. Если поля не зависят от 
координаты z, то Е-волны имеют компоненты Ez,Hx,Hy, а Н-волны 
компоненты Hz,Ex,Ey. Более простым является случай Е-волн. Перейдем к его 
обсуждению. 
Двумерный интегральный оператор для Е-волн. На рис. 3.6 показана 
геометрия рассматриваемой структуры.  

 
Рис. 3.6. К выводу интегрального оператора для Е-волн   

  
Мы имеем идеально проводящее тело с поверхностью S, которое 

возбуждается плоской волной, имеющей компоненту ziE . Нам необходимо 
найти рассеянное телом поле, удовлетворяющее уравнениям Максвелла в 
свободном пространстве и следующим условиям: 

- граничным условиям на поверхности металла S: 0E , 
- условиям излучения на бесконечности. 
Для вывода интегрального уравнения используем следующий прием. 

Допустим, что тело отсутствует, вместо него имеется поверхность S, на 
которой текут поверхностные электрические токи. Известно, что ток связан с 
магнитным полем следующим соотношением: 

 HnJ e , ,         (3.40) 
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где n вектор нормальный к поверхности S (см. рис. 3.6). Поскольку 
магнитное поле ориентировано в плоскости XOY, то из (3.40) легко увидеть, 
что ток имеет одну z-ю компоненту.  
 После удаления металлического тела решим задачу о возбуждении 
свободного пространства электрическим током, текущим по поверхности S. 
Эта задача хорошо известна в электродинамике и её решение дается с 
помощью функции Грина свободного пространства. Выпишем это решение: 

  
S

e
z

e
z dsVsGsJVA '),'()'()(  ,     (3.41) 

где 's  - координаты точки интегрирования, расположенной на поверхности S, 
а V - координаты точки наблюдения, расположенной вне металлического 
тела, )(VAe

z  - z-я компонента векторного потенциала, ),'( VVG - функция 
Грина свободного пространства. Для функции Грина свободного 
пространства известно выражение: 

  
,)'()'(

),(
4

),'(

22

)2(
0

yyxxR

kRHiVVG




      (3.42) 

где k – волновое число свободного пространства, а )()2(
0 xH  - функция 

Ханкеля второго рода, нулевого порядка. 
 Все компоненты поля могут быть выражены через векторный 
потенциал. В частности компонента zE : 

  e
zaz AiE  ,        (3.43) 

где   - круговая частота, a  - абсолютная магнитная проницаемость 
свободного пространства. 
 Отметим следующие свойства полученного поля. Оно удовлетворяет 
уравнениям Максвелла в свободном пространстве, что следует из 
определения функции Грина. Оно удовлетворяет условиям излучения на 
бесконечности. Единственное условие исходной задачи, которое нам пока не 
удалось удовлетворить – это граничное условие на поверхности металла. Так 
как у Е-волн существует одна компонента электрического поля, то граничное 
условие можно переписать в новом виде: 
  0 ziz EE     на поверхности S.     (3.44) 
 Подставим (3.41)-(3.43) в (3.44) и получим искомое интегральное 
уравнение: 
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 на S.     (3.45) 

 Уравнение (3.45) выполняется на поверхности S. Функция )'(sJ e
z  

неизвестна и ее надо определить, решая уравнение (3.45), а функция 
)()2(

0 kRH  называется ядром интегрального уравнения. 
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 Область интегрирования в (3.45) совпадает с областью определения 
уравнения. Характерной особенностью ядра уравнения является наличие 
особенности, когда 'VV  . Это связано с тем, что функция Ханкеля при 

0x  имеет логарифмическую особенность.  
 Перейдем теперь к случаю Н-волн. 
Двумерный интегральный оператор для Н-волн. Сохраним геометрию 
структуры неизменной. Отличие случая Н-волн состоит только в том, что у 
падающей волны имеется компонента ziH . Используя (3.40), можно 
установить, что токи уже текут не вдоль оси 0z, а вдоль граничного контура 
цилиндрической поверхности S. Поэтому они имеют как x-ю, так и у-ю 
компоненты.  
 Введем на поверхности металлического тела локальную систему 
координат nz . Тогда в этой системе координат ток имеет одну компоненту 

eJ .  
 Действуем далее по прежней схеме. Заменяем тело токами и решаем 
задачу а возбуждении ими свободного пространства. В системе координат 
nz  это решение имеет следующий вид: 
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ee dsVsGsJVA '),'()'()(  .      (3.46) 

 Функция Грина осталась той же самой, что и раньше. Существенно 
изменилась связь векторного потенциала с тангенциальным к поверхности 
тела электрическим полем: 
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где a  - абсолютная диэлектрическая проницаемость свободного 
пространства. 
 Используя соотношения (3.46), (3.47) и граничные условия на металле, 
получаем искомое интегральное уравнение: 
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    (3.48) 

 Интегральное уравнение существенно отличается от уравнения (3.45) 
присутствием в нем дифференциального оператора. Правильнее было бы 
называть его интегро-дифференциальным уравнением. Дифференциальный 
оператор существенно усиливает особенность ядра уравнения, что может 
привести к определенным затруднениям при решении (3.48). 
Трехмерный интегральный оператор. Трехмерный случай отличается еще 
большей сложностью. Пусть в свободном пространстве расположено 
металлическое тело с поверхностью S, возбуждаемое первичным полем, 
имеющим касательный к S вектор электрического поля iE .  
 Схема вывода интегрального уравнения остается неизменной. Отличие 
состоит в том, что вектор тока имеет все три компоненты, также как и 
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векторный потенциал порождаемый этим током. Для векторного потенциала 
справедлива следующая формула: 
  ,'),'(~)'()( 
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 Связь векторного потенциала с вектором электрического поля, 
касатель-ным к поверхности S, дается соотношением (3.50): 
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где grad и div дифференциальные операторы градиент и дивергенция. 
Приравнивая суммарное тангенциальное электрическое поле нулю на 
поверхности S, получаем интегро-дифференциальное уравнение: 
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(3.51) 
Магнитные токи и интегральные уравнения для магнитных токов. До 
сих пор формулировали интегральные уравнения относительно 
электрических токов. Это естественный с физической точки зрения путь, 
поскольку по поверхности металла текут именно электрические токи, 
являющиеся источниками рассеянного поля. Тем не менее, имеются 
ситуации, в которых этот естественный путь оказывается нерациональным. 
Дело в том, что МОМ тем эффективнее, чем меньше область, в которой 
действует решаемое операторное уравнение. Это вполне понятно, поскольку 
для описания решения в большой области потребуется аппроксимация 
большого порядка, получение которой связано с решением большой СЛАУ. 
Теперь представим себе структуру, показанную на рис. 3.7. Это бесконечный 
металлический экран с бесконечно малой толщиной. В этом экране имеется 
отверстие, занимающее область S.  
 В принципе задача рассеяния на таком экране может быть сведена к 
интегральному уравнению относительно электрических токов, текущих по 
поверхности Sa. 
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Рис. 3.7. Отверстие в металлическом бесконечно тонком экране 

 
 Однако нетрудно понять, что возмущение в структуре создает 
отверстие, имеющее небольшую сравнительно с Sa площадь. Поэтому 
интересно было бы найти способ формулировки интегрального уравнения, 
определенного в области S.  
 На рис. 3.8 показана часть экрана с отверстием (пунктирная линия). 

 
Рис. 3.8. Магнитные токи на металле 

 
 Мысленно металлизируем отверстие, а в области S разместим 
поверхностные магнитные токи. Токи по разные стороны экрана могут быть 
разными. После этого решим задачи возбуждения этими токами двух 
полупространств выше и ниже экрана. Задача о возбуждении 
полупространства над (под) металлическим экраном хорошо известна в 
электродинамике. Ее решение записывается с помощью функции Грина 
трехмерного пространства (3.49): 
  ')'(),'(~2 2,12,1 dssJVsGA m

S

m
  ,     (3.52) 

где mA 2,1  тангенциальный к поверхности экрана векторный магнитный 
потенциал. Индекс 1 соответствует области над экраном, а 2 под экраном. 
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 Магнитное поле тангенциальное к поверхности экрана 2,1H  
выражается через векторный потенциал следующим образом: 
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  .    (3.53) 

 В (3.53) индексы 1,2 опущены. 
 Отметим некоторые свойства поля, определяемого потенциалами 
(3.52). Это поле удовлетворяет уравнениям Максвелла. Также оно 
удовлетворяет нулевым граничным условиям для тангенциального 
электрического поля на всей поверхности экрана, за исключением области S 
(то есть там, где надо). Наконец это поле удовлетворяет условиям излучения 
на бесконечность. Для решения граничной задачи не хватает выполнения 
двух условий в области отверстия S: 
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 Чтобы приблизить нашу задачу к реальной, введем возбуждающее поле 
следующим образом. Пусть источник расположен под экраном в области 2. И 
пусть этот источник создает поле, удовлетворяющее нулевым граничным 
условиям для электрического поля как в области Sa, так и в области S, то есть 
на всем экране, включая отверстие. Таким образом, мы можем заключить, 
что такой источник на поверхности экрана имеет только тангенциальное 
магнитное поле iH , и, следовательно, граничные условия (3.54) надо 
дополнить, прибавив к 2H  слагаемое iH . 
 Выберем токи mJ 2,1  так, чтобы первое из условий (3.54) выполнялось 
бы автоматически. Для этого вспомним связь магнитного тока, текущего по 
поверхности металла и тангенциального электрического поля: 
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 Так как 21 nn  , то граничное условие будет выполнено когда 
mm JJ 21   . У нас осталось одно условие для магнитного поля. Подставим в 

него (3.52),(3.53) и получим интегральное уравнение относительно 
магнитного тока: 
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          (3.56) 
 Из формулы (3.56) видно, что нам действительно удалось получить 
уравнение, заданное в области S. 
Интегральные операторы для плоско - слоистых структур. Очень 
большое прикладное значение в технике СВЧ и антеннах имеют так 
называемые плоско – слоистые структуры. Пример такой структуры показан 
на рис. 3.9. Она представляет собой набор слоев разных магнито – 
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диэлектриков разной толщи-ны. Допустимо присутствие между слоями 
металлических экранов, разделяющих структуру на изолированные части. На 
рис. 3.9 над слоем с номером N находится свободное пространство. В 
принципе это необязательно. Вместо этого структура может заканчиваться 
металлическим экраном.  
 Такая плоско – слоистая структура моделирует подложку печатной 
схемы. Чтобы она превратилась в полноценную схему в ней должны 
появиться полосковые проводники. В отличие от слоев, показанных на рис. 
3.9 проводники не могут быть бесконечными в плоскости ХОУ. Они должны 
иметь некоторую форму и формировать топологию печатной схемы. Как 
любое физическое тело полосковые проводники имеют конечную толщину. 
Однако моделирование полосковых структур с проводниками конечной 
толщины сложнее, чем моделирование тех же структур в приближении 
бесконечно тонких проводников, которые в этом случае называются 
металлизациями. Поэтому в практике проектирования печатных схем  

 
Рис. 3.9. Плоско – слоистая структура 

 
широкое распространение получила модель печатной схемы с бесконечно 
тонкими металлизациями. Такая модель называется еще 2.5 D моделью. 
Здесь имеется ввиду, что полностью трехмерная структура (с конечной 
толщиной проводников) является 3D моделью. Далее рассмотрим 2.5 D 
модель печатной схемы (и антенны в том числе) и получим для нее алгоритм, 
позволяющий формировать интегральные уравнения для анализа схемы с 
произвольным сочетанием слоев и экранов. 
 Из примеров приведенных выше видно, что центральным моментом 
при записи интегрального оператора является решение задачи о возбуждении 
рассматриваемой структуры произвольной комбинацией электрических и 
магнитных токов. Решим эту задачу для плоско – слоистой структуры.  
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 Отметим, что бесконечно тонкие проводники или экраны с 
отверстиями заменяются при выводе интегральных уравнений листками 
электрических и магнитных токов. Поскольку все экраны располагаются 
между слоями, то, следовательно, и листки токов расположены там же. 
Далее, так как мы имеем дело с бесконечно тонкими экранами, то 
поверхностные токи могут иметь только две компоненты, лежащие в 
плоскости XOY.  
 Для построения функции Грина плоско – слоистой структуры и 
решения задачи о ее возбуждении очень эффективным оказался подход 
основанный на использовании эквивалентной схемы структуры. Фрагмент 
такой схемы показан на рис. 3.10.  

 
Рис. 3.10. Модель плоско – слоистой структуры 

 
 Каждому слою ставится в соответствие четырехполюсник TLn, который 
представляет собой отрезок линии передачи с длиной равной толщине слоя. 
В линиях передачи имеются токи и напряжения, подчиняющиеся 
телеграфным уравнениям, описывающим процессы в длинных линиях. 
Анализ распределения токов и напряжений в линиях передачи, который 
осуществляется методами теории цепей СВЧ, позволяет определить их 
значения для любой координаты z.  
 В плоско – слоистой структуре существуют два решения уравнений 
Максвелла Е и Н-волны ( 0,0  zz EH ). Их распространение вдоль оси z 
происходит независимо друг от друга. Таким образом, можно отдельно найти 
поле типа Е и поле типа Н, а суммарное поле будет суммой полей обоих 
типов. Существование волн двух типов означает, что, вообще говоря, нам 
надо рассматривать две эквивалентные схемы отдельно для Е и Н-волн. Для 
упрощения записи введем индекс  , равный e, если речь идет о Е-волнах и 
m, если об Н-волнах. 
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 Тогда в каждой линии передачи существуют токи и напряжения 

nn UJ , , являющиеся функциями координаты z. Каждая линия 

характеризуется своей постоянной распространения n  и волновым 
сопротивлением nZ , для которых могут быть получены следующие 
выражения: 
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     (3.57) 

где kn – волновое число n-го слоя, 21 , - некоторые параметры, меняющиеся 
от минус до плюс бесконечности. Их смысл будет пояснен позже.  
 Каскадно соединенные четырехполюсники удобнее описывать ABCD 
матрицами. Ниже приводится ABCD матрица отрезка линии передачи: 
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Чтобы найти матрицу передачи всей плоско – слоистой структуры 
достаточно перемножить матрицы передачи отдельных четырехполюсников: 
  

n
nAA  .        (3.59) 

 Присутствие токов, возбуждающих структуру отображается на эквива-
лентной схеме источниками тока и напряжения. Электрические токи соответ-
ствуют параллельно включенному источнику тока, а магнитные токи 
последовательно включенному источнику напряжения (см. рис. 3.11). 

 
Рис. 3.11. Эквивалентные схемы электрических и магнитных токов 

 
 Таким образом, задача сводится к анализу возбуждения некоторой 
схемы заданными источниками тока и напряжения. Рассмотрим показанную 
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на рис. 3.12 типичную структуру. Снизу она экранирована металлическим 
экраном, который отображается закороткой, а сверху нагружена на 
свободное пространство, которое моделируется двухполюсником с номером 
0. Между ним и четырехполюсником с номером N расположен источник 
тока. Этот источник моделирует электрические токи, текущие по 
полосковому проводнику. 

 
Рис. 3.12. Матричная модель плоско – слоистой структуры над 

металлическим экраном 
 

 Найдем напряжение в линии передачи в точке подключения источника 
тока. Для этого нам надо найти матрицу передачи цепочки 
четырехполюсников с номерами 1-N. Это легко сделать, используя формулу  
(3.59). В результате приходим к новой эквивалентной схеме, показанной на 
рис. 3.13. 

 
Рис. 3.13. Модифицированная эквивалентная схема  
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 Двухполюсники, расположенные выше и ниже источника тока можно 
заменить их входными сопротивлениями. Входное сопротивление 
свободного пространства равно 

0Z , а входное сопротивление 

четырехполюсника с матрицей 
A  и одним закороченным входом - 

inZ  
выражается следующим образом: 
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Рис. 3.14. Эквивалентная схема со входными сопротивлениями 

 
 Теперь, анализируя схему, показанную на рис. 3.14 не составляет труда 
найти напряжение в точке подключения источника тока: 
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 Для записи интегральных уравнений нам необходима связь токов и 
напряжений в линиях передачи с полями в плоско – слоистой структуре. Эта 
связь определяется следующими соотношениями: 
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   (3.62) 

где yxr 21   , интегрирование в (3.62) ведется в бесконечных 
пределах.  
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 Связь электрических и магнитных токов с источниками тока и 
напряжения имеет следующий вид: 
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    (3.63) 

где индекс  принимает значения x и y. 
 Объединяя соотношения (3.61)-(3.63), и подставляя их в граничные 
условия на поверхности полоскового проводника: 
  ,, ,0 ,0 SyxEE yx         (3.64) 
где S – область, занятая проводником, получаем искомую систему 
интегральных уравнений: 
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где вектор 
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 соответствует полю источника возбуждения, а матрица 
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 находится из формул (3.61)-(3.63).  

 Введем следующие обозначения: 
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 С их помощью удается привести систему интегральных уравнений к 
компактной форме: 
  .0')'(),'(?  i

S

e EdssJVsG       (3.67) 

 Функция ),'(? VsG  является тензорной функцией Грина плоско – 
слоистой структуры.  
 Аналогичным образом записываются интегральные уравнения, когда 
речь идет о магнитных токах. Рассмотрим похожую структуру, но не 
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полоскового, а щелевого типа. Она отличается от полосковой тем, что на 
слое с номером N располагается металлический экран со щелью. Пусть щель 
занимает область S. Такой структуре соответствует эквивалентная схема, 
показанная на рис. 3.15.  

 
Рис. 3.15. Эквивалентная схема структуры с магнитными токами 

 
 Многополюсники с номерами от 1 до N соответствуют слоям с теми же 
номерами. Верхний двухполюсник с номером 0 соответствует свободному 
пространству, перемычки, расположенные выше N-ого слоя и ниже нулевого 
моделируют экраны. Щель, как и ранее, заменяется листками магнитных 
токов, расположенными на обеих поверхностях верхнего экрана. Эти токи 
отображаются на эквивалентной схеме источниками напряжения, которые 
имеют одинаковые амплитуды, но противонаправлены, то есть их фазы 
отличаются на  . Это отражает тот факт, что магнитные токи на разных 
поверхностях экрана должны быть также одинаковы по модулю, но противо-
положны по знаку. Такой выбор магнитных токов, как было показано выше, 
обеспечивает выполнение граничных условий для электрического поля в 
области щели. 
 Поскольку интегральные уравнения в случае магнитных токов 
записываются из условия непрерывности магнитного поля в области S, то нас 
будут интересовать токи, текущие через источники напряжения. Верхний 
металлический экран разделяет нашу структуру на две части. В первой 
находятся нулевой слой и верхний источник напряжения, а во вторую входят 
остальные слои и нижний источник напряжения (см. рис. 3.16).  
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Рис. 3.16. Преобразования эквивалентной схемы структуры с магнитными 

токами 
 

 Заменяем двухполюсники их входными сопротивлениями, которые 
определяются по формуле (3.60) и находим токи, текущие через источники: 
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 Дальнейшая последовательность действий не отличается от уже 
рассмотренных. С помощью формулы (3.68) находим тангенциальные 
компоненты магнитного поля и приравниваем их в области щели. Связь 
источников напряжения с магнитными токами дается формулой (3.63). 

 Рассмотренная выше схема легко обобщается на два важных 
случая: экранированной плоско –слоистой структуры (рис. 3.17)  и 
периодического возбуждения плоско –слоистой структуры (рис. 3.18).  

 
Рис. 3.17. Экранированная плоско – слоистая структура 

 
 Экранированная структура отличается от уже рассмотренной выше 
тем, что слои в ней ограничены в плоскости XOY. Пределы им ставят 
идеально проводящие вертикальные стенки. Эти стенки могут быть 
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бесконечно протяженными по оси 0z, а могут быть и конечной длины, если в 
плоскости XOY имеются металлические или магнитные экраны.  

 
Рис. 3.18. Периодическая плоско – слоистая структура 

 
 Таким образом, в отсутствие хотя бы одного горизонтального экрана из 
данной структуры возможно излучение в бесконечный волновод, ось 
которого направлена вдоль оси 0z. Следовательно, модель, показанная на 
рис. 3.17 может быть полезна для решения, в том числе и волноводных задач. 
Основное ее применение, тем не менее, связано с моделированием печатных 
экранированных схем.  
 Модификация рассмотренной схемы состоит в следующем. Формулы 

(3.57)-(3.61) остаются неизменными за исключением замены 1  на 
a
n  и 2  

на 
b
m , где a и b – размеры металлической полости по осям 0x и 0y 

соответственно. Формула (3.62) претерпевает более существенные 
изменения: 
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 Поверхностные токи представляются через источники эквивалентных 
схем следующим образом: 
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 (3.70) 

 Структура с периодически расположенными источниками используется 
при моделировании антенных решеток большого электрического размера. 
Реальная решетка, конечно, ограничена в плоскости XOY. Однако если ее 
размеры велики, то краевые эффекты сказываются не существенно, по 
крайней мере, на параметрах элементов решетки удаленных от её границ. 
Поэтому эффективным средством моделирования такой структуры является 
ее модель в виде бесконечной по обоим осям 0х и 0у решетки. В этой модели 
и возникает задача о возбуждении плоско – слоистой структуры 
периодически расположенными электрическими и магнитными токами.  
 Решение этой задачи дается формулами (3.57)-(3.61) с заменой в них 1  

на 
xP
n2  и 2  на 

yP
m2 . Формулы (3.62),(3.63) незначительно изменяются: 
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 (3.71) 
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3.3. Источники в методе моментов 

 
 С одним видом реальных источников мы уже сталкивались в разделе 
3.1. Это волны, распространяющиеся в свободном пространстве. Такой вид 
источника характерен преимущественно для задач рассеяния. Для 
полосковых схем и печатных антенн характерны другие источники.  
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 В технике СВЧ наибольшее распространение получило представление 
СВЧ устройства в виде многополюсника. Причем многополюсник имеет 
выходы (их еще называют портами) в виде линий передачи, чаще всего 
одноволновых линий передачи. В этой линии передачи устанавливается 
некоторой сечение, называемое отсчетной плоскостью, в котором 
определяются амплитуды падающих и отраженных волн, токи и напряжения 
и т.д. Эти параметры позволяют далее найти матрицы Y, Z или S 
многополюсника.  
 Предполагается, что за пределами многополюсника в линии передачи 
поля могут существовать только в виде падающей и отраженной волн. 
Строго говоря, это условие никогда не выполняется, так как кроме основной 
волны в линии передачи всегда существуют высшие типы волн, затухающие 
вдоль линии передачи. Эти волны возбуждаются в многополюснике и всегда 
создают конечное поле в любом сечении выходной линии передачи. Однако, 
если отсчетная плоскость находится на достаточном расстоянии от места 
возбуждения реактивных волн, то их амплитуда в этом месте будет 
пренебрежимо малой.  
 Известно, что для определения, например, матрицы рассеяния 
многополюсника, надо проделать N опытов, состоящих в том, что к одному 
из портов устройства подключается идеальный генератор, а к другим 
подключаются идеальные согласованные нагрузки. Затем надо измерить 
амплитуды отраженных от многополюсника волн. В такой процедуре кроется 
определенное противоречие со строгой электродинамикой. Дело в том, что в 
качестве идеально согласованной нагрузки может выступать бесконечная 
линия передачи, в которой нет источников отражений или какая-то 
гипотетическая согласованная нагрузка, модель которой пока неизвестна. 
Таким образом, возникает проблема, как создать модель бесконечной линии 
передачи. Сделать это чисто электродинамическими методами достаточно 
трудно. Напрямую просто невозможно, так как все структуры, подлежащие 
численному анализу должны быть конечными. Кроме всего прочего, эта 
модель должна логично входить в общую схему решения 
электродинамической задачи, в нашем случае в схему МОМ.  
 Покажем, как решается данная задача в случае моделирования портов 
полосковой схемы (рис. 3.19). 

 
Рис. 3.19. Полосковая схема 
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 Предполагается, что подложка и все проводники находятся внутри 
металлической коробки. В этом месте интересы моделирования и практики 
совпадают, так как с одной стороны, анализировать закрытую структуру 
проще, а, с другой стороны, металлическая коробка играет роль корпуса, в 
который помещается реальное устройство. 
 Заканчивается наша схема портами. На практике это чаще всего 
коаксиальные разъемы, к которым присоединяются одноволновые 
коаксиальные кабели. Реально такие разъемы неидеально согласованы, но 
перед нами стоит задача создать модель некоторого идеального разъема, не 
вызывающего отражений.  
 На рис. 3.20 показан полосковый проводник, подходящий к 
вертикальной стенке корпуса. На проводник нанесена прямоугольная сетка, 
используемая в МОМ. 

 
Рис. 3.20. Модель порта в полосковой линии 

 Крайний слой, примыкающий к металлической стенке, используется 
для описания порта (на рис. 3.20 он заштрихован). Номера ячеек в этом слое 
меняются от 1 до N.  
 Напомним, что мы записываем операторное уравнение, к которому 
затем применяется МОМ, на основании граничных условий. В данном случае 
это граничные условия на поверхности полоскового проводника, требующие 
равенства нулю тангенциального электрического поля. Данное граничное 
условие справедливо для всех ячеек сетки, кроме тех, что используются для 
описания порта. Установим здесь другие условия: 

  ,
0














u

E          (3.73) 

где верхняя строчка соответствует х-ой компоненте, а нижняя у-ой, u – 
напряжение между проводником и стенкой корпуса,   - размер ячеек с 
номерами 1…N  по оси 0х.  
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 Смысл формулы (3.73) понятен. Мы требуем, чтобы на крайних 
площадках электрическое поле равнялось бы не нулю, а некоторой величине, 
определяемой напряжением в зазоре между проводником и стенкой. 
Предполагая, что размер ячейки достаточно мал, мы можем записать для 
напряжения закон Ома: 
  ,0EZJu          (3.74) 
где 0E  - эдс, включенная в зазор, а Z  включенное там же сосредоточенное 
сопротивление, J – полный продольный ток, текущий по проводнику. 
 Соотношение (3.74) есть ни что иное, как закон Ома для участка цепи. 
Эта цепь моделирует два процесса: поглощение волны распространяющейся 
из схемы в нагрузку и возбуждение схемы падающей извне волной. 
Сопротивление Z равно волновому сопротивлению полосковой линии 
передачи, подходящей к порту.  
 Полный ток J определяется через интеграл по сечению проводника. В 
условиях дискретной сетки он заменяется суммой: 

  



N

i
xiIJ

1
        (3.75) 

 Теперь мы можем модифицировать СЛАУ (12), получаемую в МОМ 
так, чтобы она учитывала наличие портов. Приведем её окончательную 
форму: 
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 При записи (3.76) учтено, что токи имеют две компоненты и, следо-
вательно, базисные и тестовые функции являются вектор - функциями. 
 Описанная выше модель порта не является строгой. Она основана 
предположении, что сосредоточенная нагрузка может обеспечить идеальное 
согласование полосковой линии передачи. Это, строго говоря, верно только 
для достаточно низких частот. Однако практика применения такой модели 
показала, что она дает хорошие результаты в большинстве практически 
важных случаев. Аналогичную модель в виде сосредоточенного источника 
используют не только для описания печатных схем, но также при анализе 
вибраторных и проволочных антенн, когда реальную питающую линии 
передачи заменяют сосредоточенным генератором с конечным внутренним 
сопротивлением. 
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3.4. Разбиение структуры на ячейки и моделирование 
      
   Проводящие поверхности разбиваются на треугольники, а провода на 
сегменты. Для диэлектриков имеется несколько способов описания. При ис-
пользовании метода поверхностных токов, поверхность диэлектрического 
тела также разделяется на треугольники, а когда применяется метод 
объемных токов, твердое тело разделяется на кубоиды. При выборе метода 
FEM, разбиение выполняется на объемные тетраэдры.   
   Тонкие слои диэлектрического материала разбиваются на треугольники, 
расположенные в середине слоя. 
     Далее дадим ряд определений, которые используются при описании 
работы FEKO: 
• Segment (сегмент): сегмент провода (короткий по сравнению с длиной 
волны). 
• Cuboid (кубоид): элемент объема, используемый для моделирования 
диэлектрических и магнитных материалов методом объемного тока в методе 
MOM. Он имеет углы в 90 градусов, как в кубе, но должен быть 
параллелепипедом. (Кубоиды могут только быть созданы в EDITFEKO.) 
• Tetrahedron (тетраэдр): трехмерный тетраэдральный элемент объема имею-
щий форму, решенный методом FEM. 
• Polygon (многоугольник): плоский поверхностный элемент с границами в 
виде прямых ребер. Это может быть примитив (который будет подразделен в 
треугольники) или многоугольная плоскость polygonal plate (которая 
решается методом дифракций UTD). 
• Vertex (вершина): Любая конечная точка, точка сегмента сетки или угла 
эле-мента сетки (треугольник, тетраэдр, и т.д.). 
• Node (узел): точка, где соединены два сегмента. К каждому узлу 
назначается одна базовая функция. 
• Edge (ребро): В геометрии ребро - любая кривая (они также называются 
проводами) или любая граница кривой поверхности. Когда используется на 
подключении с элементами сети, ребро - общая линия между двумя 
смежными треугольниками. (Если три треугольника совместно используют 
две вершины, имеются две грани, связанные с этими треугольниками.) Если 
поверхность - металл, то одна базовая функция назначена к каждому ребру. 
Если поверхность - диэлектрик, то к каждому ребру назначаются две базовые 
функции: одна для эквивалентной плотности электрического тока и одна для 
эквивалентной плотности магнитного тока. На свободном ребре  находятся 
стороны треугольников, которые относятся только к одному треугольнику. 
Если оно не находится на земляной плате или на многоугольной проводящей 
плате, никакие электрические токи не текут поперек этого ребра. •  
Connection point (точка соединения) - точка, где сегмент соединен к 
треугольнику. Конец сегмента связан с вершиной треугольника. Базовая 
функция назначена к каждой точке соединения. 
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3.5. Выбор размеров ячеек разбиения 
      
    Во время разбиения на ячейки необходимо твердо придерживаться следу-
ющих правил: 
 
• Длина сегмента l должна быть меньше, чем десятая часть длины волны 
сво-бодного пространства. 
• Заметим также, что электрические токи сегмента текут в направлении оси 
провода. Таким образом, сегменты также не должны быть слишком 
коротки относительно радиуса провода. Идеально длина сегмента должна 
быть, по крайней мере, в четыре раза больше радиуса. 
• Область A каждого треугольника должна быть меньшей, чем 70/2 . Для 
треугольников, которые по форме близки к равносторонним, это означает, 
что длина стороны должна быть короче, чем приблизительно )6...5/( . 
Если память RAM позволяет, длина ребра должна быть равной )10...8/( . 
• При моделировании поверхности с помощью сетки проводов, радиус 
должен быть выбран так, чтобы область провода в одном направлении была   

2
lr       (3.77) 

где r - радиус, а l - длина сегмента, которая должна быть около десятой части 
длины волны. 
• При соединении провода и поверхности, радиус сегмента провода должен 
быть мал по сравнению с размером плоского треугольника, приложенных к 
этой базисной функции. Как ссылка для размера треугольника, грани 
треугольника, используются приложенные к точке соединения. Длина этих 
граней должна быть большая по сравнению с радиусом сегмента провода. 
     Длина граней диэлектрических кубоидов должна быть мала по сравнению 
с длиной волны в диэлектрике, а также по сравнению с глубиной поверх-
ностного слоя 

   


2
     (3.78) 

 
     Из-за используемой ступенчатой аппроксимации, рекомендуется выбирать 
размер в десятую часть минимальной длины волны и глубины 
поверхностного слоя или более тонкой. 
• При разбиении области на тетраэдральные элементы, размер элемента 
(длина ребра тетраэдра) должен быть около пятой части длины волны внутри 
диэлектрической среды. Для правильного выбора размеров элементов при 
расчете FEM/MOM, рекомендуется более плотное разбиение около десятой 
части длины волны в среде. Внутри среды может быть более крупная сетка 
разбиения, потому что здесь применяются базисные функции высокого 
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порядка. Иногда требование к RAM можно уменьшить, прибавляя малый 
воздушный зазор в области вокруг фактического диэлектрического объекта и 
также разбить ее на сетку в тетраэдральные элементы (то есть также 
использовать FEM). Так как длина волны в воздухе большая, чем в 
диэлектрике, большие тетраэдральные элементы могут тогда использоваться 
при интерфейсе FEM/MOM. Это уменьшает RAM для размещения матриц в 
методе FEM/MOM. Это уменьшение обычно намного выше, чем 
дополнительное ЗУ, требующееся из-за наличия дополнительных 
тетраэдральных элементов (сетка дополнительной буферной зоны).  
• В некоторых случаях модель требует существенно более плотное 
разбиение на сетку. Для низких частот правило сегментации как на десятую 
часть длины волны часто очень слишком крупное, чтобы получить разумное 
представление геометрии. Один пример того, где более плотное разбиение 
может потребоваться - тот, где провод выполняется в виде параллельный 
проводящей плоскости. Если провод расположен ближе, чем на десятую 
часть длины волны до плоскости, размер треугольников в направлении, 
ортогональном к проводу должен быть подобен расстоянию от провода до 
платы, чтобы дать точное представление распределения поверхностного 
заряда. Другой случай, где может потребоваться более плотное разбиение – 
это волноводные порты, где размер ячейки должен быть достаточно малый, 
чтобы учесть распределение напряженности электрического поля самого 
высокой моды, который включен в описание порта. 
     Если правила сегментации не твердо придерживаться, FEKO может 
вывести предупреждения о следующих ошибках: 
 Предупреждение Ошибка 
Отношение длины сегмента к длине 
волны  
 

 
l> 0.3λ   

 
l> 0.5λ   

Отношение радиуса сегмента к длине 
сегмента 
 

 
ρ> 0.3λ   

 
ρ> 1.0λ   

Отношение области треугольника к 
квадрату длины волны  

2

30
1
A  2

10
1 A  

Отношение радиуса провода к длине 
ребра треугольника в точке 
соединения  

 
        r ≥ ? l  
 

 
        r ≥ 1/3 l 
 

Отношение длины ребра кубоида к 
длине волны 

l> 0.25λ   
 

l> 0.5λ   

Отношение длины ребра кубоида к 
глубине поверхностного слоя  

l> 1/5 δ   l> 1/3 δ   

Отношение площади тетраэдра к 
квадрату длине волны (внутренние 
элементы сетки) 

A > 0.047 λ2 A > 0.433 λ2 
 

Отношение площади тетраэдра к A > 0.033 λ2 A > 0.108 λ2 
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квадрату длины волны (элементы 
сети граничной поверхности) 

 

Отношение области треугольника на 
волноводном порте к самому малому 
периоду моды 

 A > 1/30 T2 
 

A > 1/10 T2 
 

 
3.6. Правила разбиения на связанные ячейки 

 
    FEKO аппроксимирует ток в терминах базисных функций, связанных с 
гранями, узлами и точками соединения как определено выше. Чтобы 
гарантировать электрическую связь, треугольники должны совместно 
использовать сопряженные ребра. Сегменты должны быть связаны с другими 
сегментами в узлах или вершинами треугольников (рис. 3.21).  

 
Рис. 3.21: Пример связности сетки: несвязанные сверху, связанные внизу 
 
    При разбиении диэлектрического объема на тетраэдральные FEM 
элементы, стороны сопряженных тетраэдров должны согласованы. Кроме 
того, при моделировании проводящих поверхностей в области FEM, стороны 
металлических треугольников должны быть согласованы со сторонами 
тетраэдральных объемных элементов (рис. 3.22).  

 
Рис. 3.22: Пример соединения областей, рассчитываемых методом FEM: 
слева - неверно, справа - верное 
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     В общем случае CADFEKO разбивает на ячейки каждую отдельную часть. 
Поэтому, связанные объекты должны быть объединены перед разбиением. 
Если, например, провод приложен к поверхности, но из-за численной ошибки 
он расположен от фактической поверхности на расстоянии, большем, чем до-
пуск модели, то CADFEKO не будет создавать вершину на поверхностной 
сетке в точке крепления. Это может случиться при объединении двух 
объектов, которые не касаются друг друга). Так при расчете провод 
электрически не будет связан с поверхностью. Заметим, что размер ячейки, 
указанный в CADFEKO – это средняя желательная длина. В отличие от 
случая моделирования с помощью карт, не гарантируется, что длины ребра 
треугольника по границе поверхности, будут равными. Таким образом части, 
треугольники, которые используют общее ребро, не должны разбиваться на 
ячейки отдельно. 
      FEKO ядро имеет несколько встроенных проверок, которые сообщат об  
ошибке, если, например, сетка содержит накладывающиеся треугольники. 
CADFEKO также имеет несколько проверок, которые пользователь может 
выполнить перед попыткой разрешить модель.  
 

3.7. Диэлектрические объекты 
 
     Имеются несколько способов моделировать диэлектрические среды в 
FEKO, три из которых относятся к диэлектрическим объектам произвольной 
формы: 
• Метод моментов (MOM) с методом поверхностных токов. Здесь фаски 
между различными однородными областями разбиваются на поверхностную 
сетку, используя треугольные элементы. Базисные функции строятся на 
треугольниках для моделирования эквивалентных электрических и 
эквивалентных магнитных поверхностных токов. Граничные условия учиты-
ваются с помощью эквивалентных источников. 
    Для моделей, созданных в CADFEKO, этот метод используется на всех 
диэлектрических областях, которые явно не разбивают объем на 
тетраэдральные элементы. 
     При работе с моделями в EDITFEKO, области среды описываются картой 
ME. Это описание использует нормали треугольников, чтобы отличить 
соответствующие диэлектрические среды на двух сторонах, и желательно 
проверить соответствующие области среды в POSTFEKO. 
• Метод моментов с методом объемных токов. Здесь объем подразделен на 
параллелепипеды. В принципе, каждому элементу могут быть назначены 
различные свойства материалов. Внутри элемента ток поляризации 
неизвестен. Обычно этот метод требует большее количество неизвестных, 
чем метод разбиения на поверхностную сетку, так что этот метод будет 
требовать большего количества ЗУ. Однако, этот метод очень подходит для 
тонких листовых материалов и очень устойчив для низких частотах. Другое 
преимущество состоит в том, что он основан на интегральном уравнении 
Фредгольма второго порядка, производя устойчивую формулировку, и таким 
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образом, при использовании метода MLFMM число итераций обычно мало. 
Этот метод в настоящее время не доступен из CADFEKO, и он реализуется в 
EDITFEKO с помощью карт DK, DZ или QU. 
• Как альтернатива метода МOM, в FEKO реализован метод конечных 
элементов (FEM). Это метод также требует, чтобы трехмерные объемы были 
дискретизированы, но не на кубоиды, а на тетраэдры. Но в 
противоположность МOM, матрицы FEM разрежены, таким образом 
требование ЗУ для сетки объема FEM - намного меньше, чем сетка объема 
МOM той же самой модели. Этот метод автоматически используется, если 
модель содержит тетраэдральные элементы. 
 В моделях CADFEKO, параметры среды задаются при определении диэлект-
рической среды. В EDITFEKO, параметры среды задаются с помощью карты 
DI.   
    Кроме этих общих методов, в FEKO имеется ряд специальных методов 
моделирования диэлектрических объектов:  
• Тонкие листы диэлектрического материала: в этом случае применяется 
метод, в котором эквивалентные токи аппроксимируются поверхностным 
током. 
• Диэлектрические покрытия: в этом случае металлические провода или 
поверхности могут иметь диэлектрическое покрытие. 
• Диэлектрическое полупространство, например земляная поверхность: в 
этом случае используется метод учета коэффициента отражения. Этот метод 
реализуется, используя бесконечные плоскости в закладке Solution в 
CADFEKO или карте BO в EDITFEKO. 
• Сферы, состоящие из одного или большего количества диэлектрических 
слоёв. Специальная функция Грина может быть включена, используя карту 
GF в EDITFEKO. 
• Плоская многослойная подложка: 
      Многослойная плоская подложка (с или без идеальной земляной поверх-
ности сверху и снизу) добавляется к модели, используя бесконечные 
плоскости в закладке Solution в CADFEKO или карте GF в EDITFEKO. 
 
    В CADFEKO тонкие листы диэлектрического материала и покрытия при-
меняются к фаскам. В EDITFEKO тонкие листы диэлектрического материала 
описываются картой SK, а покрытия - картой CO.Геометрия модели (напри-
мер металлические провода и поверхности) не обязательно должны нахо-
диться в свободном пространстве. В EDITFEKO карты EG, DI и GF могут 
также задавать материальные  параметры окружающей среды.  
 
 

4. Работа в интерфейсе CADFEKO 
 
  Первоначально FEKO был создан и приобрел мировую известность, как 
программа, которую запускали в виде пакета перфокарт. Но в 90-х годах 20 
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столетия компания EMSS создала интерфейс CADFEKO, который 
приближает работу пользователя к пользователю Windows. Так что сейчас 
большинство моделей небольшой и средней сложности удобно создавать в 
программе CADFEKO.  
    В этом интерфейсе чертится модель, информация о ней сохраняется в 
файле *.cfm, а топология - в файле *.cfs. После черчения структуры, из меню 
Run запускает на счет программа PREFEKO. CADFEKO обрабатывает файлы  
*.cfm и *.pre и генерирует файл *.fek. Результаты расчета сохраняются в 
файле *.bof, из которого они могут просматриваться в POSTFEKO. 
Результаты также сохраняются в читаемом файле ASCII *.out. Для сложных 
моделей, можно использовать и редактировать файл *.pre. Этот файл 
содержит последовательность команд (макросы) и дает полный контроль над 
процессом решения.  
   CADFEKO был разработан, чтобы облегчить создание моделей в 
графической среде автоматизированного проектирования. Этот процесс 
включает черчение геометрии и разбиение её на ячейки, а также задание 
электромагнитных параметров и конфигурации решения. 
    CADFEKO дает возможность строить параметрические модели. Если 
модель создана, используя переменные, то вся модель перечерчивается, при 
изменении этих переменных. Это используется, например, чтобы найти 
размер антенны, с заданной резонансной частотой. Кроме того, CADFEKO 
сохраняет хронологию создания конструкции так, что операция объединения 
автоматически модифицируется, если какой либо из объектов изменяется 
впоследствии. Если созданы диэлектрические материалы, которые заполняют 
диэлектрические области модели, то параметры среды можно в дальнейшем 
изменять.  
     CADFEKO может также импортировать сложные модели в различных 
форматах. Однако в некоторых случаях может быть доступна только модель, 
разбитая на ячейки.  
 

4.1. Обзор CADFEKO 
 
     Интерфейс CADFEKO, показанный на рис. 4.1, содержит главное меню и 
инструментальную панель сверху, дерево проекта слева, информационное 
окно и строку состояния внизу, и область черчения. 
    Информационное окно внизу (рис. 4.1) сообщает о каждом шаге 
пользователя при создании геометрии, разбиения на ячейки и т.д. В нём 
также выводит информация об ошибках.  
      Статус-бар показывает единицы длины, режим захвата точки и 
координаты текущей позиции курсора - в глобальных координатах – с 
использованием выбранного режима захвата. 
    В статус-баре можно видеть координаты точки ввода, нажимая <Ctrl> 
<Shift> при перемещении мыши в трехмерном представлении. В нем также 
указывается расстояние между точками. 
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     Вид интерфейса может быть изменен, перетаскивая панели. Можно 
изменять размер панелей, перемещая делители к ребрам и дальше от ребер.  
 

 

Рис. 4.1. Главное окно CADFEKO 

   CADFEKO имеет гибкий интерфейс. Например, рабочая плоскость 
workplane (рис. 4.2) и вид объекта могут быть изменены, или задана новая 
переменная, без закрытия диалога создания геометрии. Если открыт новый 
диалог, в то же время уже открыт другой диалог, все поля ввода данных в 
первом диалоге блокируются, пока не закрыт новый диалог. Если было 
открыто несколько диалогов, они будут доступными в обратном порядке, 
когда будут закрываться каждый диалог. Сами диалоги не блокируются, и 
таким образом, они могут всё еще находиться на экране. Но второй диалог не 
может быть открыт для редактирования того же самого элемента.  
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Рис. 4.2. Диалог рабочей плоскости 

    Например, если открыт диалог создания геометрии, и в то же время открыт 
диалог редактирования рабочей плоскости (РП), рабочая плоскость для этого 
представления не может изменяться без закрытия диалога геометрии. Если 
диалог применяется к невыбранным объектам, они показываются зеленым 
цветом в дереве проекта.  
 

4.1.1. Инструментальная линейка 
 

   Эта инструментальная линейка (рис. 4.3) дает быстрый доступ к пунктам 
меню File, для создания, открытия и сохранения модели. Кнопка Notes 
открывает текстовый файл, в котором можно редактировать описание задачи. 
Кнопка New 3D view создает новое трехмерное окно на экране дисплея. 

 
Рис. 4.3.  Стандартная инструментальная линейка 

    
   Команды Undo и Redo (они могут выполняться быстрыми клавишами < 
Ctrl > < Z >  и  < Ctrl > < Y> ) относятся ко всем действиям с моделью. Это 
включат создание, изменение геометрии, переменных, носителей, 
конфигурации решения, и т.д. Действия (вращение, изменения масштаба и 
т.д.) имеют отдельный список Undo/Redo для каждого представления. 
Списки отмены не сохраняются, если модель сохранена и запущена на 
расчет. Если объект повторно разбивается на ячейки, или сеть удалена, 
полная существующая сетка сохраняется в списке Undo/Redo. Это позволяет 
быструю отмену операций.     
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4.1.2. Создание, открытие и сохранение моделей 
 

    Команда File → New закрывает текущую модель и открывает новую 
задачу. Аналогично, File → Open или File → Save открывает и сохраняет 
модели CADFEKO. При сохранении модели, CADFEKO автоматически 
сохраняет файл *.cfs - содержание рабочего пространства (представления, 
плоскости сечения, РП, параметры настройки видимости, и т.д.) и файлы 
*.cfm и *.pre использующиеся при решении.  
   При запуске CADFEKO из командной строки, модель задается как 
параметр командной строки. Если файл не существует, CADFEKO создает 
новую модель, cadfeko model.cfx, убедившись, что каталог не содержит файл 
*.cfs, *.pre или *.cfm с этим именем. 
     По команде File → Export → *.cfm file можно экспортировать текущую 
сетку в файл *.cfm , которая может тогда быть импортирована в файле *.pre. 
Сетка экспортируется, как есть, т.е. не выясняется, правильная ли она в этот 
момент. Если не имеется никаких элементов сетки, переменных или 
поименованных точек в модели, файл *.cfm будет пустой, и импорт его в 
файле *.pre не будет иметь никакого влияния. Этот пункт меню только 
экспортирует сетку, но не сам файл, использованный снова CADFEKO. При 
запуске компонентов FEKO из меню Run, CADFEKO автоматически 
экспортирует файл *.cfm, используя имя модели. 
 

 
4.1.3. Перестройка геометрической модели 

 

     При черчении в CADFEKO v.2 пользователь видит все изменения 
геометрии. Если геометрия создана в ранней версии CADFEKO v.1, то 
имеется опция перечерчивания, выбирая Geometry → Re-evaluate из 
главного меню. Если часть объектов перечерчиваются не верно, то они 
отмечаются как подозрительные. Все свойства (типа локальной сетки 
разбиения), установленные на таких объектах, будут потеряны. Кроме того, 
фаски или грани, которые были удалены, вновь появятся, если они не могут 
быть перечерчены. Если геометрия модели изменится в будущем, 
рекомендуется проверить геометрию и убрать подозрительные объекты 
перед черчением новой дополнительной части. 
     Если геометрия модели не будет изменяться, то можно сохранить 
существующую модель и все её параметры настройки. Заметим, однако, что 
эта модель должна изменяться не всегда, когда требуется пересчет модели. 
Например, если рассматривается автомашина с вибраторной антенной, 
объединенной с ней, то изменение длины вибраторной антенны не требует 
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пересчета, а изменение положения требует пересчета, чтобы заново 
выполнить объединение с новой вибраторной антенной. 
 

4.1.4. Архивирование моделей 
     При работе со сложными моделями, иногда требуется зафиксировать 
состояние модели. CADFEKO может сохранять и восстанавливать различные 
части файла проекта. Выберите File → Archive model из главного меню и 
введите комментарий для памяти файла модели. Текущая модель сохраняется 
в папке заархивированных файлов. Заметим, что внешний файл данных не 
включает точечные источники и идеальные приемные антенны, которые, как 
считается, изменяются независимо от модели CADFEKO. 
 

 

Рис.4.4. Ввод комментария при архивировании модели 

Выберите File → Revert from archive, чтобы открыть диалог  Revert model 
(рис. 4.5) который перечисляет заархивированные версии с их временными 
метками и комментариями. Выберите файл и нажмите кнопку Revert, чтобы 
возвратиться к начальному состоянию. Заметим, что операция возврата 
модели не может быть исключена, и текущий файл модели записан поверх из 
архива. Текущая модель, поэтому, обычно архивируется перед возвращением 
к другой задаче. 

 

Рис. 4.5. Сохранение информации о заархивированных файлах 

     Наконец, выбор File → Delete version from archive позволяет удалять 
заархивированные примеры, чтобы сэкономить дисковое пространство. 
Пользователь может выбирать и удалять несколько архивных файлов 
одновременно. 
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4.2. Трехмерный вид моделируемой структуры 
 

     Просмотр и управление моделью, главным образом, выполняется в трех-
мерном представлении. CADFEKO использует операции щелчка левой 
кнопкой мыши, щелчка с перемещением (кнопка остается нажатой). Щелчок 
левой кнопкой используется для выбора и ввода точек. Щелчок правой 
кнопкой открывает контекстно-зависимое меню с командами. Модель 
вращается, щелкая и перемещая мышь. Можно изменять масштаб 
изображения, нажимая на <Shift> и перемещая мышь вперед и назад, 
увеличивая и уменьшая изображение. Вращение колеса мыши также 
изменяет масштаб изображения (нажимая  <Shift > масштаб будет меняться 
медленнее). 
    Направление лицевой нормали часто важно. Например, ребро между двумя 
фасками, у которых нормали расположены противоположно, не может быть 
удалено. Поэтому в FEKO передняя и задние стороны окрашены по-разному 
и можно полностью изменить направление нормали фаски. 
    Отдельные объекты можно скрыть. Если объект скрыт, он удаляется из 
всех трехмерных представлений. 
    В некоторых случаях дисплей может показывать части объектов, которые 
должны быть скрыты. Эти проблемы исполнения очень зависят от 
компьютера, и CADFEKO имеет некоторые меры для решения этих проблем. 
Выберите Options → Rendering, чтобы открыть диалог, показанный на рис. 
4.6.  
 

 

Рис. 4.6: Диалог опций Rendering options 

     В разделе Rendering mode показывается алгоритм удаления скрытых 
линий. Если отмечена опция Auto-detect без контроля типов, этот алгоритм 
может быть конфигурировано вручную. Это может улучшить просмотр 
конструкции, но может потребовать больший резерв памяти.  
   Выполнение Hardware renderin допускается только в пользовательской сис-
теме. Слайдеры изменяют показ геометрии фаски и сетки разбиения.  
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    Опции в разделе Face Displacement обеспечивают выбор оптимального 
вида линий ребер и структур. Относительные положения ползунков также 
устанавливают то, что видимо, если отображены и геометрия, и сетка. 
Различные параметры могут требоваться для различных направлений 
представления. Эти параметры записываются в файле конфигурации 
CADFEKO. 
  

4.2.1. Рабочая плоскость 
     Каждое трехмерное представление имеет связанную с ним рабочую плос-
кость (РП), которая используется для определения трехмерных координат с 
помощью мыши. РП чертится как синий прямоугольник (на границе) с осями 
U, V и N.  Вывод РП может быть отключен командой Show / hide 
workplane.  
    Чтобы установить положение и направление РП, сделайте щелчок правой 
кнопкой мыши на трехмерном представлении и выберите Workplane → Edit 
или нажмите <F9>. (На инструментальной панели имеется также кнопка Edit 
work-plane). Это открывает диалог рис. 4.7. 

 

Рис. 4.7. Диалог рабочей плоскости 

    РП определяется в терминах начала координат Origin, вектора U и вектора 
V, которые задают направление РП. Запись вектора (2,0,0) в направлении 
аналогично использованию (1,0,0). При расчете v оси, компонента V-вектора, 
параллельная вектору U, удаляется, чтобы убедиться, что эти два параметра 
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ортогональные. Таким образом, вектор V не может быть параллелен вектору 
U. Ось N нормальна к uv-плоскости.  
     Поля Origin, U vector, V vector могут быть заданы численно, то есть РП 
может использоваться, вводя параметры непосредственно. Кнопка Apply 
изменяет РП без закрытия диалога. После этого ввод мышью точки 
выполняется на  РП. 
     Величина Size задает размер РП. Рабочая плоскость может быть не 
симметричной - она может, например, простираться от -1 до 3 в u 
направлении. Можно не включать начало координат, то есть РП может также 
простираться от -3 до -1 или от 1 до 4. Для того, чтобы использовать мышь 
для черчения, РП можно продлить до бесконечности, то есть точки могут 
быть выбраны снаружи синего прямоугольника. Когда отмечена опция Auto 
enlarge, РП увеличивается, чтобы включить всю созданную геометрию. Это, 
однако, не изменяет размеры РП относительно существующей геометрии. 
Размеры РП изменяются нажатием правой кнопки на трехмерное 
представление и выбирая Workplane → Fit to geometry. Щелчок Zoom to 
extents согласовывает РП к текущей геометрии. Опция Grid spacing  
управляет плотностью линий координатной сетки.  
   Если размер РП увеличен до максимального размера, и число линий 
координатной сетки больше чем 10 000 в любом направлении, кнопка показа 
сетки автоматически отключается. Сетка может появиться, снова 
активизируя эту кнопку. Однако если число линий превышает 100 000, сетка 
не видна. 
 

4.2.2. Изменение рабочей плоскости 
 

  В диалоге Edit workplane задается рабочая плоскость в глобальных 
координатах. Для произвольной рабочей плоскости может быть трудно 
переместить РП в себя, или вращать её вокруг одного из ее собственных 
параметров, используя этот диалог. Диалог Transform workplane (рис. 4.9) 
позволяет вращение или сдвиг РП, используя три параметра (U, V, N). 
    Выберите Workplane-> Transform из всплывающего меню трехмерного 
представления или щелкая кнопку Transform workplane на трехмерной 
инструментальной панели представления (рис. 4.8). 
 
 

 

Рис. 4.8. Операции с рабочей плоскостью 
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    Углы вращения вводятся в градусах. Если вращение выполнено вокруг 
больше чем одной оси, CADFEKO использует углы Кардана. Это означает, 
что рабочая плоскость вращается сначала вокруг оси N, затем вокруг оси V и 
наконец вокруг оси U. 

 

Рис. 4.9. Диалог трансформации РП 

     РП не может быть преобразована в то время, как открыт диалог 
редактирования, или когда открыт диалог преобразований. Операция Zoom 
to extents (по которой согласовывается рабочая плоскость и геометрия) также 
блокируется при редактировании рабочей плоскости. 
 

4.2.3. Режим захвата 
 

   Режим захвата удобен для верного создания структуры, особенно в 
трехмерном представлении. Выполнив нажатие правой кнопкой мыши на 
трехмерном представлении, можно выбрать опцию Snap, чтобы выполнить 
захват точек в трехмерном пространстве. Если выбрана Workplane, то точки 
получаются на рабочей плоскости (рис. 4.10). Если выбрана Grid, то 
механизм захвата тот же, но значения округляются к самым близким 
значения сетки. (Значения округляются в координатах рабочей плоскости и 
не могут округляться в глобальных координатах для произвольных 
направлений РП.) 
    Если выбраны Geometry point  или Mesh vertex, точки выбираются от 
направления на существующей геометрии или сетки. Выбор Geometry face 
centre или Geometry edge centre обеспечивает захват курсора к центру фаски 
или ребра. Для изогнутых граней геометрический центр не обязательно 
лежит на ребре. При определении новой геометрии, используется захват к 
существующей геометрии. При этом нет строго правила, и новая точка не 
изменяется, когда существующая геометрия изменена. Эти объекты могут 
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модифицироваться одновременно, используя поименованные точки. Это 
выполняется командой Snap to → Named point (рис. 4.10). 

 

Рис. 4.10. Операции захвата точки 

     К этому меню можно также обращаться нажатием клавишей  <Ctrl> < Q> 
и < Ctrl > < Q>  <V> .  
   Чтобы выбрать режим захвата, выберите Properties, выберите закладку 
Appearance, нажмите Effects, снимите опцию Hide underlined letters for 
keyboard... и нажмите OK в обоих диалогах.  

W Рабочая плоскость 
G Сетка 
N Поименованные точки 
P Геометрические точки 
F Геометрический центр фаски 
E Геометрический центр ребра 
V Ребро сетки 

Табл. 4.1:  Меню захвата и горячих клавиш 

 

4.2.4. Расстояние между точками 
 

   Если нажаты <Ctrl> <Shift>, то при перемещении курсора в трехмерном 
представлении CADFEKO показывает, в линии состояния, координаты 
текущей точки и расстояние между этой точкой и “ точкой привязки”. 
Текущая точка определяется, используя режим захвата, и высвечивается 
красным кружком. 
    Расстояние до точки привязки устанавливается, щелкая (используя режим 
захвата) в трехмерном представлении, когда никакие диалоги не открытые, и 
- то же самое для всех трехмерных представлений. Координаты этой точки 
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первоначально показываются в линии состояния. Если мышь перемещается 
при нажиме <Ctrl> <Shift>, точка привязки расстояния показывается в виде 
зеленого кружка. 

4.3. Плоскости сечения 
 

    Если щелкнуть правой кнопкой мыши на трехмерном представлении и 
выбрать Cutplanes, то открывается диалог секущей плоскости для того, 
чтобы выполнить сечение геометрии. Первая плоскость сечения создается 
автоматически, когда диалог открыт. Нажатие на Add создает 
дополнительную плоскость сечения. Нажатие на Remove удаляет текущую 
плоскость сечения, при снятии опции Active разрез удаляется без потери всех 
параметров настройки. Кнопка Flip скрывает объекты с другой стороны 
плоскости сечения.  
   Плоскость сечения задается аналогично рабочей плоскости РП, используя 
на-чало координат и два вектора. Таким образом, плоскость сечения можно 
изме-нять вручную. 

 
Рис. 4.11. Плоскость сечения, установленная по РП 

 
       Плоскость сечения изменяется с каждой коррекцией в диалоге. При 
разрезании твердого объекта, поверхность, где твердое тело вырезано, 
отображается с видимой внутренней областью, даже когда геометрия не 
окрашена как среда. 
     Эти поверхности не могут быть выбраны, нажимая на них. Можно 
выбрать геометрию, которая находится позади плоскости сечения. Эти 
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поверхности только показываются в режиме выбора части геометрии. Когда 
выбран объект, CADFEKO вырезает твердый объект, как оболочку 
(показывая только фактические фаски), обеспечивая доступ к внутренним 
поверхностям и граням. 
     Значок Cutplane справа строки состояния активен, если представление 
под курсором мыши имеет активную плоскость сечения. Подобно опциям 
захвата, это применяется к представлению под курсором мыши, а не в 
активном представлении. 
 

4.3.1. Выбор просмотра 
 
    В некоторых случаях, когда объекты закрыты другими объектами, бывает  
трудно установить секущую плоскость, чтобы рассмотреть эти объекты. 
Кроме того, рассчитанные поля могут мешать просмотру трехмерных 
объектов. Поэтому такие объекты могут быть скрыты выборочно. Скрытые 
объекты удалены из всех трехмерных представлений, но они все еще часть 
модели и сохраняются в файлах *.cfm и *.pre. Скрытые объекты 
отображаются серыми значками в дереве. 
      Объекты скрываются командой View → Hide selected items из 
всплывающего меню. Эти объекты можно показывать снова, выбирая их в 
дереве и выбирая команду Show из всплывающего меню или View → Show 
selected items. Если выбор содержит видимые и скрытые объекты, выберите 
Show / Hide для каждого выбранного элемента. Наконец, выбирая View -> 
Show all , все скрытые объекты, независимые от текущего выбора показывает 
всю геометрию с сеткой. Порты могут быть скрыты на уровне портов или 
отдельных моделей. 
     Заметим, что кнопки видимости на трехмерной инструментальной панели 
применяются ко всем объектам того типа в только выбранном 
представлении. Это работает полностью независимо от этих параметров 
настройки, то есть если видимость выключена в трехмерном представлении, 
выбор Show all не будет влиять на вид. 
  Если модель сохранена и перезагружена, все объекты снова станут 
видимыми.  
 

4.3.2. Инструментальная линейка 3D вида 
 
     Первые десять кнопок на инструментальной панели сверху трехмерного 
представления (рис. 4.12) управляют видимостью объектов. Геометрия 
(твердый объект, поверхности и линии), точки геометрии, элементы сетки, 
узлы сетки, нормали  элементов сетки, поименованные точки, индикаторы 
конфигурации решения, глобальные оси, РП и сетки могут быть показаны 
или скрыты соответствующими кнопками.  
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Рис. 4.12: Инструментальная линейка 3D вида 
     
    Скрытие РП также скрывает сетку вокруг. Кнопка Highlight mesh edges 
на основной инструментальной панели также управляет видимостью 
элемента, но это относится к выбранным объектам и применяется ко всем 
трехмерным представлениям одновременно.  
    Стрелки, следующие за кнопками Geometry и Mesh, позволяют выбрать 
вид. В виде типа Default, все части твердых поверхностей чертятся в одном 
цвете. Эти кнопки также выбирают, чтобы показать детали. Если снята опция 
Show ports  в списке geometry / mesh, то маркеры для портов прикладываются 
к геометрии и сетке и не будут показаны.  
     В сетке также возможно показать радиусы сегмента и радиусы покрытий 
сегмента. (Выбор показа покрытия покажет также радиусы сегмента, а 
выключение радиусов также выключит показ покрытия.). Эти выборы дают 
результат, если показывается геометрия / сетка, иначе все объекты скрыты. 
    Если выбрана видимость среды Colour by medium, каждая среда области 
отображена своим цветом, как обозначено в списке под Media в дереве. 
Элементы на поверхности окрашены на каждой стороне согласно среде на 
этой стороне фаски. Например, при просмотре сетки диэлектрического 
объекта снаружи, весь объект будет иметь вид как из свободного 
пространства. Различные цвета внутри станут видимыми только, если 
введены плоскости сечения. (Так как пользователь может установить 
произвольную среду на каждой стороне треугольника, эта схема окраски дает 
возможность проверить, что среды были определены правильно.). То же 
самое относится к фаскам геометрии, лежащей между различными 
диэлектриками. Внешние фаски геометрии, однако, отображаются, используя 
видимость внутренней среды.  
   Следовательно, диэлектрический объект будет отображен как диэлектрик, 
когда просматривается снаружи. Если радиусы сегмента и покрытия 
отображены, они окрашены согласно материалу среды или среды покрытия. 
    Если выбрана опция Wire-frame, то показываются только грани модели. 
Это позволяет рассматривать скрытые объекты, но может дать очень 
запутанный вид. Так как только грани отображены, цилиндры будут 
выглядеть как два диска, а сфера будет полностью невидимая. 
     Кнопки Edit workplane, Transform workplane и Specify cutplanes  
обеспечивают быстрый доступ к этим функциям. Кнопка Vertical Z axis  
управляет вращением модели так, что ось z остается вертикальной осью на 
экране (т.е. блокируя ее в месте). Следующие две кнопки изменяют масштаб 
изображения к полной модели или к выбранному окну, соответственно. 
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(Чтобы изменить масштаб изображения к окну после щелчка этой кнопки, 
нажмите, и перетащите мышь, без того, чтобы освободить кнопку, 
определять окно.). Кнопка Restore default view устанавливает углы обзора к 
стандартной позиции. 
       Действие кнопки Undo view action и Redo view action   (также возмож-
ные клавишами <Alt><←> and <Alt><→>) относятся ко всем действиями в 
текущем представлении. 
 

4.4. Дерево модели 
 
    Дерево показывает представление текущей модели. Верхняя часть дерева 
содержит списки переменных, поименованных точек и сред. Далее идет 
общее содержание геометрии, сетка разбиения, порты и конфигурация 
решения. 
     Всю последовательность создания геометрии можно видеть в дереве. 
Когда  объекты получены из операций, то первоначальные (исходные) 
объекты удаляются из верхнего уровня модели и находятся под новым 
объектом в дереве.  Термин «части»  используется для объектов с самым 
высоким уровнем. Они могут быть на корневом уровне под Geometry или на 
максимальном уровне узла и - объекты, которые являются видимыми в 
трехмерном представлении. 
    Нажатие правой кнопкой мыши в дереве откроет соответствующее 
выплывающее меню. Двойное нажатие на пункте в дереве выведет диалог 
Properties за тот пункт, если бы не некоторые заголовки, когда новый 
элемент добавлен. 
      Дерево может быть развернуто с помощью кнопок <+> или выбирая 
Collapse / Expand all из всплывающего меню. Эта команда относится к назна-
ченному пункту, независимо от того, какие объекты выбраны.   
  Свертывание ввода покажет только все исходные объекты. Чтобы скрыть 
исходные объекты (но сохранить остальную часть) используют  клавишу <->. 
Аналогично клавиша <+> разворачивает только текущий уровень. 
     Когда отдельные объекты скрыты, они отображены с недоступными 
значками в дереве. 
      Дерево подробностей дает детальную информацию (фаски, грани, 
области, преобразования и т.д.) отдельных частей, отображенной в основном 
дереве полужирным курсивом. Списки фасок, граней и областей относятся 
только к частям верхнего уровня - эти объекты не перечислены для исходных 
объектов. 
 

4.4.1. Иконки, показанные в дереве 
 
    Иконки, идущие вслед за термином в дереве показывают тип, среду, преоб-
разование, свойства разбиения на сетку и т.д.( по умолчанию названия также 
показывают тип, но после переименования, например , Assembly1.to.Antenna, 
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эти иконки становятся очень полезными.). Эти иконки перечислены в табл. 
4.2 

Примитивы  

 
Кубоид 

 
Пирамида (усеченная пирамида) 

 
Сфера 

 
Цилиндр 

 
Конус 

 
Полигон 

 
Эллипс 

 
Параболоид 

 
Линия 

 
Многоугольник 

 
Линия эллипса 

 
Кривая Безье 

 
Сплайн через точки 

 
Спираль 

 
Импортированные (Parasolid) CAD объекты 

 
Поверхности (созданные копирование 
фаски или explode) 

 
Искривленный объект (ребро или провод), 
созданный копирование ребра или 
исключением 

 Части, которые были сведены к примитиву 

 
Части сетки разбиения 

 
Операции конструирования 

 

Объединение выделенных объектов 

 

Вычитание одного объекта из другого 

 
Область пересечения двух объектов 

 

Расщепление объекта на два 

 

Создание трехмерного объекта свипированием двухмерного 
объекта 
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Создание трехмерного объекта протаскиванием 

 

Операция Loft  создания плоскости между двумя ребрами 

 

Создание проекции одного объекта на другую плоскость 

 

Впечатывание точке на поверхности 

 

Упрощение геометрии (удаление избыточных элементов) 

 

Ассамбль 

 
    Индикация 
 

 

Эта часть была преобразована 

 

Эта часть содержит диэлектрическую область 

 

Эта фаска лежит на диэлектрической области 

 

Эта часть неопределенная (не возможно нанести на чертеж) 

 

Свойства локальной сетки (в области, на фаске, на ребре) 

 

Локальный радиус провода 

     Преобразование геометрии 
 

 

Сдвиг 

 

Вращение 

 

Масштабирование 

 

Зеркальное отражение 

 
    Порты, нагрузки и возбуждения 

 

Порты на сегменте провода 

 

Порты на ребре 

 

Порты на полосковой линии 

 

Импедансная нагрузка 
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Параллельная точка нагрузки схемы 

 
Последовательная схемная нагрузка 

 
Источник напряжения 

 
Электрический точечный источник 

 

Магнитный точечный источник 

 
Точечный источник с заданной ДН 

 

Возбуждение плоской волной 

 

Вынужденный ток в области FEM 

 

Задание частоты 

 

Установка мощности 

 
    Требуемые рассчитываемые характеристики 
 

 

Расчет тока на поверхности 

 

Расчет характеристик дальнего поля 

 

Расчет характеристик ближнего поля 

 
Расчет SAR 

 

Расчет S параметров 

 
Расчет характеристик анализа кабеля 

 
Расчет мощности, принимаемых идеальной приемной антенной 

 
     Расшифровка дерева подробностей 

 
Для проводов и поверхностей, среда сердечника; для тетраэдов - 
среда 

 
Среда слоя, используемого как покрытие 

 
Для поверхностей, среда на нормальной стороне; для проводов 
окружающая среда 

 
Используется только для поверхностей;  среда с обратной стороны 

 
 

4.4.2. Значки среды в дереве подробностей 
 
    В дереве подробностей имеются значки информации о среде. Видимость, 
используемая для каждой среды, может быть установлена нажатием правой 
кнопки мыши, нажимая на среду в списке Media.  
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    Для областей имеется один столбец, указывающий среду области (PEC, 
свободное пространство или один из определенных диэлектриков).  
    Для фасок имеются два столбца. 
    Первый столбец указывает среду фаски (PEC, одна из металлических сред, 
многослойный диэлектрик, если это – тонкий лист диэлектрического матери-
ала или импедансный лист).  
     Второй указывает многослойный диэлектрик Layered dielectric, если 
выполнено покрытие фаски. Для проводов имеются также два столбца. 
Первый указывает материал провода (PEC или одни из металлических 
носителей) и второй - покрытие.   
    Для тетраэдральных сеток, имеется снова только один столбец, который 
ука-зывает среду (один определенный диэлектрик). 
 

 
Рис. 4.13. Значки, контролирующие среду 

 
     Для сеток на поверхностях имеются два столбца, относящиеся к фаскам и 
двух дополнительных столбцов, которые указывают среду (PEC, свободное 
пространство или один из определенных диэлектрических сред) на передней 
стороне и задней, соответственно.  
     Для сетки разбиения на сегменты имеются снова эти два столбца, которые 
относятся к проводам и столбца, указывающего окружающую среду (таблицу 
4.3). 
 
Table 4.3:  Иконки среды используемые в столбцах дерева подробностей 
Области (Region)  
Столбец 1 Среда области 
 
Фаски (Faces)  
Столбец 1 Среда, в которой находится фаска 
Столбец 2 Диэлектрический слой (layered dielectric) если фаска покрыта слоем 

диэлектрика 
 
Ребра (Edges) (только 
для проводов) 

 

Столбец 1 Среда, в которой находится провод 
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Столбец 2 Диэлектрический слой (layered dielectric) если провод покрыт слоем 
диэлектрика 

 
Тетраэдральная сетка 
разбиения 

 

Столбец 1 Среда 
 
Треугольная сетка 
разбиения 

 

Столбец 1 Среда в которой находится фаска 
Столбец 2 Диэлектрический слой, в котором находится фаска 
Столбец 3 Среда впереди фаски (по нормали) 
Столбец 4 Среда сзади фаски  
 
 
Разбиение провода  
на сегменты 

 

Столбец 1 Среда в которой находится провод 
Столбец 2 Диэлектрический слой, в котором находится повод 
Столбец 3 Окружающая среда 
 

4.5 . Изменяемые параметры 
 
4.5.1. Переменные 
 
    CADFEKO поддерживает параметрические модели. Таким образом, боль-
шинство параметров могут быть определены, используя переменные или 
математические выражения типа W = 1+sqrt (x), где x - переменная. 
     Когда переменная изменяется, все объекты, в зависимости от этого, 
модифицируются. Поэтому очень просто изменять модель, используя 
переменные, например, изменять геометрию на различных частотах. Так как 
возможно редактировать объекты геометрии, переменные могут быть 
введены после построения модели. 
    В то время как геометрия полностью параметрическая, сетка разбиения не 
параметрическая, потому что сохранение выражений для вершин сетки 
потребовало бы сохранение очень большого количества данных в ЗУ. 
Вообще, действия, занимающиеся уровнем части полностью 
параметрические, но действия, которые обращаются к индивидуальным 
элементам - нет. При работе с элементами сетки, большинство входных 
полей все еще принимает выражения. Например, прибавление +1 к 
координате вершины перемещает её на одну единицу. Эти выражения тогда 
преобразуются к значениям, когда операция выполнена. Переменные могут 
быть добавлены двойным нажатием при введении переменных в дереве или 
выборе Geometry → Add variable  из главного меню. Первый символ имени 
переменной должен быть буквой от  'a' до 'z' и от 'A' до 'Z' - или символ 
подчеркивания; символы сохранения могут также быть числовые – от '0' до 
'9'. Имена переменной не чувствительны к регистру, т.е. 'a', и 'A' 
обрабатываются как тот же самый символ. Выражение определяет значение 
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переменной и может быть простой номер (типа 1.23) или математическое 
выражение, которое может использовать круглые скобки, операторы  +,  -,  *,  
\,  ^  (экспонента), другие переменные, а также функции, перечисленные в 
таблице 4.4. 
  

fmod Fmod (a,b) возвращает частное от деления a/b 
Sin 
Cos 
Tan 
Cot 

Тригонометрические функции (аргументы в радианах) 

Arcsin 
Arcos 
Arctan 
arccot 

Обратные тригонометрические функции (результат в радианах) 

Atan2 Atan2(y,x) соответствует arctan(y/x)  в диапазоне –π…π 
Deg Преобразование радиан в градусы 
Rad Преобразование градусов в радианы 
Sinh 
Cosh 
tanh 

Гиперболические функции 

Log Десятичный логарифм  
Ln Натуральный логарифм 
Exp Экспоненциальная функция 
Sqrt Корень квадратный 
Abs Абсолютная величина 
Step Step(x) =1, если  x>0,  иначе равно 0. 
ceil Верхняя граница 
Floor Нижняя граница 
Min Min(a,b) или  max(a,b) дает минимум или максимум 

Табл. 4.4: Функции, поддержанные в выражениях CADFEKO 
 
    Если имеется ошибка в выражении, сообщение об ошибках будет 
отображено внизу диалога. Переменная может только быть добавлена, когда 
выражение правильно. Кнопка Evaluate оценивает и проверяет правильность 
выражения без закрытия диалога.  

 
Рис. 4.14. Диалог создания переменной 

 
     Переменные могут быть изменены двойным нажатием на переменной (или 
нажимая правой кнопкой на Properties). CADFEKO покажет ошибку, если 
переменная зависит сама от себя. Все объекты в зависимости от переменной 
будут изменяться одновременно. Если это приводит к недопустимой 
геометрии (например, радиус сферы становится нулевой или пересечение или 
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разбиение, которое становится пустым), в информационном окне 
записывается ошибка, и переменная не изменяется. 

Переменные в таблице 4.5, которые всегда имеются в списке, являются 
частью новой модели. Эти переменные могут быть удалены и / или изменены 
точно так же как любая другая переменная, если пользователь явно 
использует их. 

Табл. 4.5: Используемые 
постоянные 

c0 длина волны в свободном пространстве 
eps0 диэлектрическая постоянная в свободном пространстве 
mu0 проводимость в свободном пространстве 
zf0 волновой импеданс в свободном пространстве 
pi константа π 

 

4.5.2. Поименованные точки 

   Поименованные точки могут быть созданы двойным нажатием на Named 
points в дереве, щелкая правой кнопкой и выбирая  Add named point, или  вы-
бирая Geometry → Add named point из главного меню (рис. 4.13). 
     Точки обычно используются для создания геометрии, которая должна 
изменяться. Диалог Add named point содержит входные поля для трех 
координат в глобальной системе координат.  
  

 
Рис. 4.15. Создание поименованной точки 

 
    Компоненты  точки x, y и z  обращаются, используя точку, сопро-
вождаемую требуемым компонентом. Например, 'P.x' - это x компонента 
точки P. Точки могут быть созданы с командой 'pt', например, ' ‘pt(1,1,1) '. 
Только операции вычитания и прибавления позволяются между двумя 
точками (соответствующие компоненты добавляются и вычитаются) и 
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направление может быть умножено или разделено на число. Кроме того, к 
точке можно применить функции, перечисленные выше.   
  Эта операция дает расстояние от начала координат до точки, то есть длину 
вектора. В настоящее время никакие другие действия не могут быть 
применены к точкам. 
 

4.5.3. Калькулятор 
 
    Выберите View → Calculator, чтобы открыть калькулятор, который 
позволяет рассчитать и проверить переменную и поименованную точку 
выражения без того, чтобы изменить любые параметры модели. 
    Формат результата может управляться. В калькуляторе применяется 
научное экспоненциальное представление чисел, например, 0.01 становится 
1.0e-2. Формат подобен научному калькулятору, за исключением того, что 
показатель степени всегда кратен 4-м. Таким образом, 0.01 становится 10.0e-
4. Десятичное число использует фиксированную систему обозначений без 
показателя степени. Этому не рекомендуют для малых чисел, например, с 5 
десятичными числами, 1.0e-6 становится 0.00000, что означает, что вся 
информация потеряна. 
     Поле Decimals дает количество разрядов после десятичной точки. 
 

 
Рис. 4.16. Окно калькулятора 

 

4.6. Выбор объектов 
 
    Объекты выбираются, нажимая или в дереве или в любом трехмерном 
представлении. Выбранные объекты, подсвеченные в дереве, выделяются во 
всех трехмерных представлениях. Когда исходные объекты выбраны в 
дереве, CADFEKO чертит каркас этих объектов в трехмерном представлении. 
Эти объекты не самостоятельно часто модели, но очень полезно иметь 
возможность различить различные исходные формы. Если текущий диалог 
работает с объектами, которые больше не выбраны, эти объекты 
показываются на зеленом фоне в дереве. 
    Нажимая <Ctrl> при выборе объектов, в дереве или трехмерном 
представлении, прибавит их к текущему выбору (или удалит их, если они 
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выбраны).  Нажимая  <Shift> при щелчке на объекты, в дереве выбираются  
элементы одного и то же типа. Так как порядок объектов - не как очевидный 
в трехмерном представлении, нажимая < Shift >, в то время как выбор просто 
добавится / удаляют новый элемент. В дереве, передвижении может также 
быть выполнен с клавишами курсора. Можно нажать < Shift >, чтобы 
выбрать несколько объектов. 
     Все выбранные объекты должны иметь тот же самый тип, то есть 
невозможно выбрать часть и некоторые из ее фасок одновременно. Однако, 
можно выбрать одновременно фаски, принадлежащие к различным частям. 
     Если нажата клавиша <Ctrl>, то во время нажатия правой кнопкой мыши 
появляется меню, текущий выбор будет оставлен неизменной. Если нажата < 
Shift >, новый элемент будет добавлен к выбору, если это не выбрано, но это 
не будет удалено, если это выбрано. 
    Выбор в трехмерном представлении управляется с инструментальной па-
нелью Selection (рис. 4.17). 

4.6.1. Выбор составляющих 
 
    Отдельные части конструкции выбираются, нажимая на их имя в дереве 
или же на трехмерном виде всей конструкции. Выбранные объекты 
подсвечиваются в дереве и в трехмерном представлении.  
    Когда исходные объекты выбраны в дереве, CADFEKO прочерчивает 
каркасы этих объектов. Эти объекты не самостоятельные части модели, но 
очень полезны для различения исходные объектов. Если текущий диалог 
работает с объектами, которые больше не выбраны, эти объекты 
показываются на зеленом фоне в дереве. 
     Нажимая <Ctrl> при выборе объектов, в дереве или трехмерном 
представлении, добавит их к текущему выбору (или удалит их, если они 
выбраны). Нажимая  <Shift> при щелчке на объекты в дереве выбираются все 
элементы одного типа от первого элемента текущего выбора. Так как 
порядок объектов не так очевидный в трехмерном представлении, нажимая 
<Shift>, в то время как выбор просто добавит или удалит новый элемент. В 
дереве, передвижении может также быть выполнен с клавишами курсора. 
Можно удерживать <Shift>, чтобы выбрать несколько объектов. 
  Все выбранные объекты должны иметь тот же самый тип, то есть невозмож-
но выбрать объект и некоторые из ее фасок одновременно. Можно, однако, 
одновременно выбрать фаски, относящихся к различным частям. 
     Если нажата клавиша <Ctrl>, в то же время нажимая правую кнопку 
мыши, чтобы открыть всплывающее меню, текущий выбор будет оставаться 
неизменным. Если нажат <Shift>, новый элемент будет добавлен к 
выбранным. 
      Выбор объектов управляется с помощью панели Selection. Она содержит 
два набора кнопок и кнопки отмены и восстановления.  
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Рис. 4.17: Инструменты выбора объектов 

 
    Эти три кнопки “ как выбирать ” позволяют выбрать объекты геометрии. 
Если включает первый режим, объекты выбираются курсором. Если 
переключается на Rectangle, прямоугольник чертится, нажимая в одном углу 
и затем перемещая мышь к противоположному углу и нажимая снова. Все 
объекты выбираются полностью или частично внутри этого прямоугольника. 
Наконец, если выбирается Polygon, чертится многоугольник, нажимая 
последовательно в углах. Многоугольник замыкается, нажимая снова на 
первый угол. Для удобства кружок в этом угле чертится синим, когда мышь 
перемещается в пределах некоторого допуска.  
    Заметим, что присутствие плоскости сечения cutplanes имеет значительное 
действие на выбор многоугольника. В отсутствии секущей плоскости, 
выбираются только видимые объекты или полностью или частично внутри 
прямоугольника / полигон. Заметим, однако, что, если фаска находится в 
диалоге Solution, то фаски сразу позади острых углов могут быть “видимы”. 
Когда присутствуют плоскость сечения, все объекты в пределах области 
выбора - видимые объекты также, которые полностью скрыты позади других 
объектов. 
     Методы выбора могут быть смешаны. Например, можно выделить всё 
объекты внутри полигона, затем нажать на кнопку Single и добавить 
дополнительные объекты, нажимая <Ctrl> или <Shift> и нажимая на эти 
объекты. 
    При выборе “ метки сетки ”, все элементы с той же самой меткой выбира-
ются или не выбираются одновременно. Действия применены к выбранной 
метке. 
     Для выбора “ разбиение на сетку”, действия относятся к отдельным 
элементам. Например, если метка сети выбрана и переименована, имя этой 
метки изменено. Если, однако, ряд элементов сети выбран и переименован, 
новая метка создается, и все выбранные элементы будут теперь иметь эту 
метку. Выбор объектов в дереве инициируется кнопкой «что выбрать (what 
to select)». Нажимая <Ctrl> < A>, выделяются всё объекты выбора текущего 
типа.  
 Прежде, чем изменяется режим выбора, сначала снимается существующий 
выбор. С одним исключением - когда метки сети выбраны, и режим выбора 
переключен, чтобы выполнить разбиение на сетку, выбранные элементы пре-
образуются. Следовательно, все элементы остаются выбранными, как будто 
они были выбраны как элементы сетки. 
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     Если нажимается кнопка Highlight mesh edges (рис. 4.17), 
высвечиваются грани выбранных элементов сети. Это позволяет находить 
узкие элементы, где поверхность может быть невидна сама по себе. При 
вращении модели (то есть перед отпусканием кнопки мыши), поверхности 
сетки скрыты. Следовательно, если геометрия скрыта, при вращении модели 
можно видеть грани выбранных элементов, даже скрытые позади других 
объектов.  
 

4.7. Удаление объектов 
 

    Чтобы сохранить модель непротиворечивой, CADFEKO не позволяет 
удалять объекты, которые используются другими объектами. Например, 
невозможно удалить переменную, которая используется при определении 
среды или удалить среду, которая используется в какой-то части геометрии.  
     Когда операция удаления терпит неудачу, CADFEKO покажет, где 
элемент используется. Этот элемент должен быть сначала удален или 
отредактирован так, чтобы он больше не зависел от исходного элемента.    
    Заметим, что иногда зависимость может быть косвенная. Например, 
рассмотрим переменную, используемую для установки размера разбиения на 
Face1 параллелепипеда Cuboid1.  
    Пусть параллелепипед далее объединяется с другим и вычитается из 
некоторого другого объекта. Если пользователь теперь попробует удалить 
переменную, сообщение с полным путем для фаски (Subtract1. Union1. 
Cuboid1. Face1), и что она не доступна.  Итак, здесь невозможно удалить 
размер ячейки разбиения, кроме как копируя первоначальные объекты из 
дерева и восстанавливая последние несколько шагов. Таким образом, все 
параметры настройки зависят от геометрии, которые, вероятно изменятся 
так, что это выполнить уже невозможно. 
     Подобная ситуация может произойти, когда конфигурация решения опре-
делена в CADFEKO и затем блокируется после того, как пользователь 
редактировал файл *.pre. Пользователь больше не может редактировать или 
удалять какие-либо установки, но CADFEKO должен сохранить модель 
непротиворечивой, так как пользователь может в любое время запустить 
решение снова. Это может стать проблемой, если пользователь хочет, 
например, изменить переменную, которая также используется в остальной 
части модели, но это изменение не может быть сделано вследствие того, что 
это вызывает недопустимое состояние в конфигурации решения. 
Единственный путь в этом состоит в том, чтобы допустить конфигурации 
решения снова (CADFEKO автоматически переименовывает редактируемый 
файл *.pre), сделать изменение и затем найти переименованный файл *.pre и 
переименовать его снова. 

4.8. Ввод точки 
 
    В некоторые диалоги ввода геометрии можно вводить значения, нажимая 
мышью на трехмерном представлении. Если поля можно использовать для 
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такого ввода, они имеют желтый фон. Нажимая на трехмерное 
представление, координаты выбранной точки (определенные используя 
режим активного захвата) вводятся в поле, и метка курсора сдвигается в 
следующее поле. Это позволяет создавать геометрию серией щелчков на 
трехмерном представлении, и одним щелчком на Create в диалоге.  
   Для одномерных входных полей (типа радиуса сферы), значение 
рассчитано из заданной точки и результат вводится в поле. Когда вводится 
вектор, он идет от начала координат до выбранной точки. 
    Также можно нажать на поименованную точку или переменную в дереве. 
Тогда эта точка добавляется во всех активных полях или, в случае 
переменной, в текущее поле. Если поля определены, используя 
поименованные точки, они пересчитываются, когда что-нибудь изменяется.  
    Например, если поле U vector на РП определяется с помощью захвата к 
точке модели (например, в вершине сетки), то рассчитывается вектор от 
начала координат до этой точки и вводится в поле как число. Если начало 
координат изменяется впоследствии, направление вектора u остается 
неизменным. Если, однако, направление вектора задается захватом к 
поименованой точке, это изменяется всякий раз, когда изменяется начало 
координат. U vector тогда продолжает указывать на заданную точку. 
     Поля, которые принимают несколько значений от точки, имеют кнопки 
Lock рядом с ними . Если включается кнопка , то поле не 
подставляется при выборе точки. Это используется, когда нужно, например, 
кликнуть на точку на РП без изменения значения в n направлении. Также 
возможно определить различные названные точки в трех составляющих 
полях направлений. Каждая составляющая тогда определена, проектируя 
заданную точку вдоль требуемых размеров.  
    Когда значения введены в поля, показывается предварительная 
иерархическая структура. Если нажаты <Ctrl> <Shift>, при перемещении 
мыши по экрану (без нажатия), значения полей изменяются непрерывно. Это 
называется режимом предварительного просмотра Preview. Активные поля 
показывают значения, которые были бы введены, если мышь была нажата в 
этой позиции. Значения в активных полях отображены, используя курсивный 
шрифт, чтобы указать, что режим предварительного просмотра активен.  
    Режим захвата и зафиксированное положение координат (в глобальных 
координатах) показываются в строке состояния. Если клавиши <Ctrl> <Shift> 
отпущены без нажатия на представлении, величины устанавливаются 
такими, какими были прежде, чем был инициирован режим 
предварительного просмотра. Когда при редактировании примитивов, 
которые были преобразованы, подчеркнутая штриховой линия чертится в 
исходной позиции в дополнение к твердой линии в окончательной позиции. 

Некоторые размеры могут быть ортогональными к рабочей области. 
(Например, высота цилиндра, когда локальные координаты выравниваются с 
РП). Когда эти  величины являются активными, высота определяется как нор-
маль к рабочей области. Это возможно только тогда, когда представление не 
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является ортогональным к рабочей области. Ориентация представления 
модели может быть изменена перетаскиванием левой кнопкой мыши,  
создавая геометрию. 

Нажимая кнопку Create, рассчитываются все вводимые данные. Если 
какое- нибудь поле содержит недопустимое выражение, или значение, которое 
неверно для этого параметра (например, нуль для радиуса сферы), в окне 
сообщения отображается ошибка. 
 

4.9. Локальные координаты 
 
    Все простые геометрические объекты в CADFEKO определены в 
глобальных или локальных координатах. 
    Заданная по умолчанию система координат может быть определена, 
выбирая Options → Preferences из основного меню CADFEKO, но эта 
система может быть изменена в каждом диалоге геометрии. Если поле Use 
global coordinates в диалоге создания не отмечено, закладка Coordinates, как 
показано на рис. 4.18, становится активной. Задание локальных координат 
очень похоже на задание рабочей плоскости. Поле Origin определяет начало 
координат локальных координат. Изменение этого значения преобразуют 
координаты, и, таким образом, положение, где будет создан новый объект. 
Поля векторов U и V определяют направления рабочей плоскости. Третья ось 
N нормальна к осям u и v. Нажатие кнопки Set to workplane . (рис. 4.18) 
устанавливает локальные координаты к РП в текущем представлении. Таким 
образом, инструмент рабочей плоскости может использоваться для 
определения и манипуляцией РП, и затем локальных координат, 
согласованных с ним. 

 
Рис. 4.18. Закладка локальных координат, при создании параллелограмма 
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Если предпочтительнее установить локальные координаты, то эти 
координаты привязываются к рабочей области каждый раз, когда 
открывается диалоговое окно создания геометрии. Сделано так, что после 
открытия диалогового окна, координаты преобразуются. Если нет 
трехмерного представления, локальные координаты согласовываются к 
глобальным. 

Некоторые конфигурации решения также используют локальные коорди-
наты. В некоторых случаях они также используются для примитивов 
геометрии (например, при копировании исходных). В других случаях это, 
возможно, уменьшило бы функциональные возможности (например, в 
дальней зоне области, где пользователь может изменить начало координат, 
но не ориентацию), или добавит дополнительные опции (например, в зоне  
ближнего поля, в которой может также быть вычислена в других системах 
координат). 

Выберите Options → Preferences, чтобы установить заданную систему 
координат, по умолчанию для примитивов геометрии задано средство про-
смотра в формате PDF и шаги отмены сохраняются в памяти. Так как 
используется большой объем памяти для  операций отмены, сокращая 
количество вводов отмены, можно уменьшить количества использованной 
памяти во время работы. 

 
4.10 Редактор текста описания задачи 

 
В CADFEKO имеется редактор текста (рис. 4.19),  в котором пользова-

тель может добавить комментарии к модели. Он открывается из основной 
инструментальной панели или выбирая View → Notes.  

 
Рис. 4.19. Редактор описания задачи 

 
Панель редактора сверху содержит кнопки: Clear (очистить) и Print (пе-

чать) примечания, Undo / Redo, а также стандартные команды Cut, Copy and 
Paste (вырезать, копировать, вставить). Отменить любые изменения в 
тексте можно только командой Undo. Кроме того, редактор позволяет уста-
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новить шрифта, его размер, тип и цвет текста. Если ранее никакие примеча-
ния не были сохранены с моделью, то запускается основной шаблон. 

 
4.11. Получения справки 

 
Выберите Help (помощь) → CADFEKO manual, чтобы открыть 

документы в Help assistant. Кроме этого, нажатие (F1) в любом диалоговом 
окне откроет справку, связанную с этим окном. 

В меню Help также доступно  Руководство пользователя FEKO (User’s 
Manual) и Первые шаги (Getting Started Manual). Эти документы в формате 
PDF, и должен быть установлен Акробат. 
    В дополнение к сообщениям и ошибкам в окне сообщения, CADFEKO 
выдает текстовый файл для регистрации в подкаталоге файлов. Если 
CADFEKO сталкивается с внутренней ошибкой, файл регистрации 
копируется в CADFEKO.ERROR.LOG и текущая модель в 
CADFEKO.ERROR.CFX. Если эти файлы запускают, то сообщается об 
ошибке. 

 
4.12. Быстрые клавиши 

 
Перечислим клавиши быстрого доступа, которые реализованы в 

CADFEKO. 
<Shift> <F1>   "Что это?” (расширенная подсказка). 
<F1> помощь в диалоговом окне. 
<F2> переименовывание выбранного элемента. 
<F9> редактирование в рабочей области . 
<Del> удаление выбранных элементов. 
<Shift> <Ins>   вставка текста. 
<Ctrl> <Ins> копирование выбранного текста. 
<Shift> <Del> вырезание выбранного текста 
<Ctrl> <A> выделение всех элементов 
<Ctrl> <C> копирование выбранного текста 
<Ctrl> <K> для части или элемента решения, которые позволяют 

создать копии выбранных элементов. Для элементов 
геометрии создаются новые части корневого уровня как 
копии выбранных элементов 

<Ctrl> <M> создание сетки разбиения 
<Ctrl> <N> создают новой модели 
<Ctrl> <3> создание нового трехмерного пространства 
<Ctrl> <O> открытие модели 
<Ctrl> <Q> выбор зафиксированной опции (только тогда, когда у 

трехмерного пространства есть центр). Элементы выби-
раются обозначенными клавишами 

<Ctrl> <S> сохранение модели 



 86 

<Ctrl> <V> вставить 
<Ctrl> <X> вырезание выбранного текста (только в редакторе 

примечаний). 
<Ctrl> <Y> отмена последней операции в создании модели 
<Ctrl> <Z> отмена созданной модели. 
<Alt> <←> манипуляция отменой 
<Alt> > <→> манипуляция отменой последней операции 

 

4.13. Проверка обновлений программ FEKO 
 
Выберите Help → Check for updates (проверка обновлений) и нажмите 

Check (проверка) в диалоговом окне, чтобы с помощью сайта EMSS обновить 
программу. Эта операция проверяет, были ли какие-нибудь обновления добав-
лены на сайте FEKO, начиная с последней проверки. (Так как CADFEKO не 
знает, есть ли у пользователя лицензия для других платформ, он  выдает 
сообщение обновления, независимо для какой платформы предназначено  
обновление). Устройство обновления загружает только список обновлений. Но 
информации на сайт не посылается и автоматически обновления не загру-
жаются. Если обновление доступно, оно может быть загружено с сайта 
www.feko.info/members.htm 

Если активизируется автоматическая проверка обновления, то CADFEKO 
обращается на сайт каждый раз спустя семь дней после последней проверки. 
Это также возможно, если у вас есть доступ к Интернету. Эта установка раз-
делена на CADFEKO и EDITFEKO. Закладка Info относится к проверочному 
устройству обновления, не доступному обновлению. 
 
5. Создание модели 
 
   В предыдущей главе был описан интерфейс FEKO. В этой будет 
рассмотрена последовательность черчения конструкции. При решении задач 
в FEKO, модели могут быть созданы и решены полностью в интерфейсе 
CADFEKO (рис. 5.1). Утилита EDITFEKO (раздел 8), которая работает с 
картами, дает дополнительные, более широкие возможности расчета. По 
мере совершенствования CADFEKO, всё большой класс задач можно решить 
полностью в ней.  
 

5.1. Создание конструкции в CADFEKO 
     
    Единицы длины в CADFEKO устанавливаются командой Model → Model 
unit. Помимо стандартных единиц, можно выбрать произвольные единицы. 
Например, можно задать 1x10-6 при работе с микронами. Единицы отобража-
ются в строке состояний.  
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Рис. 5.1. Интерфейс FEKO с деревом проекта анализа отрезка линии 
 
    Изменение единиц длины не изменяет самих чисел, а только интер-
претацию их до и после изменения единиц, следовательно выбор единиц 
длины можно сделать в любое время при построении модели.  
    Операции на геометрии (которые могут привести к выявлению одинаковых 
точек) требуют задания числового допуска. Этот допуск зависит от размера 
модели. (Например, микрополосковые структуры могут быть созданы с точ-
ностью нескольких микрон, но эта точность не нужна при изучении 
распространения радиоволн в горах). 
   Максимальные размеры модели выбираются в CADFEKO командой 
Geometry → Extents из главного меню. Расширение геометрии выполняется 
одинаково во всех направлениях и, таким образом, нужно задать только одно 
значение. Это максимальная координата, которая дает самое большое 
смещение - в любом направлении - по любому из этих трех параметров. 
Например, если максимальная координата равна 500, вся геометрия должна 
находиться внутри поля 1000x1000x1000 (единиц), с центром  в начале 
координат.   
    Допуск модели определяется как параметр в диалоге Maximum coordinate, 
разделенный на 5x108 (рис. 5.2) . Если значения координат отличаются боль-
ше, чем на эту величину, они приобретают конкретные, отличные значения. 
Значения будут уникальными, если разница между ними – меньше, чем сотая 
часть допуска.  

 
Рис. 5.2.Задание максимальной координаты 
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    По умолчанию для расширения геометрии выбирается значение 5E+02, и 
это расширение рекомендуется, если модель не большая. Для величины, от-
личной от 5E+02, экспортируемая модель Parasolid не будет транслироваться 
в единицах, используемых в CADFEKO.  
    Размер бокса относится ко всей геометрии. Например, пересечение между 
двумя сферами не может быть создано, если одна из сфер превышает размер 
бокса, даже если результат преобразования находится внутри него.  

 
5.2. Черчение используя примитивы 

  
    Меню Geometry → Solid (рис. 5.3) содержит подменю для черчения 
нового кубоида, пирамиды (возможно усеченной), сферы, цилиндра или 
конуса. 
     Процесс черчения аналогичен для всех компонентов, так что обсудим этот 
процесс на примере кубоида. При создании геометрии используются глобаль-
ные или локальные координаты и точку ввода.  
    Объекты имеют фиксированную ориентацию в выбранных (глобальных 
или локальных) координатах. Для кубоида все фаски можно использовать как 
плоскости для черчения следующей компоненты. Для пирамид основание 
(база) её выравнивается с плоскостью xy или осями U и V, а высота идет в 
направлении оси z или N. Для цилиндров и конусов ось идет в направлении 
оси z или N. При произвольном ориентировании, объекты должны быть 
созданы в локальных координатах.  
 

 
Рис. 5.3.Команды черчения примитивов и обработки геометрии 

 
   В диалоге Create cuboid (рис. 5.4) нужно ввести положение одного угла и 
размеров по трем координатным направлениям.  
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Рис. 5.4. Диалог создания куба 

 
    Новый объект создается после нажатия кнопки Create. Когда все нужные 
параллелепипеды созданы, нажмите Close, или  <Esc>, чтобы закрыть диалог. 
Размеры должны быть ненулевые, иначе CADFEKO покажет ошибку в 
информационном окне и укажет неверное поле. Возможны отрицательные 
значения (типа ширины кубоида), они принимаются как встречное 
направление от координаты угла.  
    В поле Label записывается имя нового объекта. Это имя появится в дереве 
проекта и может быть изменено в любое время.  
      Если поле Radius для сферы или цилиндра определено точкой, 
поверхность сферы, или расширение цилиндра будет выполняться через эту 
точку. Для конуса радиус определяется как расстояние между началом 
локальной системы координат и направлением в локальной uv плоскости. 
Чтобы определить остроконечный конус, оставьте Top radius =0.  
     Твердые примитивы - по умолчанию идеальные электрические провод-
ники, но могут быть изменены на диэлектрик или структуры в виде внешнего 
слоя. Это выполняется установкой свойств области.  
 

5.2.1.Черчение двумерных поверхностей 
 
    Все двумерные поверхности создаются как твердые листы. Поэтому они 
также включают ввод фаски (поверхности относятся к частям или 
компонентам). Фаски относятся к отдельным сторонам, составляющим 
поверхностям или определяются как границы твердого тела. В настоящее 
время можно создать только плоские полигоны, эллиптические диски и 
поверхности параболоида.  
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     Полигоны создаются с помощью диалога Create polygon (рис. 5.5). Этот 
диалог использует глобальные или локальные координаты и точки ввода. Все 
указанные точки должны лежать в одной плоскости. В простейшем случае 
можно выполнить выравнивание локальных координат с плоскостью 
полигона,  и в этом случае все значения координаты Z равны 0.  

 
Рис. 5.5. Диалог создания полигонов 

    Командой Add вводится дополнительный угол формы. Углы полигона 
вводятся последовательно, не допуская пересечение граней. Угол 
показывается синим квадратом на трехмерном чертеже. Кнопка Reverse 
normal переупорядочивает точки таким способом, что вектор нормали 
(определенный в математически положительном смысле от направления 
граней), реверсируется.   
   Когда нажимается Create, все пустые точки удаляются автоматически. В 
закладке Properties можно установить опцию неразбиения этой платы на 
ячейки (Unmeshed plate). Если это свойство - устанавливается как True, поли-
гон разбивается на ячейки в виде прямоугольников, а не на треугольники. 
Это используется, если полигон рассчитывается методом UTD. 
    Параболоид используется для черчения параболической антенны. Этот 
элемент также относится к двумерным поверхностям. Если создается 
параболоид командой Creare Paraboloid, его фокусное расстояние f связано 
с высотой h: 

h
Rf
4

2
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Рис.  5.6. Размеры параболоида 
      
    Глубина рефлектора идет от начала координат до точки фокуса f. 
Параболоид (рис. 5.6) ориентируется по оси N. Поле Radius определяет 
радиус R в плоскости, ортогональной к оси N и должно быть 
положительным. Если она отрицательна, параболоид меняет ориентацию по 
оси N.  
 

5.2.2.Создание искривленных форм 
 
    Искривленные части конструкций в CADFEKO могут быть созданы с 
помощью операции смещения spin, вращения sweep или слияния loft. В 
дополнение к сложным конструкция, получающимся из соединений фасок и 
поверхностей, CADFEKO использует ряд простых геометрических 
компонентов, таких, как одиночные прямые и ломаные линии, сплайны, 
кривые Безье, эллиптические дуги и спирали. Создание искривленных 
примитивов похоже на создание твердых объектов и поверхностей.  
    Ломаная линия и сплайны используют список точек. Здесь, как для поверх-
ностей полигона, используются новые поля, а неиспользованные точки уда-
ляются перед построением геометрии.   
    Компонента спирали может также создавать конические спирали 
установкой верхнего и нижнего радиуса к различным значениям, или 
плоским спиралям, при установке высоты равной нулю.  
    Заметим, что радиус провода определен на ребре (он устанавливается в 
дереве подробностей), а не на примитиве. Задание радиуса провода (ребро, а 
не граничная фаска) который был создан геометрической операцией (типа 
пересечения двух фасок) выполняется таким же образом.  
 

5.3. Экспорт и импорт геометрии 
 

    CADFEKO выполняет моделирование твердого тела в формате Parasolid. 
Модели Parasolid могут быть импортированы и экспортироваться без 
преобра-зования.  
   Выберите File → Export → Parasolid..., чтобы экспортировать геометрию в 
виде файла Parasolid. Нужно сделать выбор между текстовым или бинарным 
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форматом. CADFEKO в настоящее время экспортирует файлы Parasolid 
версии 17.0, но можно импортировать файлы более старых версий Parasolid. 
Экспорт и импорт той же самой модели теряет полное созданное дерево, 
подобно выполнению элементарной операции.  

 
Рис. 5.7. Диалог выбора типа файла экспорта 

 
    Модели Parasolid ограничены полем 1000x1000x1000 единиц, с центром в 
начале координат. CADFEKO вводит масштабный коэффициент, чтобы 
согласовать размеры импортируемой модели (см. расширение геометрии). 
Поле Scale factor при экспорте модели Parasolid показывает коэффициент, 
на который умножаются все размеры модели, чтобы преобразовать её к 
единицам модели Parasolid. Масштабный множитель 0.1 подразумевает, что 
размеры сохраненной модели Parasolid - десятая часть от исходных размеров 
CADFEKO. Многие программы, которые импортируют модели Parasolid, 
определяют коэффициент, на который модель Parasolid должна быть 
умножена во время импорта. Это должно быть величина, обратная 
масштабному множителю CADFEKO. Для удобства, коэффициент импорта 
сохраняется в файле с расширением .info, например 
export_geometry.x_t.info.  
    Если модель должна включить больший размер, чем 500 единиц, 
множители должны быть увеличены. Если, однако, модель меньшая, чем 50 
единиц, то размер может быть уменьшен. Это не рекомендуется, если модель 
не очень малая и выполняется в пределах точности.   
    Модель Parasolid может также быть импортирована в CADFEKO, 
командой File → Import → Geometry → Parasolid..... из главного меню.  
 

 
Рис. 5.8. Список файлов импорта 
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    Появится запрос об имени файла и затем открывается диалог Import 
Parasolid, где можно изменить масштабный множитель. Например, если 
модель антенны была создана в мм и затем импортируется модель 
автомобиля, созданная в м, масштабный множитель будет равен  0.001, 
независимо от масштабного множителя, требуемого по модели. 
    Изолированные вершины в модели Parasolid - не то же самое, как поиме-
нованные точки в CADFEKO. Они не импортируются, но CADFEKO 
записывает их координаты в информационное окно. Требуемые 
поименованные точки могут быть созданы вручную.  
    Важно, что импортированная модель имеет хорошее качество. Если 
импортированная модель имеет накладывающиеся поверхности, в результате 
могут появиться промежутки между поверхностями.  

 
Рис.5.9. Диалог установки единиц импортируемых моделей 

 
    Если выбран режим Import bodies with faults, все части в файле 
импортируются, даже если они содержат ошибки. Это может тогда быть 
возможно, и в этом случае, ликвидируйте компоненты с ошибками, и удалите 
только несколько проблематичных поверхностей. Эта опция должна 
использоваться осторожно - это позволяет прибавлять возможно 
разрушенные данные в модель, которая приняты как непротиворечивые. 
Идеально модель должна быть заархивирована до и после этой операции.  
    CADFEKO может также импортировать другие форматы CAD. В 
настоящее время поддержаны ACIS, Catia, ProEngineer, Step и Unigraphics. 
Импорт геометрии выполняется по команде File → Import → Geometry . 
    CADFEKO запросит об имени файла и затем открывает диалог импорта 
модели. Группа Units в этом диалоге показывает единицы импортированной 
модели и позволяет установку единиц. Эти единицы могут отличаться от 
единиц модели и согласовываются масштабным коэффициентом. Если 
CADFEKO не устанавливает единицы импортированной модели, то значит, 
что это метры. Может потребоваться выбрать другие единицы, чтобы 
выполнить импорт модели внутри модели Parasolid с допуском, 
обсужденного выше.  
    Так как импортированная модель преобразована к Parasolid, все 
комментарии для импорта Parasolid также применяются здесь. Из-за 
различий в правилах построения, преобразование формата CAD может иметь 
неожиданные результаты. В частности, примыкающие поверхности иногда 
не ложатся корректно. Эта проблема из-за того, что CADFEKO еще не имеет 
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все CAD инструментальные средства. Проблемы преобразования записы-
ваются в файле FEKO_USER_HOME \logs\CADimport.log, что является 
полезным в случаях сбоев преобразования.  
 

5.4. Работа с геометрией 
  
   Любая комбинация объектов или переменных, от которых они зависят, мо-
жет параметрически изменяться. Параметры доступны из главного меню или 
инструментальной панели.  
    Редактирование включает Булевы операции (объединение, вычитание и 
пересечение), и другие дополнительные операции (типа проектирований, 
расщепления, свипирования и протаскивания), переименовывание (чтобы 
изменить метку / название объекта или одной из его областей / фасок / граней 
- все объекты в модели должны иметь уникальные имена), копирование, 
удаление (доступное через клавишу < Del >), реверсирование нормалей 
фасок и установление свойств (в диалоге редактирования, подобном диалогу 
создания).  
    Когда смежные объекты расположены с небольшим нарушением границ, 
могут иметься фаски и / или грани, которые имеют очень малое перекрытие 
или непересекающиеся секции, как показано на рис. 5.10. Если эти секции 
имеют размеры, того же порядка, как допуск модели, булевы операции 
между этими объектами могут выполниться неверно или привести к очень 
малым сторонам или промежуткам. Для того, чтобы быть уверенным, что 
объекты собраны корректно, нужно использовать операции захвата. 
Подобные проблемы могут происходить, когда элемент разбит очень близко 
к границе.  
 

 
Рис. 5.10: Топология с небольшим нарушением границ включающих 

поверхностей с перекрытием ребер, а также короткие непересекающийся 
ребра 

 
    Сложная геометрия создается последовательностью операций, начиная с 
простых примитивов. Эти процедуры сохраняются в дереве проекта с самого 
начала создания структуры. На любом уровне в дереве проекта можно 
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выбрать и изменять объекты, или параметры, или значения переменных, 
которые описывают геометрию. Для удобства выбора материнских объектов, 
CADFEKO показывает каркасное представление всех выбранных объектов.  
   Все объекты в дереве получают новые номера, когда изменяется 
компонента. Во время этого процесса CADFEKO может не выполнить 
тождества некоторых областей / фасок / граней, например, где несколько 
фасок получены из той же самой первоначальной фаски во время Булевых 
операций. Эти объекты тогда отмечаются как подозрительные (что 
отмечается вопросительным знаком ря-дом с ним в дереве) как 
предупреждение, что свойство, устанавливаемое на него, возможно, не 
поддержано. 
 

 
Рис. 5.11. Проблемные ребра с пояснением: неверное определение исходного 

объекта 
     
   Причина этой проблемы отображается, если курсор помещается поверх эле-
мента в дереве. После этого нужно обеспечить, чтобы свойства были 
верными или были исправлены, области/фаски/грани, могут быть 
возвращены, используя установки из всплывающего меню.   
   Некоторые объекты конфигурации решения (например, порты) которые 
зависят от модели, будут также отмечены как подозрительные, если модель 
изменилась так, что они больше не правильны. Их нужно отредактировать и 
установить снова, чтобы удалить подозрительность.  
 

5.4.1. Булевы операции 
 
    Главное меню Geometry и инструментальная панель редактирования 
геометрии обеспечивают доступ к Булевым операциям. Перед выполнением 
булевых операций, должны быть выбраны части.  
    По команде Geometry -> Union объединяются все выбранные части.  
    При использовании команды пересечения, в результате остается общая 
часть всех выбранных частей.  
   При операции вычитания, все выбранные части вычитаются из последней 
час-ти, которая должна быть выбрана, когда появится запрос. Когда только 
одна часть выбрана, единственная разрешаемая булева операция - вычитание. 
Никакие булевы операции не доступны, когда не имеется никаких 
выбранных частей. (Поверхности и провода - также части.) Булевы действия 
не могут быть применены к материнскому объекту или к частям: областям / 
фаскам / граням.  
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    Выбор Geometry → Split из главного меню откроет диалог, в котором 
может быть задана плоскость расщепления, аналогично определению 
рабочей плоскости. По умолчанию плоскость расщепления совпадает с 
рабочей плоскостью. Эта расщепления создает две новые части (названные 
Split_back ... и Split_front ..., в направлении положительной оси N плоскости 
расщепления) для каждой выбранной части. Две половины каждого 
разбиения получены из независимых копий исходной конструкции.  
    Если исходные объекты расщепляются, удаляется вид одной половины, а 
другая половина остается неизменной.  
   Если нужно синхронно менять конструкцию, исходная деталь должна быть 
создана, используя переменные. Плоскость разбиения может изменяться,  вы-
бирая новую часть и выбирая Properties из выплывающего меню.  
 

5.4.2. Операции свипирования и протаскивания 
 
    Командами Geometry → Sweep или Geometry → Spin из главного меню  
выполняется свипирование (также называемое экструзия) выбранного 
объекта по указанному вектору или вращением вокруг указанной оси. Эти 
действия могут быть применены только к частям. Операции sweep /spun 
применяется отдельно к каждой из выбранных частей. Если несколько частей 
перемещаются или вращаются, получающиеся новые части становятся 
самостоятельными и могут далее обрабатываться независимо.  
 
    Части, содержащие только грани и/или фаски (не твердые вещества или 
замкнутые области) можно вращать или перемещать. Однако объекты в виде 
поверхностей должны иметь одну границу, которая не накладывается сама на 
себя, и никакое ребро не может быть приложено больше, чем к двум фаскам 
(например, Т-образную плату на рис. 5.12 нельзя  вращать/перемещать, пос-
кольку она имеет три фаски, связанные границей). Перемещение или 
вращение кривой приводит к поверхности, тогда как применение этой 
операции к поверхности дает твердое тело.  
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Рис. 5.12. T-сочленение, имеющее три фаски с границей, так что её нельзя 
перемещать и вращать 
 
    Когда выбрана команда Sweep, диалог Sweep geometry позволяет задать 
вектор в терминах начальной и конечной точки. В эти поля вводятся точки 
стандартным способом. Нельзя свипировать объекты в направлении, 
тангенциальной к любой из его граней или в плоскости его фасок.  
     В диалоге Spin geometry нужно задать ось и угол вращения. Угол в 
градусах идет по часовой стрелке вокруг указанной оси. Кнопки Set to ... axis 
позволяет выбор параметров осей. Отметим, что кнопка локальной оси 
активна только в том случае, если все выбранные части имеют ту же самую 
локальную систему координат. Нормальные направления получающихся 
фасок зависят от направления кривых.  

 
Рис. 5.13. Пример поверхности с ребром, который касается оси вращения 

     
   Имеется ряд ограничений на соотношении между частью и осью вращения. 
Никакие свободные грани не могут совпадать с осями, и при этом они не 
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могут пересечь ось в любой точке, отличной от конечной точки ребра. При 
задании полного вращения частей с фасками, ось не может пересекать фаску 
только в одной точке, хотя она и лежит на ребре. Ось может совпадать с 
любым ребром стороны, при условии, что все ребро находится на оси. Кроме 
того, никакое ребро не может касаться оси даже в одной точке, как показано 
на рис. 5.13 (это позволяется, если всё ребро лежит на оси.).  

Есть ряд ограничений на соотношения между объектом и осью вращения. 
Никакие свободные ребра не могут совпадать с осью, и при этом они не мо-
гут пересекать ось в любой точке кроме концов характеристики. Для 
поверхностей, созданных вращением, ось, возможно, не пересекает 
поверхность только в одной точке. Ось может быть совпадать с любым 
ребром полости, при условии, что ребро полностью лежит на оси. Кроме 
того, никакое ребро не может касаться оси, как показано на рис. 5.13, даже 
если ребро имеет излом в этой точке (снова, это позволяется, если 
начерченные ребра лежат на осях).  
 
5.4.3. Поверхности созданные операцией Loft 
 
    Операция Loft формирует гладкую поверхность, соединяя две кривые 
части прямыми линиями. В результате имеем линейчатую поверхность, но 
это не фасеточная модель, если одна или обе кривой не ломаные линии.   
   Искривленные поверхности могут состоять из ряда граней, например, лома-
ных линий. Две соединенные кривые должны иметь то же самое число 
граней (сглаживание может рассматриваться как подключение еще двух 
граней). Если дело обстоит не так, точки могут быть впечатаны на одном из 
них, чтобы показать этот факт. Кривые с больше, чем двумя гранями, 
соединяющимися в каждой точке, не позволяются. Выполните 
предварительный просмотр, когда кривые будут связаны. Диалог Loft 
позволяет реверсировать начальные и конечные точки одного ребра в случае, 
где две грани не созданы в одном  (или желательном) направление.  
 
5.4.4. Проекция точек на другую плоскость и впечатывание 
точек 
      
    В некоторых случаях желательно создать специальные точки, грани или 
фаски на данной геометрии. Например, чтобы присоединить другие струк-
туры к модели, чтобы задать очень узкую искривленную щель или создать 
проводящую полоску на диэлектрических объектах. Это выполняется нажа-

тием на . Ранее в CADFEKO было возможно определить вершину в диа-
логе Edge properties. Теперь такие точки должны быть созданы с операцией 
Imprint points.  
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Рис. 5.14. Создание впечатываемых точек 

 
     Операция Imprint points позволяет поместить точки на выбранную часть 
конструкции. Точки могут быть впечатаны на одной части только один раз. 
Диалог Imprint points (рис. 5.14) позволяет задать список точек, используя 
стандартные точки ввода в глобальных или локальных координатах. Точки 
наносятся в самом близком месте к выбранной части - или на фаске или 
ребре. Точки не могут быть впечатаны на уже существующие точки. 
Операция впечатывания создает новый элемент в дереве (позволяет доступ к 
этой части без точек), но использует имя исходного объекта.  
    Несколько частей могут быть спроектированы на другую часть, выбирая 
их операцией Project и затем выбирая целевую часть, на которую нужно 
выполнить проекцию. Эта последовательность подобна операции вычитания. 
Как в операции вычитания, все спроектированные части выступают как 
исходные получающейся части, то есть они больше не представляются как 
отдельные части модели. Все грани выбранных частей проектируются на 
фаски целевой части. Любая часть (кривые поверхности и твердый объект) 
может быть спроектирована на любую часть, содержащую фаски. Сферы не 
имеют граней, следовательно операция проектирования сферы (в этом 
смысле) некорректна. Когда проектируются замкнутые формы в виде 
траектории, создаются новые фаски.  
    Направление проекции определяется по нормалям к поверхности цели. 
Проектируемые ребра на выпуклые изогнутые фаски целевой поверхности 
будут, таким образом, иметь тенденцию уменьшать их размер и / или 
перспективу. Выпуклые поверхности могут также "заслонить" другие 
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поверхности, в которых все точки на ребре проекции могут проектироваться 
на изогнутую фаску даже при том, что кажется, как будто это должно также 
проектироваться на другую фаску. Поэтому грани проектируются только на 
нормальную сторону фасок.  
    Рёбра, где проекции пересекаются сами с собой или возвращаются обратно 
на себя, не позволяются.  
 

5.4.5. Реверсирование нормали фасок 
 
    Нормали фасок могут быть реверсированы, командой Reverse face normals 
из всплывающего меню или Geometry → Reverse face normals из главного 
меню. (Нормали всех выбранных фасок реверсируются, даже при том, что 
только фаски одной части показываются в дереве подробностей в любое 
данное время.)  
    В настоящее время невозможно полностью изменить нормаль на теле с 
одной замкнутой фаской, например, сферой. Если такая нормаль была 
реверсирована, самая простая опция должна показать круглую линию на 
объекте, чтобы создать две фаски. Нормали этих фасок могут тогда быть 
реверсированы и ребро разделяется, упрощая эту часть.  

 
5.4.6. Удаление деталей и операция упрощения 
 
    Лишние фаски могут быть удалены, выбирая их и нажимая клавишу <Del> 
или команду Delete из выплывающего меню. Фаски становятся лишние, если 
только они имеют ту же самую среду (то есть металл, свободное 
пространство или та же самая диэлектрическая среда) с обеих сторон. Когда 
удаляется фаска, внутренняя область свободного пространства отделяется от 
внешнего свободного пространства, а внутренняя область объединяется с 
внешней. Так как внешняя среда - свободное пространство, фаски могут 
только быть удалены из замкнутых областей, если внутренняя среда - 
устанавливаются к свободному пространству.  
    Лишние и свободные грани могут быть удалены аналогично. Эти объекты 
обычно удаляются при создании, но можно скопировать первоначальный 
объект, в котором они всё еще существуют. Также, если компонента или 
переменная изменены таким способом, что объект повторяется, 
подозрительные фаски не будут удалены, и некоторые удаленные фаски 
могут вновь появляться. Заметим, что грани не являются лишними, если 
нормали фасок находятся во встречных направлениях. По этой причине 
передняя и задняя стороны фасок окрашены по-другому в режиме просмотра, 
и возможно полностью изменить нормали фасок. Нормали треугольников 
находятся в том же самом направлении как фаски, от которых они 
произошли.  
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    CADFEKO также позволяет автоматическое перемещение и удаление 
лишних фасок и граней. Диалог упрощения геометрии (рис. 5.15) вызывается 
командой Geometry → Simplify.  
 

 
Рис.5.15.  Диалог упрощения геометрии 

 
    Эти операции позволяют удалять конкретные типы деталей. Упрощенная 
геометрия, как электромагнитный объект, будет той же самый, как оригинал, 
но не будет иметь те же самые связи разбиения на сетку. Если, например, 
впечатанная точка удаляется, больше не будет иметься гарантированная 
вершина сетки в этой топологии. (Заметим, что впечатанные точки, которые 
не приложены к любым граням, рассматриваются лишними). Фаски не могут 
быть удалены, если области, которые они разделяют, могут быть 
объединены. То же самое применяется к граням на границах фасок и точек 
геометрии в конце граней.  

Ри
с. 5.16. Иллюстрация операции упрощения 
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        По умолчанию операция упрощения не удаляет излишние области, фас-
ки или грани, на которых установлены локальные опции разбиения. Чтобы 
удалить их, должна быть снята опция Keep ...with local properties  .  
   Например, рассмотрим объединение двух сфер с диэлектрической средой, 
показанной на рис. 5.16(a). Размер локальной ячейки - установлен в области 
Region1. Если объединение упрощается, отмечая опцию Keep regions with 
local properties, результат такой, как показывается в (b). Когда область 
содержит локальные свойства, они не удаляется. Тогда фаска между ней и 
средней областью не также удаляется. Если затем опция Keep regions with 
local properties не отмечена, результат такой, как показано на рис. 5.16(c).  

 
5.5. Копирование объектов 

 
    Геометрические объекты, включая материнские объекты, могут быть 
скопированы и созданы как новые части, выбирая объекты, командой Edit → 
Copy из главного меню (или используя  < Ctrl > < K >). Например, если 
создана оболочка сферы, вычитая одну сферу из другой (который удалит обе 
первоначальные сферы из модели и перечислит их как исходные объекты 
перед булевой операцией) внутренняя сфера может быть скопирована, чтобы 
создать новую часть, которая была бы как внутренняя оболочка. Скопи-
рованные объекты создаются в корневом уровне, даже если первоначальные 
предметы формируют часть из сборки. Также возможно сделать несколько 
преобразованных и скопированных частей.  
     Новая часть полностью независима от существующей, и ни одна не 
изменится, если изменяется другая. Если желательно, чтобы они изменились 
вместе, первоначальный объект должен быть создан, используя переменные, 
что будет выполняться во время копирования.  
     Также возможно выбрать фаски или грани частей и выбрать Copy. В этом 
случае новые части создаются как выбранный элемент. Это позволяет, напри-
мер, скопировать ребро сложного объекта и использовать операцию связи 
loft  к другому ребру. Заметим, что эти копии - кадры модели, когда копия 
сделана - они не связаны с исходным объектом и не параметрические.  
 
 

5.5.1. Копирование оригиналов 
 
    Если фаски или грани удалены из части, они удалены из модели. Эти 
фаски могут быть вновь созданы,  копируя исходные объекты, из которой 
получена эта часть или операцией восстановления. Это может быть очень 
громоздкая операция, для которой CADFEKO обеспечивает простое 
решение. Выберите требуемые объекты, и Edit → Copy special → Copy 
original из главного меню или команду Copy special → Copy original из 
всплывающего меню.  
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5.5.2. Ликвидирование частей  
 
    Команда Geometry → Explode ликвидирует все выбранные части геомет-
рии. Ликвидирование не значит удаление. Отделенные новые поверхностные 
части созданы для каждой фаски и освобождают ребро от первоначальных 
частей. Новые части представляют копию мгновенного снимка геометрии во 
время процесса ликвидации - они не параметрические.  

 
Рис. 5.17.  Символы ликвидированных элементов 

 

5.5.3. Создание примитива с удалением хронологии его 
создания  
 
    CADFEKO хранит всю хронологию создания каждой части, позволяя 
пользователю изменить любую точку в хронологии создания. Эта полезная 
операция требует существенного объема памяти и в некоторых случаях 
также существенное время.  

Если компонента, которая была получена, в результате, например, 
операции объединения, модифицируется , CADFEKO должен обновить 
части исходного материала, чтобы повторно выполнить объединение. Так как 
они не сохраняются на каждом уровне, это означает построение их снова от 
самого первого уровня. Однако весьма часто большая часть модели никогда 
не будет изменяться. (Это, например, модель автомашины будет изменяться 
на другую модель, но нужно менять размещение антенны на таком 
носителе). Следовательно, она не должна быть пересчитываться каждый раз, 
когда изменяется малая часть конфигурации. 
     Следовательно, она нужно требовать, чтобы пересчитываться их, каждый 
раз, когда малая часть геометрии изменена.  
 

 
Рис. 5.18. Символ созданного примитива 
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     Поэтому CADFEKO имеет опцию, чтобы выбрать эту часть по команде 
Geometry → Make primitive. Это удаляет полную хронологию создания и 
сохраняет модель, как есть. Если пользователь использует эту часть в других 
действиях и изменяет те действия, часть доступна немедленно, создав прими-
тивы. Поэтому она становится примитивом. Можно сэкономить время 
обработки и также уменьшить случаи, когда грани / фаски или области не 
могут быть отображены и стать подозрительными.  
 

5.5.4. Проверка правильности геометрии 
 
    CADFEKO дает возможность выполнить основные проверки на 
непротиворечивость на геометрии. Так как должным образом связанные 
сетки только гарантируются для одной части, важно гарантировать, что части 
не исключают друг друга. Части конфликтуют, если имеется любой контакт 
между ними или если одна часть находится полностью внутри другого. 
Выделите всё объекты, чтобы это проверить (или нажмите <Ctrl> < A > при 
выборе частей геометрии) и выберите команду Find → Clashing geometry 
(проверка геометрии) из главного меню. Проблемные части остаются 
выбранными и перечислены в информационном окне.  
 

 
Рис. 5.19. Выбор несоединенных ребрами геометрий 

 
      Команда Find → Unconnected geometry edges находит и выбирает все 
грани выбранных частей, которые являются свободными (не соединенные ни 
к какой фаске) или приложенными к только одной фаске. Если эта опера-ция 
выбирает ребро, которое, как кажется, связано с несколькими фасками, это 
означает, что имеются больше чем одно ребро в этой топологии и что фаски 
не имеют электрический контакт. Это указывает проблему в модели.  
 

5.5.5. Разбиение на ячейки  
 
     Выберите команду Mesh → Create mesh или нажмите <Ctrl> < M>, чтобы 
открыть диалог Create mesh, показанный на рис. 5.20. Укажите, будут ли все 
части или только выбранные части разбиваться на ячейки. В отличие от 
других диалогов, выбор может быть изменен, пока диалог открыт. Это 
позволяет, например, разбивать различные части на ячейки с различной 
плотностью без закрытия диалога.  
 



 105 

 
Рис.  5.20. Диалог разбиения на ячейки 

 
  В поле Edge length вводится размер разбиения для граней треугольников и 
тетраэдров. Заметим, что некоторые грани могут быть на 30 % больше чем 
это значение. Все грани, не формирующиеся границы фасок, полагаются 
проводящими проводами и разбиваются на сегменты. В поле Segment length 
задается максимальная длина этих сегментов. Обычно, радиусы этих 
проводов определены на гранях геометрии. В поле Wire segment radius  
задается радиус, который относится ко всем проводам, для которых не 
определен локальный радиус. Если отмечена опция Enable volume meshing, 
все диэлектрические твердые объекты разбиваются на тетраэдры так, и они 
становятся областью решения методом конечных элементов (FEM).  
    Размер ячейки не может быть меньшим, чем максимальная координата, 
разделенная на 1x108. Это - предел численной точности геометрии. Для очень 
малых моделей (требование соответственно малые размеры), расширения 
геометрии должны быть уменьшены.  
     Группа Small features позволяет специальную обработку тонких 
подробностей геометрии. Поле Small feature size определяет предел размера 
ячейки разбиения как процента от части, которой это принадлежит. В режиме 
Default сетка разбивается обычным образом. Это приведет к точному 
представлению геометрии, включая очень малые элементы. Оптимизация 
полезна, где геометрия имеет длинные узкие заусенцы или фаски, лежащие 
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близко друг к другу. Если эта опция выбрана, CADFEKO пробует 
выравнивать вершину на противоположных сторонах малой особенности как 
показано на рис. 5.21.  
    Наконец, можно игнорировать малые особенности, выбирая режим Ignore. 
Тогда малые детали игнорируются с точностью, установленной для 
геометрии. Эта опция также иногда позволяет разбивать на ячейки 
неправильные фаски, которые не могут быть разбиты на ячейки, используя 
настройки по умолчанию. Заметим, что игнорирование малых деталей не 
работает для замкнутых граней. Такие грани могут, однако, быть разделены 
впечатываемыми точками.  
 

 
Рис. 5.21. Сетка, выполненная по умолчанию (вверху) и оптимизированная 
(внизу),  длинного узкого элемента. Здесь ширина ленты становится 
минимальным размером ячейки. Для оптимизированной сетки, вершины на 
длинных гранях выровнена. 
 
    В режиме сглаживания сетки Enable mesh smoothing применяется 
дополнительный алгоритм кэширования. Это приведет к лучшей сетке, но 
увеличит время разбиения на ячейки.  
    Размеры, указанные в диалоге Create mesh, используются на всех 
объектах, которые не имеют локальное разбиение. Заметим, что если область, 
которая имеет локальный размер ячейки, разбивается на тетраэдры, то размер 
ячейки разбиения будет также относиться к фаскам на границе. 
Дополнительный уменьшенный размер ячейки может, конечно, быть 
определен на этих фасках (используется минимальное значений из всех 
соответствующих локальных размеров ячеек). Аналогично, установка размер 
ячейки на фаске также устанавливает этот размер на его граничных ребрах. 
Если наименьший размер ячейки определен, например, на ребре фаски, то 
треугольники фаски будут точно соответствовать этой длины по ребру, даже 
при том, что остальная часть фаски будет разбиваться на ячейки большего 
размера.   
   Параметр Mesh size growth factor управляет скоростью изменения размера 
ячейки. Можно сделать резкий переход от малых к большим ячейкам, в то 
время как при плавном изменении размера каждый треугольник не будет 
увеличиваться вдвое, по сравнению со связанной ячейкой.  
    Сетка отражает текущую геометрию. Любые изменения геометрии (напри-
мер, изменение радиуса провода), сделанные после разбиения, не будут 
отражены в сетке. Порты, созданные на геометрии не будут иметь сетки, 
пока не будет запущено разбиение на ячейки.  
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Рис. 5.22. Диалог разбиения на сетку 

 
    Сетка находится в дереве в разделе Meshes с той же самой структурой как 
первоначальные части геометрии. Сети идентифицированы только их 
метками. При разбиении геометрии, CADFEKO даст предупреждение, если 
сетка с такой меткой уже существует (рис. 5.23).  

 
Рис. 5.23. Запрос на замену сетки 

 
    Существующая сетка может сохраняться или заменена. Если сетка или 
геометрия переименованы перед попыткой повторно разбить на сетку, созда-
ется дополнительная часть сетки геометрии.  
 
5.6. Задание локальных параметров разбиения на 

ячейки 
 
   Иногда точное решение требует очень мелкую сетку разбиения в некоторой 
части модели. Тогда вместе с заданием глобальной сетки, пользователь 
может определить локальный малый размер для этих частей структуры. 
Например, в изогнутых частях структур, и может требоваться более плотная 
сетка, чтобы получить точное представление геометрии.  
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Локальные параметры разбиения для поверхностей или краев 
устанавливаются в группе Mesh size в соответствующем диалоговом окне 
Properties (рис. 5.24). Эта группа содержит опцию Local mesh size 
(локальный размер сетки), которая должна быть отмечена, если 
устанавливается локальный размер сетки. Для областей локальный размер 
ячейки используется только для разбиения на сетку области 
четырехгранника. Размер ячейки в итоге на любом элементе – это 
минимальный из всех размеров разбиения, применимых к нему. Как пример, 
если к граничным краям у поверхности, которая является границей области 
всех трех элементов, применяется локальный размер ячейки, размер петли по 
краю равен минимуму всех трех этих размеров. Локальный размер ячейки 
может быть больше, чем общий размер петли. Отметим, однако, что если 
никакой локальный размер ячейки не назначен на краю, который к ним 
относится, то у треугольников на краю поверхности тогда будет общий 
размер сетки. 

 
Рис. 5.24. Диалог свойств сетки разбиения 

Первоначально диалоговое окно (рис. 5.24) показывает текущее 
состояние свойств  выбранных элементов. Если у некоторых выбранных 
областей есть локальный размер ячейки и нет других, или если размеры 
разные, локальный размер элемента разбиения находится в не определенном 
пространстве. (Тогда это поле считается как пространство неопределенной 
области). Если дело обстоит так, то параметры не обновляются, нажимая OK 
или Apply. Это поле может все еще быть отмечено, чтобы установить 
свойства на всех выбранных элементах. Отметим, что возможно циклическое 
повторение через все три пространства, нажимая на область. Тогда рядом с 
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элементом в дереве деталей будет отображен специальный значок, чтобы 
указать, что были установлены локальные параметры разбиения на ячейки. 

 

 
Рис. 5.25. Диалог параметров локального разбиения на сегменты 

 
Радиусы свободных краев (то есть краев, не формирующих границу по-

верхности), могут быть установлены в диалоге Edge properties (рис. 5.26). 
Отметим, что провода в трехмерном представлении отображаются как линии, 
то есть радиус не представлен. Радиус может, однако, быть отображен для 
сегментов разбиения. Значок в разделе Edge в дереве деталей указывает, что 
был установлен локальный радиус провода. 
 
5.6.1. Импортирование сетки разбиения на ячейки 
 
    CADFEKO может импортировать ряд форматов сетки, для чего можно 
обратиться к команде File → Import → Mesh → .....  
    Для файла *.fek импортируется только только часть, относящаяся к 
геометрии (сегменты проводов, треугольники, многоугольные платы и 
тетраэдры); раздел управления игнорируется. Когда CADFEKO определяет 
границы диэлектрической среды, основанные на метках фаски, она добавляет 
символ подчеркивания и номер, чтобы создать уникальные метки, если файл 
*.fek содержит различные диэлектрические границы с той же самой меткой. 
Кроме того, так как импортированные метки перечислены под новой частью 
сетки, метки в импортированной модели содержат дополнительный уровень. 
Информация среды и радиусы сегмента сохранены.  
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Рис. 5.26. Установка размера локального разбиения ребер 

 
CADFEKO выводит другие форматы сетки, выполняя PREFEKO и 

импортируя получающийся файл *.fek. В настоящее время можно 
импортировать файлы FEMAP neutral file mesh (поверхности, ограниченные 
кривыми линии, чертятся как многоугольные пластины), NASTRAN, 
PATRAN, STL, Meshed AutoCAD DXF (поддерживаются только структуры 
LINE и POLYLINE, сегменты и треугольники), Ansys CBD, ABAQUS и 
специальный формат ASCII. (см. карту IN). 

 

 
Рис. 5.27. Операции импорта сетки разбиения 

 
Для всех форматов файлов, кроме *.fek, CADFEKO открывает 

дополнительный диалог Import mesh. В нем можно установить масштаб и 
управлять выводом элементов. (Например, граничные элементы в файле 
FEMAP могут быть или частью геометрии - то есть это не должно быть 
импортировано - или предназначено как многоугольные пластины - то есть 
это должно быть импортировано). Четырехугольники разделены на треуголь-
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ники во время процесса вывода. Только файлы Ansys CBD - информация о 
радиусе сегмента - для всех других форматов радиус значения по умолчанию 
должен быть определен в диалоговом окне Mesh. Радиус по умолчанию 
также используется для сегментов Ansys. Разные радиусы могут быть 
установлены на сегментах после импорта. 
    CADFEKO импортирует другие форматы сетки, выполняя PREFEKO и им-
портируя получающийся файл *.fek. В настоящее время поддерживается 
FEMAP neutral file mesh (граничные поверхности, ограниченные кривыми ли-
ниями, импортированые как многоугольные плоскости) NASTRAN, 
PATRAN, STL, файл АutoCAD DXF (только элементы LINE и структуры 
LINE, который определяет сегменты, и треугольники), Ansys CBD, файл 
ABAQUS сетки и специальный текстовый формат (см. карту IN).  
    Для всех форматов кроме файла*.fek, CADFEKO открывает 
дополнительный диалог импорта сетки. В нем можно установить 
масштабный множитель и управление импортируемыми элементами. 
(Например, граничные элементы в файле FEMAP могут быть или часть 
геометрии - то есть это не должно быть импортировано - или предназначено 
как многоугольные карты - то есть это должно быть импортировано). 
Четырехугольники разделяются на треугольники во время процесса импорта. 
Только Ansys CBD информация радиуса сегмента основа файла - для всех 
других форматов заданная по умолчанию радиус должен быть определен в 
диалоге импорта. (Заданная по умолчанию радиус также используется для 
сегментов Ansys, где радиус не определен в файле). Различные радиусы 
могут быть установлены на сегментах после импортирования.  
    Наконец, для файла AutoCAD DXF, элементы LINE разделены на сегменты 
согласно величине в поле Segment length. Если элементы LINE не должны 
быть подразделены, это значение должно быть больше, чем самая длинная 
линия.  
    Так как эти форматы не поддерживают определение диэлектрических 
областей, все сегменты, треугольники и многоугольные пластины – являются 
структурами PEC в свободном пространстве, а среда у всех 
четырехгранников считается неизвестной. 
     Также возможно импортировать сетку вручную, создавая файл *.pre в 
EDITFEKO, запуская PREFEKO и затем импортируя файл *.fek в CADFEKO. 
Это дает возможность контроля над процессом импорта, например, чтобы 
только включать некоторые метки.  
 

5.6.2. Проверка и редактирование сетки разбиения 
 
     Команда Mesh → Info из главного меню выводит гистограмму распре-
деления длин границ (а также среднюю длину границ и дисперсию) и числа 
различных элементов в текущем выборе ( рис. 5.28).  
   Выбор может содержать части сети, метки или элементы. Разница фикси-
рует качество сетки и показывает, сколько граней лежит по желательной 
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длине. Числа различных элементов устанавливают размер задачи и требуе-
мое время выполнения.  
 
 

 
Рис. 5.28. Статистическое распределение размеров сетки разбиения 

 
5.6.3. Радиус элемента сетки 
 
    Если выбраны отдельные сегменты или фрагменты сетки, содержащие сег-
менты, то радиусы сегмента могут быть изменены в диалоге Properties. Если 
выбранные объекты имеют различные значения, поле Radius будет первона-
чально незаполнено. В этом состоянии объекты в этом диалоге могут тогда 
быть изменены без изменения радиусов всех выбранных элементов. Если 
значение введено в это поле, радиус всех выбранных объектов будет равным 
этому значению.  
    Сегменты могут быть показаны их фактическим радиусом в трехмерных 
представлениях. Нажмите стрелку "вниз" рядом со значком Show/hide mesh 
на трехмерной инструментальной панели представления, и убедитесь, что 
отмечено «Show segment radii».  
 
5.6.4. Перемаркировка элементов сетки 
 
    Выбранные фрагменты сетки могут быть перемаркированы, если они 
имеют тот же самый тип и принадлежат той же самой части сетки. Так, имея 
метку, Assembly.Part.Label,. невозможно повторно маркировать её элементы 
на различных частях. Заметим, что должны быть выбраны отдельные 
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элементы, а не метки. (Если выполнен выбор части сетки, или метка сетки, 
переключая на выбор элементов, автоматически выбирает все элементы, 
принадлежащие к выбранным фрагментам). Если исходные элементы не 
имели тех же самых установок (среда, использование PO, и т.д.) новая метка 
отмечена как подозрительная.  
     Метки используются для установки свойств конкретного опорного 
элемента. Чтобы определить определенные свойства на элементе или на 
нескольких элементах, эти элементы должны быть повторно помечены. 
Например, рассмотрим простую вибраторную антенну, созданную на плате с 
именем Union1. Результирующая сетка содержит две метки: Face1 для 
треугольников на плате и Wire5 для сегментов на вибраторе. Если, например, 
только нижняя половина вибратора покрыта слоем, эти сегменты должны 
быть повторно помечены перед применением покрытия. (Было бы, однако, 
намного лучше разбить первоначальный провод – с помощью впечатывания 
точки - и применять покрытие к получающейся нижней части ребра.)  
     Когда последний элемент любой метки удален (удаленный или 
переобозначеный), метка удаляется. Таким образом, если выбор, содержащий 
все элементы от больше чем одной метки, переименована, общее количество 
меток уменьшается.  
    Осторожность должна приняться при переразбиении на сетку частей, где 
сетка получила метка. Так как вся сетка заменена новой, метка, созданная  
повторно с маркировкой, теряется. Если в примере выше структура повторно 
разбивается на сетку, будут снова иметься только метки Face1 и Wire5. 
Поэтому, повторная маркировка элементов должна быть отсрочена.  

 
5.6.5. Объединение совпадающих вершин 
 
   Вершины в FEKO считаются связанными, если они находятся в пределах 
малого допуска друг от друга. CADFEKO может объединить вершины в 
пределах указанного пользователем допуска. Чтобы сделать это, выберите 
одну или большее количество частей сетки, и команду объединения 
совпадающих вершин Mesh → Merge coincident vertices из главного меню, 
чтобы открыть диалог слияния совпадающих вершин. Здесь может быть 
определен допуск. Любые две точки, отдаленные меньше чем на это 
расстояние, тогда объединяются , а не принимают среднее положение. 
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Рис. 5.29.  Точность слияния вершин 

 
Если отмечены опции Snap to geometry points  или Snap to 

named points , то вершины сетки, лежащие в пределах заданного допуска 
этих точек, будут слиты. Например, если поименованная точка находится 
между двумя вершинами сетки, которые лежат на расстоянии друг от 
друга, меньше чем заданный допуск, то они будут объединены в этой точке. 
Если операции захвата будут отмечена, вершина, лежащая в пределах допуска 
геометрии, или поименованные точки будут включены в числе объединенной 
вершины, перечисленной в окне сообщения - даже если они первоначально 
совпали точно с точками. 

Слияние точек может привести к вырождению треугольников. CADFEKO 
пытается избежать этого, давая предупреждение, если допуск является 
большим по сравнению с размером ячейки разбиения. Эта операция также 
автоматически удаляет все выродившиеся элементы после слияния вершин. 
 

5.6.6. Слияние элементов (удаление вершин) 
 

   Автоматическое упрощение сетки выполняется через слияние вершин, 
которые могут различаться из-за числовых допусков. Если эти точки остаются в 
дальнейшем обособленными, то нужно обязательно определить, какая точка 
удаляется, а какая точка остается. Это также часто удаляет определенные 
элементы, где расстояние между точками может быть большим по сравнению 
с размером треугольника в другом месте в модели. 

Удаление вершины является двухступенчатым процессом, подобно 
операции  вычитания. Сначала выделите все вершины, которые должны быть 
слиты и нажмите (Del).  На втором шаге выбирается итоговая вершина, когда 
она запрашивается. Все первоначально выбранные вершины тогда 
заменяются конечной вершиной. CADFEKO автоматически удаляет все 
элементы, которые удаляются во время этой операции. 

 

5.7. Удаление дублированных и сокращенные элементы  
 
    Дублированные элементы в пределах части сетки могут быть удалены 
автоматически. Выберите требуемые части сети, и команду Mesh -> Remove 
duplicate elements из главного меню. (Вообще дублирующие элементы поя-
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вляются в импортированных сетках или когда сетки CADFEKO 
редактируются вручную, накладываясь одна на другую.)  
     Если дублированные элементы имеют ту же самую метку, CADFEKO 
удаляет все, кроме одной. Если элементы не имеют той же самой метки, 
может быть лучше удалить конкретный элемент. Это определено в диалоге 
Remove duplicate mesh elements (рис. 5.30). Объекты упорядочиваются, 
нажимая <Ctrl> и щелкая и перемещая числа в левом столбце. Для каждой 
установки дубликатов элемент, метка которого самая высокая в этом списке, 
остается, а все другие удаляются (здесь имеется более, чем два идентичных 
элемента.)  

 
Рис. 5.30. Диалог удаления дублированных элементов, в котором 
пользователь определяет оставшиеся элементы 
 
    Выбирая Mesh → Remove collapsed elements из главного меню, можно 
удалить все вырожденные элементы (элементы, где два или больше узлов 
соприкасаются).  
 

5.7.1. Обнаружение искаженных и элементов с 
завышенными размерами  
 
    Так как точность расчета FEKO зависит от качества сетки, CADFEKO 
включает проверку правильности сети. Выбор Find → Distorted mesh 
elements или Find → Oversized mesh elements из главного меню проверяет 
текущий выбор (части сетки, метки или элементы) для искаженных или с 
элементов с завышенными размерами, соответственно (рис. 5.31). Результат – 
выбор несоответствующих элементов. Командами Undo и Redo можно 
выбирать элементы, которые выбирались до и после испытания.  
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Рис. 5.31. Нахождение опций ошибок геометрии 

Искаженные элементы сетки разбиения определяются в терминах 
минимального внутреннего угла. В идеальной сетке все внутренние углы 
равны 60◦, и если любой из трех углов намного меньше 60◦, то элемент узкий. 
Эти элементы могут быть удалены,  удаляя вершину. Элементы с большими 
размерами находятся на основании максимальной длине края. 
 
5.7.2. Просмотр свободных ребер сетки и узлов сегментов 

 
Другая очень важная проблема - обеспечение соединений. В дополнение к 

проверке геометрии, CADFEKO позволяет найти несвязанные ребра и 
вершин сегментов. Это можно сделать, выбирая Find → Free mesh triangle 
edges или Find → Free segment nodes из главного меню (рис. 5.31). Эти 
операции проверяют только выбранные элементы, и не будут сообщать о 
свободных краях/вершинах, если элемент соединен с другим невыбранным 
элементам. 

Команда Find → Free segment nodes ищет все вершины, которые не 
присоединены к другому сегменту или углу треугольника. Эти вершины 
могут быть верными, например, на концах проводов. Однако если две 
таких точки лежат очень близко друг к другу, они должны быть объединены. 
Края треугольника, считаются свободными, если они не присоединены к 
другим треугольникам. (Край подключен к треугольнику только в том случае, 
если обе конечных точки совпадают с угловыми точками треугольника). Здесь 
выбираются эти две вершины на концах края. Эти вершины могут тогда 
быть объединены, перемещены или изменены, чтобы сделать модель 
непротиворечивой. Снова, свободные ребра могут быть идеально 
нормальными, такими как на ребре конечной границы. 
 

5.7.3. Редактирование вершин сетки 
 
Вершина сетки может быть изменена,  выбирая команду (вершина сети 

должна быть видимой) Edit → Properties из главного меню (или Properties из 
всплывающего меню). Это открывает диалоговое окно Modify vertex, которое 
содержит координаты вершины (в глобальной системе координат). Ввод точки  и 
выражения изменяет эти значения, как только закрывается диалог. Точка может 
быть сдвинута на  заданное расстояние ,  добавляя необходимый сдвиг. 
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Например, изменение X от 1.2 до 1.2+0.5 перемещает точку на 0.5 единиц в 
направлении X. 
 

5.7.4. Создание треугольников сетки разбиения 
 
     Иногда требуется ручная установка сетки. Это может быть потому, что 
сетка содержит ряд дырок или потому что некоторые плохие элементы были 
выбраны и удалены. В отличие от удаления вершины, удаление элементов 
оставляет отверстия на поверхности сетки.  

К этой вершине треугольники могут быть добавлены вручную, выбирая 
Mesh → Create new triangle из главного меню. Эта операция позволяется, если 
выбор содержит единственную метку сетки (когда новый элемент добавлен к 
этой метке), или единственная часть сети (когда новый элемент добавлен к 
новой метке, созданной под этой частью). Диалоговое окно Create mesh 
triangle позволяет определять три угла треугольника. Так как эти три поля – 
стандартные поля ввода, то все доступны различные операции захвата 
(рис.5.32). 

 
Рис. 5.32. Диалог создания треугольника сетки 

 
Новые созданные треугольники могут быть "перемещены" в 

существующую метку. Выделите все элементы существующей метки так же 
как все новые элементы. (Если элементы выбраны меткой, нажмите кнопку 
Select mesh element, чтобы преобразовать выбор в индивидуальные элементы). 
Теперь выбираем элемент нажатием правой кнопкой мыши и выбираем 
Rename. Это объединит все выбранные элементы в одну метку, которая 
может тогда быть переименована. Если все элементы метки переименованы, 
эта метка удаляется - имя метки может тогда использоваться для вновь 
созданной метки. 
5.7.5. Реверсирование нормалей 
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    Некоторые свойства в FEKO используют нормальные векторы элементов. 
Например, диэлектрики определяются, задавая среду на каждой стороне гра-
ничащих треугольников. Для этой цели, нормальная сторона треугольника 
или полигона определена как сторона, на которую указывает вектор нормали. 
(Если начальная точка вектора нормали  расположена на треугольнике, 
нормальная сторона - ближайшая к стрелке - указателю). 
    В CADFEKO передние стороны элементов сетки окрашены синим цветом, 
а задние части окрашиваются коричневым цветом.  

 
Рис.5.33. нормаль и задние стороны треугольника 

 
Когда выбор содержит треугольники или многоугольные пластины (или 

метки или части, которые содержат эти элементы), выбирая Mesh → Reverse 
normals, инвертируются нормали всех выбранных треугольников и 
многоугольников. Вектор нормали может быть показан, активизируя Show / 
hide normals на инструментальной панели трехмерного представления. 

Реверсирование нормалей треугольников на диэлектрических границах 
может неблагоприятно повлиять на последовательность модели. CADFEKO 
пытается сохранить модель непротиворечивой. Например, если нормали всех 
треугольников в данной метке полностью изменены, CADFEKO меняет 
диэлектрические носители на этих двух сторонах. Однако, если только 
некоторые треугольники изменены, нельзя гарантировать последовательность и 
то, что модель является непротиворечива. 
 

5.7.6. Уплотнение сетки  
 

    В некоторых случаях геометрия модели доступна только в виде сетки. 
Если такая сетка была создана для показа свойств, то она может содержать 
большой набор размеров элементов, или она может содержать треугольники с 
очень большими коэффициентами пропорциональности. Даже если сетка 
была создана для создания фрагмента кода программы , то она может 
быть создана для разных частоты. Одно решение состоит в том, чтобы 
подразделить элементы сетки, но это может привести к большому количеству 
элементов, требования памяти  и времени выполнения.  
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Рис. 5.34. Иллюстрация грубой сети. Исходная (слева) сетка содержит 

две среды, показанные разным цветом. В грубой сетке (справа) остается  
граница между средами, но размер сетки вдоль границы огрубляется. 
Искусственная граница, отделяющая элементы с той же самой меткой, не 
поддержана. 
 

Выберите Mesh → Re ne / coarsen mesh, чтобы повторно выполнить разби-
ение на сетку треугольников или тетраэдров, не используя основную 
геометрию.  Поле Size  определяет желательную среднюю длину края, которая 
может быть меньшей или большей чем текущий размер сетки разбиения. 
Начальное значение Size показывает текущий средний размер сетки. Эта 
операция может только быть сделана на метках сети или частях. 

Заметим, что сегменты не разбиваются более плотно. Относительно просто 
поместить согласованный сплайн через необходимые вершины сетки и сетка 
в результате искривляется . 

Свойство уплотнения или огрубления относится к конкретной метке, то 
есть это гарантирует, что соединения обеспечиваются в основном правильно, 
но это не будет создавать новые элементы между границами метки. 
Маленькие области могут, однако, быть удалены, выбирая эти элементы этих и 
соседних областей и повторно маркируя их к единственной метке (рис.  
5.34). 
 

5.8. Преобразование геометрии 
 

Объекты геометрии или части сетки могут быть преобразованы командой 
Edit→ Transform из главного меню, или кнопкой на инструментальной панели 
Modify geometry. Преобразование входит в дерево, и находится в списке (в 
порядке создания) всех операций. Они могут быть отредактированы (двойным 
нажатием на определенные операции) или удалены (нажимая клавишу 
<Del>).   

 Преобразование может быть применено к выбранным нескольким объек-
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там, и оно будет добавлено отдельно к каждому объекту. Поэтому, изменение 
их впоследствии требует выбора и редактирования преобразования каждого 
объекта отдельно. Преобразование может, конечно, быть определено в 
терминах переменных. В этом случае, изменение переменной изменит все 
элементы. 

Операция Rotate требует задания оси вращения (которая определяется 
началом координат и направлением оси в глобальных координатах), и углом 
вращения (в градусах). Угол измеряется по часовой стрелке вокруг оси. 
Диалоговое окно, которое показано на рис. 5.35, также имеет кнопки, чтобы 
установить ось вращения в основные точки глобальной и локальной системе 
координат.  

В диалоговое окно Translate, (рис. 5.36), вводятся  начальная и конечная 
точки, по которым вычисляется расстояние преобразования и направление. 

Преобразование Scale (Масштаб) требует начала координат (в 
глобальных координатах) и масштабный коэффициент, как показано на рис. 
4-17. Масштабирование выполняется вокруг начала координат определенного в 
диалоговом окне масштабирования, не вокруг центра или начала координат 
объекта или модели. 

 
Рис. 5.35. Диалог вращения объектов 

 
    В диалоге Translate, (рис. 5.35) вводится начальная и конечная точки, от 
которых они рассчитывают расстояние преобразования и направление.  
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Рис. 5.36. Диалог смещения геометрии 

 
     Операция зеркального отражения требует задания плоскости. Она опре-
деляется в диалоге, показанном на рис. 5.36 и подобно заданию рабочей 
плоскости. В диалоге есть кнопки, чтобы выбрать её из числа глобальных 
плоскостей.  

 
Рис. 5.37. Диалог зеркального отражения 
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    Преобразование масштаба требует ввода начала координат (в глобальных 
координатах) и масштабный множитель как показано на рис. 5.37. 
Масштабирование выполняется вокруг начала координат, указанного в 
диалоге масштабирования, а не вокруг центра или начала координат объекта 
или модели.  

 
Рис. 5.38. Диалог масштабирования 

 
 

5.8.1. Многократные копии 
 
     Части могут быть скопированы и трансформированы несколько раз одной 
командой Copy special из всплывающего меню или Edit → Copy special из 
главного меню. Диалог трансформации содержит поле number of copies. Это 
будет число копий каждой выбранной части.  

    При операции вращения n-я новая часть будет вращаться (с 
единственным преобразованием) n  раз с определенным углом вращения.  
При сдвиге n –я  новая часть будет смещена n раз на заданное расстояние. Для 
операции зеркального отражения разрешается только одна копия. (Вторая 
копия вернулась бы к оригиналу и может быть сделана обычной опцией Copy). 
 
5.8.2. Преобразование частей сетки 
 

Части сетки могут быть преобразованы так же, как и части геометрии. 
Преобразование относится ко всей части и может быть отредактировано или 
удалено. Если изменить вершину сетки, то отображаются 
преобразованные координаты, и данные ввода, как предполагается, находятся 
в преобразованном пространстве. Если преобразование является измененным, 
то это также применено к отредактированной вершине. 
 

5.8.3. Ансамбли (сборки) 
 
Сборки используются для организации геометрии. Они становятся частью 

геометрической структуры и показываются в первом уровне  раздела Geometry в 
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дереве. Чтобы создать новую сборку, выберите необходимые составляющие, 
сделайте правый щелчок в дереве или пространстве чертежа  и выберите 
Assembly → Create. Только части (отображенные объекты) могут быть 
добавлены к сборке . (Части сетки и части геометрии не могут быть 
добавлены к той же самой сборке). Части перемещаются между сборками, 
выбирая Assembly → Move to → ... из всплывающего меню. А команда Assembly 
→ Move out  возвращает обратно выбранные части на исходный уровень. 
Элемент не может быть в двух сборках одновременно. 

Удаление сборки  удаляет саму сборку и его составляющие из модели. 
Точно так же выбор элемента в сборке и нажатие Del удалит элемент из 
модели. (Assembly → Move out). Команда Disassemble  перемещает его 
компоненты назад в корневой уровень и удаляет сборку.  

Булевы операции, преобразование, разбиение, и т.д. применяются к 
отдельным  элементам. Если мульти-родительские операции применены к 
элементам в одной сборке, результат находится также в том проекте. Если 
такие операции применяются к компонентам больше чем одного проекта, 
результат помещается на корневом уровне. Имена сборки становятся частью 
полной метки / имени, например, Assembly1. Union4. Face12. Отметим, что 
имена даются в CADFEKO без учета регистра, то есть Face1 и face1 - то же 
самое. 

5.9. Использование диэлектрических и сред с 
потерями 

 
     Перед использованием в модели, должны быть описаны материалы. 
Диэлектрические материалы в модели задаются установкой диэлектрической 
среды в геометрических областях. 
      Потери в проводниках учитываются тем, что проводящие поверхности 
создаются как металлические среды. Покрытия и тонкие диэлектрические 
листы задаются на поверхностях, используя определяемый слоистый 
диэлектрик из отдельных диэлектрических слоев. В некоторых случаях 
свойства материала описываются как поверхностный импеданс на квадрат. 
    Все используемые диэлектрики перечисляются в разделе Media (рис. 5.39). 
Каждый тип перечисляется отдельно, но названия сред должны быть 
уникальны и содержать не больше 43 букв.  
   Цветной значок рядом с каждой средой указывает, какой цвет используется 
в индикации этой среды на трехмерном дисплее и в дереве подробностей. 
Они могут быть изменены командой Change из всплывающего меню (цвета 
сохраняются в файле *. cfs.). Первые три значка – идеальный проводник, 
идеальная магнитная стенка (в настоящее время только используемая, когда 
установлена магнитная стенка земляной платы) и свободное пространство 
Free space, которые нельзя удалить.  
     Хотя тонкий импедансный лист, строго говоря, не среда, параметры 
Impedance sheets (рис. 5.39), также могут быть введены в раздел Media, 
подобно другим средам. 
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Рис. 5.39.  Создание среды GRAFIT с тонким диэлектрическим листом 

 
     Диэлектрические среды могут быть переименованы или изменены в 
дереве или в диалогах Properties. Эти изменения будут тогда относиться ко 
всем частям, в которых используется этот диэлектрик. Среды могут быть 
удалены, если они не используются в проекте.  
 

5.9.1.Диэлектрическая среда 
 
     Любая область может быть заполнена диэлектриком. Диэлектрики 
создают-ся, используя раздел Media в дереве проекта, или выбирая команду 
Model → Add medium → Dielectric из главного меню.  

 
Рис. 5.40. Создание диэлектрического материла 

 
   В качестве параметров диэлектрической среды задаются относительная 
диэлектрическая проницаемость, относительная магнитная проницаемость, 
коэффициент магнитных потерь, тангенс диэлектрических потерей или 
проводимость.  
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    Тангенс диэлектрических потерь и проводимость определяют потери в 
диэлектрике, но имеют различные частотные зависимости. Выбор зависит от 
задачи. Например, небольшие потери в подложках обычно определены в 
терминах коэффициента потерь, в то время как потери в биологической 
ткани (при расчете уровня поглощения мощности) определены в терминах 
проводимости.  
    Плотность массы Mass density используется только для расчета уровня 
удельного поглощения (SAR), но это значение должно быть определено и 
должно быть больше 0.  
 

5.9.2. Металлическая среда 
  
    Потери (из-за скин-эффекта) определяются установкой фаски как металла 
с потерями. Но они не могут быть выполнены для фасок, ограничивающих 
области идеальной электрической проводимости.  
   Металлические среды создаются, нажимая на Media правой кнопкой мыши 
и выбирая Create metallic medium, или выбирая команду Model → Add 
medium → Metallic из главного меню. Отметим, что невозможно установить 
твердый объект как металлическую среду. Это можно выполнить заданием 
внутренней области как свободное пространство и установке толстой 
металлической среды на поверхности. «Толстая» здесь подразумевает, что 
поверхность намного более толстая, чем глубина поверхностного слоя.  
 

 
Рис. 5.41. Диалог создания металлической среды 

     
     Металлические среды определены в терминах проводимости 
Conductivity, относительной магнитной проницаемости Relative 
permeability и коэффициента магнитных потерь Magnetic loss.  
    В этом описании определение проводящей среды относится и к металлам, 
и к идеальному электрическому проводнику. 
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5.9.3. Слоистые диэлектрики 
 
    Поверхности между областями свободного пространства могут быть 
заданы как тонкие диэлектрические листы или как провода, покрытые 
диэлектриком.  

 
Рис. 5.42. Диалог создания слоистого диэлектрика из двух слоев Layer1 и  

Layer2 
 
    Это выполняется с помощью слоистых диэлектрических сред, которые 
состоят из произвольного числа диэлектрических слоев указанной толщины. 
Заметим, что диэлектрические среды, составляющие различные слои, 
должны быть определены прежде, чем может быть определен слоистый 
диэлектрик.  
     Диалог создания слоистого диэлектрика Create layered dielectric 
содержит таблицу с толщиной и материалом каждого слоя. В этом списке 
Medium могут быть только диэлектрические среды. Кнопкой Add 
добавляется новый слой (рис. 5.42), а кнопкой Remove слой удаляется. Таким 
образом, можно вставить новые слои между любыми двумя слоями.   
     Покрытия и тонкие слои диэлектрического материала должны быть 
геометрически или электрически тонкие в зависимости от выбранного 
решения. CADFEKO даст предупреждения, если толщина приближается к 
пределу и об ошибке, если предел толщины превышен.  
 

5.9.4. Импедансные слои 
 
    Структура поверхностного импеданса определяется как поверхностный 
импеданс на поверхностях между областями свободного пространства. И 
определяется он реальными и мнимыми частями поверхностного импеданса. 
Теоретически, те же самые результаты могут быть получены установкой 
соответствующего свойства металла на этой поверхности, но в тех случаях, 
когда только известен поверхностный импеданс.  
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5.9.5. Установка свойств материалов 
 
    По умолчанию все объекты – идеальные электрические проводники. Чтобы 
изменить это, обычно свойства устанавливаются на областях, фасках или гра-
нях / проводах. Области - полностью замкнутые объемы, которые перечис-
лены в дереве проекта. Они могут быть выбраны из дерева подробностей 
проекта. Некоторые импортированные модели используют поверхностные 
части, чтобы определить границы твердых областей. Эти модели не имеют 
никаких областей, и не возможно определить твердый диэлектрик. Однако, 
если поверхности объединены операцией Union, чтобы создать замкнутые 
поверхности, CADFEKO автоматически создает соответствующие области 
для новых частей.  
     Фаски – отдельные поверхности объекта и также перечислены в дереве 
подробностей. Они могут быть выбраны или в дереве подробностей или 
трехмерного представления, когда активен выбор фаски. 
     Термин "фаска" используется, чтобы отличить её от "поверхности", 
которая в CADFEKO является двумерной геометрической поверхностью 
типа полигона. Грани, которые перечисляются в дереве подробностей 
включают грани фасок, а также свободные кривые (называемые как и 
провода, "wire").  

 
Рис. 5.43. Фаски и провода в дереве подробностей проекта 

      
    Где это возможно, характеристики среды сохраняются во время 
геометрических преобразований. Например, если фаска разбивается на две 
фаски операцией вычитания, обе получающиеся фаски наследуют 
характеристики исходной; или, если две накладывающихся поверхности 
пересечены, получающаяся поверхность будет иметь свойства, одинаковые 
для обоих поверхностей. Если не возможно объединить свойства нового 
объекта с исходным, то объекты отмечаются как сомнительные.  
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5.9.6. Свойства трехмерных областей region 
  

     Чтобы установить свойства диэлектрика или свободной области, выберите 
одну или большее количество областей и команду Properties из выплываю-
щего меню. Это открывает диалог Region properties, показанный на рис. 
5.44. 

 
Рис. 5.44.  Диалог свойств региона 

 
     Поле Type используется для определения типа среды - для области, это 
может быть идеальный электрический проводник, свободное пространство 
или диэлектрик. Установка к свободному пространству Free space создает 
свободные окна, а установка на Perfect electric conductor -электрические 
проводники – твердые объекты. Разница главным образом очевидна во время 
создания геометрии. Можно, например, удалить фаски, когда они граничат со 
свободным пространством, но нельзя, когда они граничат с диэлектриком и 
идеальным проводником. Некоторые свойства устанавливаются только на 
тех фасках, которые граничат с областью свободного пространства.  
     Тип диэлектрической среды доступен только тогда, когда список Media 
содержит диэлектрические среды. Диэлектрик может быть определен, когда 
открывается диалог свойств области - тип диэлектрической среды тогда ста-
новится немедленно доступным (рис. 5.45). Если тип диэлектрический, 
соответствующая среда должна быть выбрана в списке Name. В отличие от 
имен метки, которые должны быть уникальны, одно название среды может 
использоваться для нескольких областей. В случае пересечений, если 
возникают конфликты, материалы областей будут отмечены под вопросом.  
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Рис. 5.45. Диалог Region properties с установкой размера сетки 

 
     Первоначально диалог показывает текущее состояние свойства 
выбранного элемента. Если выбрано несколько областей, поля, которые – не 
те же самые для всех диалогов, оставляются необработанной подложкой. Эта 
характеристика не  изменяется, когда изменения приходят в силу. Это 
позволяет, например, выполнить модификацию размера ячейки разбиения 
для ряда различных диэлектриков одновременно.  
 
 

5.9.7. Свойства фасок 
 
      Диалог Face properties имеет две закладки: Properties and Solution (рис. 
5.47). Параметры фаски, находящейся  в среде, устанавливаются в закладке 
Properties. 
 

       
Рис. 5.46. Диалог свойств фаски с двумя закладками 
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    Опции для поля Face type в группе Face medium зависят от областей с 
двух сторон фаски. Если с обеих сторон свободное пространство, то 
параметры могут быть: Perfect electric conductor, Lossy conducting surface, 
Impedance sheet, Thin dielectric sheet и Default (по умолчанию). Некоторые 
параметры доступны только после того, как были определены 
соответствующие материалы.  
     В данном конкретном случае опция по умолчанию Default – такая же, как  
Perfect electric conductor. Если выбрана опция Lossy conducting surface, то 
должны быть определены металлическая среда и толщина. Заметим, что 
невозможно установить среду Metallic в областях, но это может быть 
эффективно достигнуто установкой фаски на границе к области с 
поверхностными потерями слоев, более толстых, чем глубина 
поверхностного слоя.  


 2

skin  
. 
    Импедансный слой Impedance sheet - бесконечно тонкая проводящая 
поверхность с указанным поверхностным импедансом (отношение между 
тангенциальным электрическим полем на поверхности и электрическом 
поверхностном тока). Если выбрана опция Thin dielectric sheet, поле Medium 
перечисляет все слои Layered dielectric. Это - плоские многослойные 
диэлектрические структуры типа автомобильного окна1. 
 
    Если фаска формирует границу между двумя диэлектрическими областями 
или между диэлектрической областью и свободным пространством, 
параметры для Face type заданы по умолчанию, Dielectric boundary, Lossy 
conducting surface и Perfect electric conductor. Если выбрана Dielectric 
boundary, фаска представляет границу между двумя различными 
диэлектрическими областями. Опции Lossy conducting surface и Perfect 
electric conductor используются для определения границы проводимости на 
диэлектрической области. Например, при моделировании планарной антенны 
на подложке конечного размера, стороны и большинство пространства 
сверху должны быть установлены как Dielectric boundary, в то время как 
плата и земляная плата должны быть проводящими поверхностями. Здесь 
Default становится Dielectric boundary. 
   Если же все граничащие области - идеальный проводник, единственные 
доступные параметры Face type заданы как Default и Perfect electric 
conductor. Здесь Default становится Perfect electric conductor. 
    Выбор Face type сохраняется, когда граничащая область изменяется. Это 
может приводить к недопустимым параметрам настройки. Например, если на 
фаске, граничащей со свободным пространством, установлена опция Lossy 
conducting surface, эта установка становится неверной, если область 
                                                        
1 Такой расчет выполняется согласно карте SK с сообщениями ошибок, при задании параметров Impedance 
sheet и Thin dielectric sheet. 
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границы переходит в Perfect electric conductor. Эти установки обычно 
отображаются в с вопросительными знаками (даже если все выбранные 
фаски имеют ту же самую установку). Таким образом, область может 
переходить в неизвестную область без изменения настройки фаски. Фаска 
будет отмечена как подозрительная во время этого процесса и должна быть 
переустановлена вручную.  
    Установка Default также остается, когда граничащая область изменена. 
Это ведет себя по-разному для различных случаев, предусматривая наиболее 
соответствующих опции для каждой комбинации областей. Например, если 
область идеально проводящая, её границы могут только идеально 
проводящие. Если они явно установлены как Perfect electric conductor, фаски 
останутся идеально проводящие, если область граничит с диэлектриком. В 
большинстве случаев это не соответствует структуре. 
  Так, если диэлектрик с замкнутой границей с идеальной проводимостью 
будет вести себя так же, как и  идеально проводящее тело - если источники и 
точки поля не вся внутренняя часть тела - но это приведет к более 
длительному времени решения.  
    Однако, если фаски на идеально проводящей области установлены как 
Default, они станут диэлектрическими границами, когда область переходит в 
диэлектрик. Заметим, что это означает, что если двумерная поверхность 
(которая по умолчанию идеально проводящая) – объединена операцией 
Union с диэлектрическим телом, то результатом будет диэлектрическая 
граница. 
    Покрытия прикладываются с обеих сторон фаски. Следовательно, эта оп-
ция доступна только в том случае, когда фаска имеет свободное пространство 
с обеих сторон. Покрытие Coating name выбрано из списка Layered media. 
Покрытие прикладывается так, что слой 1 находится на внешней стороне, как 
показано на рис. 5.48. 

 
Рис.  5.48. Покрытия, приложенные к обоим сторонам проводящей 

поверхности 
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5.9.8. Установка свойств элемента разбиения на сетку 
 

     В идеале свойства объектов должны быть установлены на геометрии, до 
преобразования геометрии в сетку ячеек. Любые изменения геометрия (или 
свойств геометрии), сделанные после объединения, не будут отражена в 
сетке разбиения. Только параметры сред могут быть изменены после 
объединения, и это будет учтено в расчете.  
    Например, если область получена объединением и затем материал изменя-
ется от Teflon к FR4, объединенные области будет все еще использовать 
среду Teflon. Однако, если среда Teflon переименована к Teflon_new после 
объединения, объединенные области приобретут материал Teflon_new.  
     Однако можно установить реквизит на сетке разбиения. Выберите требуе-
мые элементы сетки и далее команду Edit → Properties.  
      Для  тетраэдрального разбиения может быть определена только среда. 
Среда определяется на каждой стороне. Среда Face и свойства покрытия 
Coating может быть установлена на фаски, но здесь две окружающих среды 
определены в том же самом диалоге, а не в  отдельном диалоге Region. Если 
среда изменена таким способом, что среда фаски или установка покрытия 
становится недопустимой, то установка немедленно становится под 
вопросом и должна быть модифицирована снова. (Определение сред на 
элементах сетки требуется только для импортированных сеток разбиения). 
Для сегмента, отмаркированного как окружающая среда, в диалоге может 
быть установлен реквизит сетки. Среда внутреннего сегмента и покрытие 
могут быть определены, как и их грани.  
    Нужно отметить, что установки по разбиению на сетку не изменяют 
никакие установки геометрии. Если модель повторно  разбита на ячейки, 
такие установки теряются (если сетка разбиения не было переименована 
сначала, когда будет иметься большое количество дублированных 
элементов). Следовательно, не рекомендуется устанавливать свойства сетки, 
когда это можно сделать на геометрии.  
 

5.9.9. Свойства ребер 
 
   В диалоге Edge properties (рис. 5.51), можно установить локальный радиус 
провода (что отменяет установку по умолчанию в диалоге Create mesh), и 
среды, в которой находится провод и применить покрытие. Эти параметры 
доступны только в том случае, если край - провод, то есть не граница фаски.     
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Рис. 5.51. Диалог свойств ребер Edge properties 

 
    Потери в проводах учитываются установкой типа провода Wire type как 
Lossy и выбору среды Metallic. Для покрытий выбирается Coating name из 
списка сред Layered dielectric, но в настоящее время к проводам можно 
применить только однослойные покрытия. 
 

5.9.10. Показ диэлектрической среды, покрытия  
и тонких слоев 
 
     Кликните указателем курсора на иконку  Show / hide geometry objects или 
на иконку  Show / hide mesh icon и выберите Colour by medium чтобы 
увидеть диэлектрические области в цвете. Стороны каждой внутренней 
поверхности окрашиваются как диэлектрические области на каждой стороне. 
Для геометрии цвет области используется на всех внешних границах, но для 
сеток разбиения, снаружи поверхностей отображены в виде цвета среды на 
той стороне, которая должна быть свободным пространством.  
    Параметры фаски и покрытия показываются с иконкой в дереве. Фаски на 
диэлектрических областях показываются с иконкой в дереве.  
  Сегменты разбиения на ячейки могут быть показаны с их реальным 
радиусом в трехмерном виде. Этот радиус может включать радиус оплетки.  
 
 

6. Подготовка к решению и запуск FEKO на счет  
 

  После создания геометрии необходимо задать порты, источники 
возбуждения, частоты, выбрать метод решения и подготовить все данные для 
запуска на расчет. Метод решения выбирается в диалоге Solution Setting, 
который вызывается командой  Solution в дереве проекта. Появляется диалог 
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рис. 6.1. В закладке General устанавливается точность хранения данных: 
либо одиночная, либо двойная точность. 
 

 
Рис. 6.1. Закладка General выбора решений 

 
     Одиночная точность (Single precision) рекомендуется, если FEKO не дает 
предупреждения, чтобы переключиться на двойную точность (это может слу-
читься на низких частотах, где требуется большая точность).  
      Если выбрана опция Store / re-use solution, FEKO хранит и 
переиспользует решение линейных уравнений. Этот режим используются, 
чтобы считать ближние поля, поля в дальней зоне, и другие характеристики, 
без повторного вычисления корней системы уравнений. Для малых моделей 
(когда время выполнения небольшое) это обычно не требуется. Для больших 
моделей, это может существенно экономить время, но создает большой файл 
*.str. 
     В закладке MLFMM устанавливается многоуровневый быстрый 
многополевой метод (MLFMM) и требуемые опции (рис. 6.2).  
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Рис. 6.2. Установка опций быстрого многоуровневого метода 

     
     Метод MLFMM может решить большую задачу быстрее, чем метод 
моментов (MoM). В настоящее время MLFMM не может использоваться 
одновременно с FEM. MLFMM основан на иерархическом алгоритме 
группировки, и FEKO сам устанавливает оптимальное число групп и боксов 
для каждой модели. Если модель не сходится, можно изменять размер бокса 
(рис. 6.2) в длинах волн (Box size in wavelengths). Рекомендуется начальное 
значение установить равным 0.23.  
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Рис. 6.3. Закладка метода конечных элементов FEM 

.     
    В разделе Advanced solver settings устанавливается число итераций или 
критерий остановки итеративного процесса. В режиме MLFMM можно 
также выбрать решение смешанного интегрального уравнения поля и 
параметры установки решения на фасках.  
      В закладке FEM (рис. 6.3) выполняются установки, относящиеся к методу 
конечных элементов. FEM используется, если модель содержит 
тетраэдральные элементы разбиения на сетку. Если выбран режим Decouple 
FEM and MoM solution, решение FEM (тетраэдральные элементы и любые 
проводящие поверхности на их границах) выполняется независимо от метода 
MoM. Эта развязка может существенно уменьшить время расчета, что 
справедливо, если две области достаточно далеки друг от друга. 
Переключение на режим первого порядка элементов (First order) уменьшает 
требуемое ЗУ и время выполнения, но ухудшает точность. Чтобы получить 
ту же самую точность, размер ячейки должен быть уменьшен, и в этом 
случае требуется больше ЗУ и время расчета. Таким образом, переключение 
на элементы первого порядка рекомендуется только в том случае, если 
разбиение на сетку - очень грубое, например чтобы реализовать очень 
неоднородные среды.  
      Можно выбрать метод Direct sparse или итерационное решающее 
устройство Iterative solver. Для итерационного решающего устройства можно 
установить критерий сходимости. Коэффициент стабилизации применяет 
только к неполному (Multilevel ILU / diagonal decomposition) предва-
рительному условию и может улучшиться сходимость в критических 
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случаях. Значение должно быть между 0 и 1. Заметим, что любое поле в этой 
закладке может быть оставлено пустым.  
          Закладка High frequency (рис. 6.4) содержит разделы для установки 
параметров PO (физическая оптика) и параметров метода UTD (однородная 
теория дифракции). Решение PO устанавливается для каждой поверхности, и 
UTD может применяться ко всем многоугольным платам.  
   Если отмечены Decouple PO and MoM solutions или Decouple UTD and 
MoM, то структуры PO / UTD не принимаются во внимание при вычислении 
токов в MoM. Тогда, например, входное сопротивление рупорной антенны, 
излучение из которого падает на параболической отражатель, будет то же 
самое, как такого же  рупора в свободном пространстве. Однако, если 
требуется только ДН, с учетом развязки, то при таком решении существенно 
уменьшается объем памяти и время выполнения без влияния на результаты.  
     При решении задачи методом физической оптики PO большинство 
времени тратится на определение, какие поверхности освещаются из каждого 
источника.  
      Если отмечена опция Export ray file for post-processing, FEKO 
записывает  лучи в файл *.ray так, чтобы они просматривались в POSTFEKO. 
Нужно отме-тить, что этот файл может быть очень большой, особенно, если 
решения MoM и UTD не были разъединены и имеется больше, чем несколько 
сотен элементов разбиения в области MoM.  
 

 
Рис. 6.4. Закладка методов СВЧ 
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     Параметр Max.no.ray ограничивает число отраженных лучей. Например, 
луч, который включает двойную дифракцию и одно отражение, имеет три 
взаимодействия, а луч, который включает дифракцию, и три отражения,  
имеют четыре взаимодействия.  
     Опции в группе вкладов лучей Select ray contributions устанавливают, 
какие взаимодействия нужно принять во внимание. Выбор большего 
количества вкладов или при увеличении числа взаимодействий луча 
увеличивает и точность и время вычисления.   
     Окончательные установки должны быть компромиссом между точностью 
и временем расчета. Они должны быть основаны на физических 
соображениях. Заметим, что некоторые комбинации дублируются. Например, 
вклад дифракции от ребра и от угла имеют обычно тот же самый порядок, и 
они должны быть включены или отключены одновременно.  
 
6.1.Создание портов, источников и нагрузок в FEKO 

 
  Источники напряжения и дискретные нагрузки прикладываются к портам, 
которые должны быть определены перед созданием источника или нагрузки.  
    Порты перечисляются в разделе Ports в дереве проекта. Каждый порт 
содержит подэлементы, или модели, указывая геометрию и сетку разбиения, 
с которыми он связан. Порты устанавливаются на геометрии, например, в 
линии. Другая характеристика порта, это разбиение на сетку, автоматически 
создается, когда мешируется вся структура. Тогда раздел Port в дереве 
проекта будет содержать образы геометрической модели и всех элементов 
разбиения порта. 
    Порты могут также быть созданы на сетке. Эта опция доступна из меню 
Mesh → Create port и выполняется только для импортированной сетки 
разбиения. Если порт создан на сетке разбиения, он будет только содержать 
модель разбиения на сетку.  
    Если порт содержит геометрическую модель, то, выбирая Properties из 
всплывающего меню портового элемента, можно открыть описание  
геометрии. Если порт содержит только раздел разбиения на сетку, это 
открывает свойства этого разбиения. Преобразование порта состоит в том, 
что если положительное напряжение приложено к порту, электрический ток 
течет через порт от отрицательной клеммы к положительной клемме.  
    Как геометрия, так и сетка их разбиения не могут быть удалены, пока порт 
связан с ними. Однако иногда удается удалить элементы, на которых 
установлены порты. Порты тогда отмечаются как подозрительные и должны 
быть переустановлены, чтобы снять эту установку. Геометрия и сетка, 
связанные с портом, должны быть удалены раздельно. После этого удаляется 
сам порт. Если порт установлен на сетке или геометрия удалена после 
объединения, тот порт содержит только разбиение на сетку. Любая часть 
сетки разбиения, к которой такой порт обращается, не может быть повторно 
объединена, если порт не удален полностью.  
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6.1.1.Проводные порты 
 
   Проводные порты создаются на ребрах и проводах, т.е. ребра не 
формируют граничную плоскость. Выберите команду Geometry → Create 
port → Wire port из главного меню, чтобы открыть диалог Create wire port 
(geometry) показанный на рис. 6.5.  

 
Рис. 6.5. Диалог создания проводного порта на геометрии 

 
    В поле Edge устанавливается провод, на котором будет создаваться порт. 
Он может быть вставлен, выбирая его в трехмерном представлении или в 
дереве проекта. Диалог порта может быть открыт также нажатием правой 
кнопки на краю провода в дереве проекта и выбирая Create port → Wire 
port из всплывающего меню в дереве подробностей. Тогда выбранное ребро 
автоматически вводится в поле Edge.  
    Когда провод разбит на ячейки, порт может быть помещен в один сегмент 
или на вершине между двумя сегментами. Порт на вершине главным образом 
используется, когда провода соединены с другими структурами, и разность 
фаз от конечной точки до центра первого сегмента может значительно 
изменить входное сопротивление.  
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Рис. 6.6. Создание линии и задание на неё порта источника и порта нагрузки 

 
       В разделе Location (рис. 6.5) задается, в каком месте на проводе будет 
находиться порт. Если точки Segment points определены в начальной точке, 
используется сегмент Start , в середине Middle, и End в конце. Когда 
выбрана опция Other, пользователь должен задать положение по проводу. 
Поле % определяет положение, в процентах от длины провода от 0 % в 
начальной точке, до 100 % в конечной точке. Если провод изменяется 
впоследствии так, что имеется все еще только один провод с этим 
обозначением, порт будет в том же самом положении по проводу. Таким 
образом, если порт был на расстоянии трети от конца провода, и провод 
закорочен, чтобы работать на различных частотах, порт находится на 1/3 от 
более короткого провода. Если не имеется никаких проводов с меткой слева, 
или если провод разделен на кратные части, порт отмечается как 
подозрительный. В этом случае нужно отредактировать его и выбрать 
соответствующее ребро. Позиция может быть установлена сразу, вводя 
поименованную точку или выражение «pt» в поле %. Тогда порт 
располагается в этой точке провода. Если провод изменяется впоследствии, 
точка останется насколько возможно близко и к этому положению. В этом 
случае, если провод – разбитый на кратное число, обрамляет порт, будет 
зафиксирован на ребре, где его положение самое близкое к этой точке. Если 
провод исчезает, порт становится подозрительным. Этот стандарт ввод 
точки, и текущее положение порта обозначены малым шариком в 
трехмерном представлении.  
     Проводные порты могут быть установлены непосредственно на сетке 
разбиения, выбирая Mesh → Create port из главного меню.  
   Диалог создания проводного порта (mesh) на сетке также содержит Locate 
port on group, который имеет поле Segment / Vertex. Если это поле активно, 
можно выбрать сегмент или вершину в трехмерном представлении. Поле 
segment / vertex тогда показывает обозначение сегмента, в то время как 
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начало и координаты конечной точки сегмента или координат вершины 
отображены только в полях для чтения.  
 

 
Рис. 6.7. Порт между ребрами металлической структуры 

 
     В трехмерном представлении положительная сторона порта отображается 
как красный цилиндр, а отрицательная клемма - как синий цилиндр (рис. 6.7). 
Порты, которые устанавливаются на вершине (в противоположность сегмен-
там), отмечаются маленьким шариком на вершине. Если вершина порта под-
ключена к поверхности, то сегмент показывается окрашенным.  

 
6.1.2.Порты на ребре 
  
    Порты на ребрах (Edge ports) выбираются вдоль границ между двумя 
фасками. Фаски должны принадлежать той же самой части конструкции 
проекта. Выберите команду  Geometry → Create port → Edge port из 
главного меню.  
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Рис. 6.8. Диалог создания порта на ребрах для геометрии (слева) и сетки 

(справа) 
 
     Диалоги Create edge port (geometry), показанные на рис. 6.8, содержит 
два списка, в которых пользователь может прибавлять и удалять фаски. Если 
ввод в таблице можно выполнить, фон желтый, и можно щелкнуть на фаске в 
трехмерном представлении или в дереве деталей, чтобы ввести эту фаску в 
список. Когда данные добавлены в список, добавляется новая незаполненная 
строка.  
   Фаски могут быть переключены между списками, щелкая кнопку между 
списками или выполняя двойное нажатие. Этот диалог может также быть 
открыт, выбирая фаски геометрии или грани, ограничивающие фаски, 
выбирая порт командой Create port →Edge port из всплывающего меню в 
дереве подробностей. Выбранные фаски или все фаски, ограничивающие 
выбранные грани, добавляются в список Positive faces. Пользователю нужно 
только переместить соответствующую фаску в список Negative faces.  
    Граница между двумя фасками высвечивается как серый цилиндр. 
Положительные фаски отмечены вторым, красным цилиндром, а 
отрицательные фаски отмечены синим цилиндром. Заметим, что край не 
должен быть обязательно прямым - он может даже замыкаться, и можно, 
например, создать порт в центре толстого вибратора, созданного как цилиндр 
и разбитый на треугольники, а не на сегменты.  
    Для создания порта на ребре диалоги, которые осуществляют выбор на 
сетке, и на геометрии - те же самые. К этому образцу разбиения на сетку 
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обращаются, выбирая команду Mesh → Create port → Edge port из главного 
меню.  
6.1.3.Полосковые порты 
 
   Полосковые порты используются для создания источника на полосковых 
структурах. Они задаются на ребре или на нескольких гранях, которые 
формируют прямое, горизонтальное (то есть лежащее при постоянном z) 
ребро, ограничивающий только одну фаску. Кроме того, модель должна 
содержать плоскую диэлектрическую подложку с проводящей земляной 
платой. Диалог Create stripline port (geometry) содержит список граней, 
который подобен спискам фасок в диалоге Edge port. К этому порту 
обращаются, выбирая Geometry → Create port → Stripline port или выбирая 
несколько фасок и затем выбирая Create port →Edge port из выплывающего 
меню в дереве подробностей. Порт отображен в диалоге рис. 6.9 подобно 
граничному порту. Положительное направление всегда направлено к ребру.  
     В диалоге параметров разбиения на сетку ребро определено между 
начальной и конечной точками. Они должны быть вершинами и выбраны в 
трехмерном представлении, как активные вершины Start vertex и End vertex. 
(Вершины сетки разбиения должны быть отображены.). 

 
Рис.6.9. Диалог создания полоскового порта 

 
    Поля вершины тогда показывают метки элементов, связанных с 
соответствующей вершиной.  Этот диалог появляется по команде Mesh → 
Create port → Stripline port из главного меню.  
 
6.1.4. Источники в виде плоских волн 
 
     При описании структуры, возбуждаемой плоской волной, выберите 
Solution → Add excitation → Plane wave из главного меню или нажмите 
правой кнопкой мыши на папку Excitation в дереве проекта и выберите Add 
plane wave. Появляется диалог (рис. 6.10). 
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     Направление падение плоской волны определяется в сферической системе 
координат, в терминах углов θ и φ (в градусах). Поляризация определяется 
углом η, идущем вправо от направления распространения. Эллиптичность 
должна быть равна 0 для линейной поляризации, и 1 для круговой 
поляризации.  
 

 
 

Рис. 6.10. Диалог падающей плоской волны возбуждения 
      
     Источник плоской волны имеет два режима описания. Если выбрана 
опция Single incident wave, к существующим источникам добавляется одна 
плоская волна.  
    Чтобы создать сложные распределения напряженности электрического 
поля, выбирается режим Multiple Single incident (падение несколько плоских 
волн).  
   Если выбран режим Loop over multiple directions, FEKO вычисляет 
решение для каждого указанного направления падения. Пользователь должен 
определить конечный угол и приращение угла для каждой угловой 
координаты. CADFEKO вычисляет и показывает получающееся число 
падающих направлений. Заметим, что окончательный угол определяется от 
начального угла, приращения и числа отсчетов и может не совпадать с 
указанным конечным углом. Может иметься только один источник плоской 
волны с циклом по скольким выбранным направлениям Loop over multiple 
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directions. Все другие источники (перечисленные в разделе Excitations) 
активны для каждого направления падения плоской волны.  
     При редактировании источника, направление падения и направления 
поляризации отображается в трехмерном представлении. Угловые поля 
воспринимают, вводя точки трехмерного представления.  
 

 
Рис. 6.11. Возбуждение в виде нескольких плоских волн 

 
      Напряжение электрического поля падающего поля дается  
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   где v - эллиптичность, βo  направление падения и Eo вектор поляризации 
как показано на рисунке 6.11.  
 

6.1.5. Электрические и магнитные диполи 
 
     Чтобы создать точечные источники излучения, выберите Solution → Add 
excitation → Electric point source / Magnetic point source из главного меню 
или нажмите правой кнопкой мыши в дереве и выберите Electric point source 
/ Magnetic point source. В разделы Position и Orientation  (углы в градусах) 
этих диалогов вводятся координаты и ориентации источников (рис. 6.12).  
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Рис. 6.12. Диалог электрического точечного источника 

 
     Ориентация точечного источника излучения влияет на поляризацию 
излучаемой волны. Точечный магнитный источник может быть либо петлей 
электрического тока Electric ring current (величина которого задается как 
произведение тока по петле на площадь петли) или линейным магнитным 
током Magnetic (величина задается как произведение длины диполя на 
магнитный ток, рис. 6.13).  

 
 

Рис. 6.13. Диалог точечного магнитного источника в виде петли 
электрического тока 
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    Петля электрического тока и линия магнитного тока излучает то же самое 
ближнее и дальнее поле, но потенциалы излучения разные. Этот выбор 
зависит от задачи.  

 
6.1.6. Точечные источники с заданной ДН 

 
     Чтобы создать точечный источник с указанной моделью поля в дальней 
зоне, выберите Solution → Add excitation → Radiation pattern point source 
из главного меню. Или нажмите правой кнопкой мыши в разделе Excitation в 
дереве и выберите точечный источник Radiation Pattern.  
     Если координаты глобальной переменной используются в закладке 
Pattern, а  локальные координаты – не отмечены, могут быть аналогично 
быть определены, и использованы при создании геометрии. Углы 
импортированной модели интерпретируются в этих координатах и могут, 
таким образом, ориентироваться произвольно.  
   В поле Position закладки Pattern (рис. 6.14) определяется положение 
источника в локальных координатах. Позиция может также быть 
установлена, используя поле Origin в закладке Coordinates, но Origin 
определен в глобальных координатах, в то время как положение задается в 
локальных координатах. Величина масштабного множителя и смещение 
фазы применяются ко всей модели.  

 
Рис. 6.14. Диалог точечного источника, описанного его ДН 
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   Данные модели могут быть импортированы из файла *. ffe, созданного 
FEKO или файлом данных ASCII. (см. карту АR).  
     Заметим, что модель не загружается в CADFEKO, а только связывается с 
файлом. Файл обрабатывается каждый раз, когда запускается PREFEKO. 
Таким образом, можно просто записать поверх файла и повторно вычислять 
решение FEKO, но нужно следить за изменениями в файле. Файл не 
заархивирован CADFEKO, так как он может быть в другом каталоге и может 
использоваться другими моделями. Если модель CADFEKO сохранена в 
другом каталоге командой Save as, то CADFEKO сначала будет пытаться 
найти файл в том же самом пути и, в случае неудачи, пробовать находить это 
в исходном пути.  
    Нужно убедиться, что ДН в файле рассчитана на частоте решения текущей 
модели. Так как модели поля в дальней зоне - обычно частотно зависимые, 
модели с источниками диаграммы направленности излучения будут обычно 
иметь только одну частоту решения. Если диаграмма направленности излу-
чения была рассчитана в диапазоне частот, файл *. ffe будет содержать нес-
колько ДН.  
    Поле Start from point number (рис. 6.14) может тогда использоваться, 
выбирая первую линию требуемой диаграммы направленности. Например, 
если ДН первоначально была рассчитана для 50 направлений поля в 
диапазоне частот, ДН для третьей частоты первоначального решения может 
быть выбрана установкой 101 в этом поле.  
 

6.1.7. Токи в области FEM 
    Для задания источника тока в области конечных элементов FEM выберите 
Solution → Add excitation → FEM current source из главного меню или 
кликните правой кнопкой мыши на Excitation и выберите источник FEM 
current source.  

 
Рис. 6.15. Диалог для выражения источника тока в области FEM 
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    Этот источник задается модулем и фазой, а также начальной и конечной 
точкой (рис. 6.15).  
   Заметим, что линейный ток имеет постоянную величину и фазу, поэтому, 
он должен быть короткий по сравнению с длиной волны в среде в источнике. 
Так как не имеется никакого требования на юстировке нити тока с 
элементами сетки (в смысле, что должна иметься вершина сети в ее 
конечных точках), этот источник не связан с геометрией. Нужно убедиться, 
что этот источник находится в области FEM, и что обе конечных точки 
находятся на проводящих поверхностях.  
    Ограничение этого источника в том, что его радиус не учитывается, 
поэтому поле однородно около линии тока, и это влияет на точность 
вычисления входного полного сопротивления источника. В будущем этот 
источник будет применен к портам, которые будут также поддерживать 
расчет S параметров и поэтому включать нагрузки.  
 
6.1.8. Источники напряжения 
 
    Выберите Solution → Add excitation → Voltage source из главного меню 
или щелчком правой кнопки мыши на Excitation в дереве проекта и выберите 
Voltage Source, чтобы задать источник напряжения. Диалог (рис. 6.10) 
содержит поле Port, которое перечисляет все доступные порты, и входные 
поля для величины напряжения и фазы. Указанное напряжение дает разность 
потенциалов между положительной и отрицательной клеммой. 
Положительное напряжение вызывает ток, вытекающий из положительной 
клеммы. 

 
Рис. 6.16. Диалог создания источника напряжения 

     
     Источники напряжения могут также быть добавлены нажатием правой 
кнопки мыши на требуемом порту. Этот порт тогда автоматически вводится 
в поле Port в диалоге генератора напряжения (рис. 6.16).  
 

6.2. Нагрузки 
 
     Чтобы прибавить нагрузки к портам, выберите Solution → Add load из 
главного меню или сделайте двойной щелчок на Loads в дереве.  
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    Нагрузка комплексного импеданса состоит из постоянной реальной и 
мнимой части. Она может быть применена к проводному, граничному и 
микрополосковому портам. Нагрузка может представлять собой 
последовательную или параллельную схему, состоящую из резистора (R), 
конденсатор (C) и индуктивности (L), и может быть применено только к 
проволочным портам.  

          
Рис. 6.17. Создание импеданса в различном виде 

 
  Для параллельной схемы полное сопротивление (рис. 6.17, справа), 
сопротивление или индуктивность принимаются равными бесконечности, 
когда установлены равными 0 (то есть это не вносят вклад в полное 
сопротивление).  
     Заметим, что если несколько нагрузок, или источников с нагрузками 
приложены к тому же самому порту, они включаются последовательно. Это 
также относится к параллельной схеме, только в этом случае компоненты 
соединяются параллельно.  
 

6.3.Моделирование бесконечной земляной плоскости 
 
    FEKO может включать влияние земляных плоскостей и выполнять 
моделирование схем на плоских подложках. Выберите Solution → Define 
infinite planes из главного меню, или дважды нажмите на Infinite planes в 
разделе Solution в дереве проекта, чтобы открыть (рис. 6.18) диалог Infinite 
planes (ground / planar substrates).  
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Рис. 6.18. Диалог установки бесконечных плоскостей 

 
     Если выбрана Homogeneous (free space), то модель решается в свободном 
пространстве (рис. 6.12), без земляной плоскости. 
    Земляные плоскости могут быть внесены двумя способами: используя 
приближённый коэффициент отражения или точный интеграл Зоммерфельда. 
Плоскость земляной платы совпадает с плоскостью z = 0.  
    Среда выбирается из списка в разделе Ground medium (рис. 6.19). Этот 
список содержит все определяемые пользователем диэлектрические среды, и 
идеальные электрическая и магнитная плоскости для моделирования 
плоскости отражения (идеальные проводники не поддержаны в режиме 
земляной платы Зоммерфельда.). В случае коэффициента отражения, 
компонента отражения добавляется в каждом расчете поля, поскольку 
интеграл Зоммерфельда устанавливает идеальное граничное условие, 
используя соответствующую функцию Грина. Метод коэффициента 
отражения намного быстрее, но менее точен, и для реальных земляных 
плоскостей, все проводящие структуры должны быть более, чем десятая 
часть длины волны выше земляной платы. (Для идеально проводящего 
основания, структуры могут быть соединены с основанием, но не ниже ее.). 
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Рис. 6.19. Режимы установки земляной платы 

 
     Метод интеграла Зоммерфельда позволяет иметь проводящие структуры 
внутри земли, но никакой элемент разбиения не может пересечь поверхность 
земляной платы. Это может быть соединено с элементом с другой стороны. 
Например, могут быть частично скрытые провода, если вершина находится в 
точке, где провод проходит сквозь поверхность земли.  
  Если выбрана опция Planar Multilayerd Substrate (рис. 6.20), то можно 
задать материал и толщину каждого слоя в планарной конструкции. Задача 
тогда решается, используя планарные функции Грина, для моделирования 
слоистой структуры. Список Medium содержит все определяемые 
пользователем диэлектрические среды.  
   Слои могут быть добавлены и удалены кнопками Add и Remove. 
Проводящие плоскости могут прибавляться сверху слоя 1 или ниже слоя 
Bottom, отмечая поля в группе Conducting ground planes. Заметим, что слой 
Layer 0 бесконечно тонкий, и он игнорируется, если имеется проводящая 
плоскость сверху слоистой структуры. Толщина слоя Bottom только 
учитывается, если самая нижняя плоскость - проводящая. Иначе этот слой 
простирается к бесконечности. Планарная конструкция всегда ортогональная 
к z оси, вертикальность может изменяться, определяя значение Z сверху 1 
слоя. Плоские подложки используются без противовесов в слоистой 
реальной модели с земляной платой, с противовесом внизу конструкций с 
использованием микрополосковых линий и с обеими проводящими 
плоскостями в планарных конструкциях.  
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Рис. 6.20. Многослойная подложка 

 
      Сделайте щелчок правой кнопкой мыши на Infinite и выберите Show / 
Hide, чтобы переключить показ земляных плоскостей или слоев на вкл. и 
выкл. без использования изменения фактических установок. Заметим, что 
чертеж всегда показывается существующие установки. Это может несколько 
запутать, если бесконечная плоскость после этого изменяется, поскольку вид 
будет сохранять ранний просмотр вместе с существующей установкой. 
Поэтому рекомендует скрыть показ бесконечных плоскостей при 
редактировании структуры. 

 
6.4. Установка частот решения 

 
Выберите команду Solution → Set frequency или дважды нажмите на 
Frequency в разделе Solution в дереве проекта, чтобы открыть диалог Solution 
frequency (рис. 6.21). Здесь имеется четыре опций частотного диапазона. 
Режим Single frequency позволяет установить конкретную частоту решения.  
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Рис. 6.21. Задание частот расчета 

     
   Если выбран режим Continuous (interpolated), все требуемые результаты 
рассчитываются, используя адаптивные выборки в диапазоне частот от Start 
frequency до End frequency. Алгоритм выбора частотных точек использует 
лучший алгоритм частотных выборок, для обеспечения того, что все резонан-
сные эффекты были рассчитаны точно. Установка параметра Maximum 
number of samples ограничит число решений или время расчета, но резуль-
таты могут быть получены неточными, если не будет перекрытия всего 
диапазона частот.   
    Параметр Minimum frequency increment используется для ограничения 
плотности создания частотных точек. Это полезно, если имеются небольшие 
расхождении результатов расчета.  
    Используя опции Linearly spaced discrete points и Logarithmically spaced 
discrete points, можно задать фиксированное число точек между начальной и  
конечной частотой.  
 
 

6.5.Установка мощности источника 
 
    Возбуждение антенны обычно определяется как комплексное напряжение, 
но может требоваться, чтобы задать общую излучаемую мощность или 
мощность источника. FEKO может определять масштабирование  результата, 
чтобы задать желательный уровень мощности. Выберите Solution → Specify 
power settings, или дважды щелкните Power в разделе Exitation, чтобы 
управлять мощностью источника (рис. 6.22). Заметим, что FEKO использует 
пиковую величину для всех комплексных величин. Следовательно, 
возбуждения должны быть определены с пиковой величиной (в 
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противоположность среднеквадратичным значениям) если никакое 
вычисление мощности не выполнено.  
 

 
Рис. 6.22. Установка мощности источника возбуждения 

 
     Если выбрана опция  No power scaling, FEKO вычисляет результаты с ука-
занными величинами источников. Заметим, что плоские волны имеют беско-
нечную протяженность и поэтому бесконечную мощность. Следовательно, 
если модель содержит возбуждения плоской волны, нужно выбрать No power 
scaling.  
      Если выбрана установка Total source power, FEKO выполняет расчет так, 
чтобы общая мощность источника (сумма мощностей, поставляемых всеми 
отдельными источниками) равнялась величине, указанной в поле мощности 
источника. Никакое рассогласование не учитывается. Эта опция может 
использоваться с любым возбуждением, кроме плоских волн.  
    Если выбран режим Incident power (transmission line model), то считается, 
что все антенны питаются линиями передачи с комплексным характеристи-
ческим импедансом Zo. Поле Source power определяет сумму падающей 
мощности от всех этих линий передач. Если имеется рассогласование между 
полным сопротивлением линии передачи и входным сопротивлением антенн, 
часть падающей мощности будет отражена назад к источнику. Это – 
следствие рассогласования. Эта опция может использоваться только в том 
случае, если модель содержит только генераторы напряжения.  
     FEKO всегда вычисляет полную мощность всех источников для всех 
решений. Для больших моделей или моделей со многими источниками, 
расчет взаимной связи, которая требуется для точного расчета соотношения 
мощностей источников, может быть очень длительный. Если все источники 
развязаны,  взаимная связь не рассматривается при вычислении мощности 
источника. Это приемлемо для источников, которые расположены 
относительно далеко друг от друга и от других структур в модели, или когда 
не требуются точные значения мощности (усиление антенны и 
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направленность основаны на мощности, и они, вероятно, будут неточными, 
если установлен этот режим).  

6.6. Установка параметров решения на фасках 
 
   Отдельные плоскости могут моделироваться разными методами. Например, 
некоторая плоскость модели может быть решена методом физической оптики 
PO. Это устанавливается в закладке Solution диалога Face properties или 
диалога Mesh properties для меток треугольников (установка параметров на 
геометрии перемещается к разбиению на ячейки во время объединения.)  
    Если выбрана опция Solve with physical optics (PO), используется метод 
физической оптики при вычислении токов на поверхности. В этом методе, 
существенная часть времени решения затрачивается на прочерчивание траек-
торий лучей (устанавливающих, какие элементы являются видимыми от каж-
дого элемента тока, отличного от PO). Это может подобрано опцией 
Optimise ray tracing и выбором Always illuminated or Only illuminate from 
front (освещение всегда или освещение только с передней стороны). Первая 
опция применима, когда вся PO поверхность освещается только для анализа 
отражения. (Поверхности, не заданные как PO, рассматриваются 
прозрачными для этой цели.). Вторая опция применима ко всем замкнутым 
телам, но нормальный вектор должен указать направление наружу от каждой 
фаски. Если какая либо из этих опций отличается от нескольких выборов, то 
поле находится в неясном состоянии.  

 
Рис. 6.23.Черчение лучей в программе POSTFEKO 

 
     По умолчанию устанавливается Integral equation (интегральное 
уравнение) – как уравнение для электрического поля. Это - наиболее общая 
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формулировка и может быть применена и для разомкнутых, и замкнутых 
объектов. Установка Combined field  может только использоваться на 
замкнутых объектах, и этот подход более устойчив. Если его применять, то 
это особенно полезно использовать в методе MLFMM, тогда требуется 
меньше ЗУ, и сходимость – более быстрая. Можно выполнить установку 
Combined field на объектах модели, но поверхность должна быть замкнута, и 
все нормали должны указать направление наружу.  
 

6.7.Выбор требуемых результатов расчета 
 
     Дерево проекта содержит список рассчитываемых характеристик. Они 
перечислены в разделе Calculation (рис. 6.24). Эти результаты рассчи-
тываются для всех частот с заданными нагрузками и возбуждениями. 
Некоторые требуемые характеристики могут быть скрыты, переименованы и 
удалены (кроме токов). Они могут также установлены двойным нажатием на 
них или выборе Properties из всплывающего меню.  
    Каждая характеристика отмечается меткой Label, которая используется, 
что-бы идентифицировать запрос в CADFEKO и для показа этой 
характеристики в POSTFEKO.  
 

 
Рис. 6.24. Выбор рассчитываемых характеристик 

 
6.7.1. Расчет токов на металлических поверхностях 
 
     Двойное нажатие на Currents в разделе  Solution (или выбирая Current 
output из меню) дает возможность выбора режима вывода тока в выходной 
файл (рис. 6.25). Эта опция требуется для показа распределений тока на 
поверхности, но это может приводить к большим выходным файлам. Если 
выбрана опция Export currents to *.out file, токи записываются в файл *.out.  
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Рис. 6.25. Диалог задания расчета токов на металлических поверхностях 

 
 Если отмечена опция Export currents to ASCII file, токи записываются в 
файл *.os.  
 
6.7.2.Расчет S-параметров 
 
    Диалог Request S-parameters содержит таблицу, в которой можно задать 
порты и импедансы каждого порта (рис. 6.26). Если отмечается режим Active 
в таблице, то порт используется как источник. Иначе этот порт служит 
только для приема сигнала. Например, если список содержит два порта и 
активен только порт 1, FEKO вычислит S11 и S21, но не S12 и S22. Если 
активен также порт 2, также рассчитываются S12 и S22. Кнопки Add и 
Remove позволяют прибавлять или удалять порты в списке. Если отмечено 
Export S Parameters to Touchstone file, рассчитанные S параметры 
записываются в файл *. snp.  
 

 
Рис. 6.26. Диалог задания расчета S параметров 
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   При расчете S параметров, FEKO нагружает все порты с указанными 
импедансами. Эти нагрузки обычно остаются как нагрузки портов, после 
вычисления S параметров. Если отмечен режим Restore loads after 
calculation, то нагрузки после расчета S параметров удаляются. Однако, 
восстановление нагрузок требует полного расчета матрицы и LU 
декомпозиции в методе моментов (Это - обычно самый длительный шаг в 
анализе.)  
 

6.7.3. Расчет характеристик антенны в дальнем поле 
 
     В закладке Position диалога расчета дальнего поля (рис.6.27)можно 
выбрать один из двух опций: расчет поля в направлении излучения во все 
стороны, и расчет поля в направлении плоской падающей волны. В 
последнем случае направление падения используется вместе с возбуждением 
плоской волны с несколькими падающими направлениями, главным образом, 
чтобы вычислить эффективную поверхность рассеяния (RCS). В этом случае 
никакие параметры в закладке Position не требуются, поскольку рассеянные 
поля рассчитываются только в обратном направлении к падающей волне. 
Если эта опция выбрана, модель должна содержать возбуждение плоской 
волны с несколькими направлениями падения. Иначе программа даст ошибку 
во время решения.  
    Если выбран режим Calculate field as specified, то задаются начальный и 
конечный углы, а также шаг угла для каждой угловой оси. CADFEKO вычис-
ляет и выводит дальнее поле в этих точках. Фактические конечные углы 
зависят от начальных углов, количества точек и приращений, и могут не 
совпадать точно с указанными конечными углами. 
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Рис. 6.27. Диалог дальнего поля когда задан расчет полей 

 
     Когда число приращений больше 1, для обоих угловых параметров, FEKO 
вычисляет также интеграл вектора Пойнтинга (то есть полную мощность 
излучения) через сегмент, заданный начальным и конечными углами также 
как вторым сектором, который расширяет приращение наполовину всюду 
вне указанного диапазона. Это нужно для ликвидации неоднозначности в 
определении замкнутых поверхностей в сферических координатах. Полный 
срез по углу φ выполняется от 0o до 360o, но последнее направление 
соответствует первому.  
    Закладка Coordinates позволяет установить начало координат Origin для 
расчета полей. Это обеспечивает позицию опорной фазы.  
     В закладке Advanced можно выбрать расчет усиления и направленности. 
POSTFEKO может показывать оба результата, независимо от этой установки 
- эта установка управляет только тем, что записывается в файл  *.out.  
    Если отмечено поле Export fields to ASCII file, результаты 
экспортируются в файл *. ffe. Этот файл может использоваться другими 
постпроцессорами или как модель для диаграммы направленности излучения 
точечного источника или приемной антенны. Если отмечены поля Export 
fields to *.out, то поля записы-ваются в файл *.out. Этот файл не 
используется POSTFEKO, но эта опция дол-жна быть отмечена при 
использовании OPTFEKO. Если отмечено Calculate only the scattered part of 
the field , излучение из приложенных источников (типа электрических и 
магнитных точечных источников) игнорируется, остав-ляя только 
рассеянные поля. (Для источников плоской волны вклад источника всегда 
игнорируется.) Обычно эту опцию не нужно включать. Если отмечено 
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излучение мощности поля в дальней зоне интегрированием Only determine 
radiated far field power by integration, рассчитываются поля в дальней зоне 
и полная мощность излучения, но поля не записываются в файлы *. bof и *. 
out. (Дальние поля только записываются в файл *. ffe).      
 
6.7.4.Расчет ближнего поля 
 
    Чтобы вывести ближнее поле на плоскость, нужно задать параметры этой 
плоскости в закладке Position (рис. 6.28), где вводится начальное, конечное 
положения и шаг приращения по каждой оси. CADFEKO вычисляет и 
показывает значения ближнего поля в каждом направлении. Конечное 
положение зависит от начальной позиции, числа отсчетов и приращения и 
может точно не совпадать с указанным конечным положением. В результате 
предварительного просмотра можно видеть сетку маркеров в указанном  
диапазоне (если имеется слишком много маркеров, они не чертятся.)  
 

          
Рис. 6.28. Закладки Position для расчета ближнего поля в растре антенны 
 
     Закладка Coordinates используется для выбора системы координат. Origin 
определяет начало системы координат. В этом случае ближние поля 
рассчитываются на сферической поверхности вокруг точки Origin.  
    В закладке Advanced (рис. 6.29) можно выбрать опции поля (Fields) и 
потенциалов для расчета. Если отмечены поля Export to file ASCII, расчетные 
электрические поля записаны в файл  *efe, а магнитные поля в файл *. hfe.   
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Рис. 6.29. Закладка Advanced расчета ближнего поля 

 
     Эти файлы в формате ASCII могут использоваться другими постпроцессо-
рами или как данные апертурного источника. (См. карту АP). Если отмечен 
режим Export to file *. out, в файл  *. out включаются поля.  
    Если отмечен режим Calculate only scattered part of the field, вклад 
излучения из приложенных источников (типа электрических и магнитных 
точечных источников) игнорируется, и остаются только поля рассеяния. 
Обычно эта опция не отмечается.  
 
6.7.5. Уровень поглощения мощности в среде  
     Расчет уровня удельного поглощения мощности в объеме (SAR) чаще 
всего выполняется как величины, усредненной в объеме (Volume-average 
SAR) или как максимальное поглощение в 1 г/см3 или 10 г/см3 в заданном 
объеме пространства (Spatial-peak SAR). Эта характеристика может быть 
выбрана в группе Select calculation в диалоге Request SAR (рис. 6.30).  
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Рис. 6.30. Диалог расчета SAR 

 
    Для расчета SAR нужно задать область анализа. Это может быть вся 
модель, или области, определенные средой, в плоской подложке или в 
указанной точке пространства. Последние две опции, не задаются для 
расчета параметра, усредненного по объему. Если выбрана среда, 
пользователь может выбирать определенную среду или выделить все среды. 
Для случая среднего значения в объеме и максимального SAR рассчитан 
отдельно для каждой среды, таким образом это не то же самое, как выбор 
Entire model. Точно так же для опции In planar substrate, пользователь 
может выбирать удельный уровень. Уровень 0 – верхняя область свободного 
пространства, уровень 1 – верхний диэлектрический уровень и т.д., или 
выделите всё уровни.  
 

6.8.Анализ кабеля 
 
   В FEKO имеется возможность анализа связи кабеля с большой проводящей 
структурой, находящейся рядом. Диалог установки параметров расчета 
кабеля вызывается по команде Solution -> Request cable analysis. В закладке 
Cable path, кабель определяется как серия сегментов прямой линии. Точки 
углов могут быть вставлены или удалены кнопками Add и Remove. Если 
начальная точка используется вначале, то последняя определяется в списке 
(рис. 6.31). Новая точка добавлена автоматически. Можно пересекать тракт 
сам с собой (или другие кабельные тракты), но не должно быть никакого 
электрического контакта в этих точках пространства.  
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Рис. 6.31a. Две линии передачи с различными 
нагрузками установлены на металлической 
земляной плане конечного размера.  

Рис. 6.31 б.Индуцированные токи в 4 портах 
соединенных линий передачи 
 

         В закладке Cable Properties можно выбрать заранее заданный тип 
кабеля или определять свойства кабеля вручную. (Заметим, что 
предопределенные кабели в настоящее время ограничены частотами от 10 
кГц до 500 МГЦ.) Во время расчета, FEKO разбивает на сетку кабель в виде 
дискретных сегментов. Остальные размеры могут быть изменены в группе 
Sampling Density, но это не рекомендуется.  

  
Рис. 6.32a. Построение пути кабеля 
по точкам 

 Рис. 6.32б.Задаваемые параметры 
кабеля 

 
      Можно задать импедансы нагрузок между двумя проводниками кабеля 
(внутреннего), а также между кабелем и самыми близкими проводящими 
структурами в каждом порте в закладке Port Terminations. (рис. 6.33, см. 
карту CA)  
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Рис. 6.33. Закладка нагрузок портов диалога анализа кабельных систем 

 
    Результат анализа кабеля - напряжения, токи, полное сопротивление и 
мощность между внутренним проводом и экраном – отображается в 
POSTFEKO на графике данных (рис. 6.33). Заметим, что FEKO вычисляет 
связь с кабелем, но присутствие кабеля не обязательно принимается во 
внимание в любом вычислении.  

6.9.Приемная антенна 
 
    При применении в проекте приемных антенн, FEKO должен вычислить 
мощность, принятую изотропной антенной с заданной диаграммой 
направленности. Считается, что антенна согласована (т.е. нет потерь на 
рассогласование); и расположена только в точке; и модели не 
взаимодействуют для разных фаз решения (никакая связь не учитывается). 
Приемная антенна обратима, к точке источника с указанной моделью и 
параметрами (рис. 6.34).  
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Рис. 6.34. Параметры идеальной приемной антенны 

 
     Расчетная полученная мощность может быть выведена на график Power 
data в POSTFEKO.  
 

6.10. Обоснование адекватности модели 
 
    После задания на расчет рекомендуется выполнить команду Solution → 
EM validate для проверки модели (так как ячейки разбиения могут состоять 
из миллионов элементов, CADFEKO не делает длительной проверки 
параметров разбиения на ячейки.) Все ошибки или потенциальные проблемы 
перечисляются в информационном окне. Обоснование адекватности модели 
требует выбора частот, поскольку это влияет на верность ряда установок. Так 
как модель может одновременно содержать различные типы проблем, 
проблемы перечислены в информационном окне, и пользователь должен 
использовать различные пункты меню Find, чтобы расположить ошибки по 
одной. Основная программа расчета FEKO может давать дополнительные 
предупреждения и сообщения об ошибках в выходном окне запущенного на 
расчет FEKO.  
   Модель CADFEKO сохранена в файле *.cfx. Решение этой модели в FEKO 
требует двух дополнительных входных файла, а именно файла *.cfm, 
который содержит информацию о разбиении и файла *.pre, который 
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управляет процессом решения. CADFEKO автоматически экспортирует 
текущее разбиение на ячейки в файл *. cfm, каждый раз подпрограмма 
запускается из меню Run. Если запуск на решение выполняется, то файл *. 
pre сохраняется с файлом *. cfm. Если CADFEKO встречает любые 
недопустимые установки, он записывает ошибку в файл *. pre так, чтобы 
пользователь получил соответствующее сообщение об ошибках даже, когда 
REFEKO запускает другую подпрограмму из набора программ FEKO.  
    Обычно, когда модель создана в CADFEKO, PREFEKO запускается, чтобы 
создать входной файл FEKO. Этот файл может просматриваться в 
POSTFEKO перед запуском FEKO на расчет. Окончательные результаты 
могут снова просматриваться в POSTFEKO.  
     Пункт Component parameters в меню Run позволяет задать параметры в 
командной строке для различных компонентов FEKO (рис. 6.35). Этот диалог 
одинаковый для CADFEKO, POSTFEKO и EDITFEKO.  
 

 
Рис. 6.35. Установка параметров работы составляющих подпрограмм 

FEKO 
     
     Если отмечено Treat errors as non-fatal... в закладке PREFEKO, 
PREFEKO продолжает счёт после первой ошибки. Это может привести к 
большему количеству ошибок как следствие первой, но иногда полезно 
видеть всю геометрию, и сразу все ошибки модели. PREFEKO может также 
генерировать дополнительные данные, полезные для отладки, и эти 
параметры должны быть использованы для отладки. Поле Advanced 
позволяет вручную ввести параметры, которые будут выполнены после 
имени файла в командной строке.  
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    Если отмечена проверка геометрии Only check the geometry в закладке 
FEKO (рис. 6.36), то FEKO выполнит проверку геометрии и выйдет без 
расчета. Эта опция обычно используется перед решением модели на 
отдельной машине. Пользователь может также установить  приоритет FEKO 
продолжает этот закладку. Если приоритет установлен к Low,  расчет будет 
выполняться дольше, но компьютер можно загрузить другой работой. 
(Заметим, что при параллельном выполнении все машины в группе работают 
со скоростью самого медленного компьютера, поэтому скоростной 
центральный процессор одном из компьютеров в группе не рекомендуются.). 
Поле Environment Variable (рис. 6.36) может использоваться, чтобы ввести 
системные переменные, которые могут управлять решением FEKO.   
 

 
Рис. 6.36. Опции установки работы FEKO 

 
   Опция Remote host используется для дистанционного расчета, когда 
отмечен режим Run → Remote FEKO execution. Опции в разделе Parallel 
execution  ис-пользуются для параллельной версии  FEKO в режиме Run → 
Remote FEKO execution.  
  Выбор опции в группе Configure позволяет использовать PC для 
параллельного и последовательного решения на нескольких компьютерах. 
Поле Advanced позволяет вручную ввести параметры, которые будут 
установлены после наименования файла в командной строке.  
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Рис. 6.37. Закладка параметров утилит FEKO 

 
 В закладке Utilities (рис. 6.37) можно выбрать опции работы утилит 
OPTFEKO, TIMEFEKO и ADAPTFEKO. Опция Restart analysis number для 
ADAPTFEKO устанавливается для повторного запуска после остановки 
может использоваться, если выполнение останавливается (и временный файл 
не был удален). Решение может быть перезапущено на анализ заданным 
количеством раз.  
 

6.11.Работа с моделями CADFEKO в EDITFEKO 
 
      CADFEKO может установить полную конфигурацию решения, и в общем 
случае не должен работать с файлом  *. pre непосредственно. Однако, неко-
торые возможности FEKO доступны только через EDITFEKO. Пользователи 
могут также продолжать использовать EDITFEKO для существующих 
моделей со сложными установками управления. CADFEKO может создавать 
файл *.pre, но не может импортировать его. Таким образом, если файл *.pre 
изменяется вне CADFEKO, это должно быть выполнено в EDITFEKO.  
    Как говорилось ранее, CADFEKO поддерживает старые модели. Также в 
слу-чаях, когда нужно редактировать файл *. pre, чтобы получить решения с 
помощью встраивания геометрии, это выполняется с помощью команды 
Solution → Enable solution parameters.  
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Рис. 6.38. Перечень требуемых характеристик 

 
   Обычно этот пункт отмечен и снят, и все решения, связанные с действием, 
допускаются. Если модель загружена или сохранена в CADFEKO, этот 
режим отмечен, если файл *. pre редактировался вне CADFEKO. Если дело 
обстоит так, пользователь может согласиться потерять изменения в файле *. 
pre или блокировать решение в CADFEKO.  
     Если решение CADFEKO заблокировано (рис. 6.38), команда Enable 
solution configuration также блокируются. Все установки решения 
недоступны и любые существующие установки игнорируются при 
сохранении модели. (Они могут быть восстановлены, запуская решение 
снова.) Диэлектрические среды могут быть созданы, но их параметры 
материалов не могут быть установлены. В то время как решение допускается, 
не имеется никакого ввода EDITFEKO в меню Run. Начальное 
редактирование нужно будет выполнить вне CADFEKO.  
    Выбор опции Enable solution configuration (возможность 
конфигурации решения) вновь восстановит все установки решения, и 
возможность переименовать существующий файл *.pre к name_orig_x. pre 
(x - число, который гарантирует, что никакой существующий файл не 
переписан). Установки в файле *. pre тогда игнорируются.  
 
6.11.1.Имена элементов со ссылками 
 
    В программе EDITFEKO можно задать, что характеристики должны быть 
установлены на определенных элементах, используя их полные обозначения, 
метки. Сегменты имеют обозначение ребра (обычно названным Wire...), 
треугольников, которые лежат на фасках (обычно Face...), и тетраэдра в 
диэлектрической области (обычно Region...). Конечно, эти имена могут 
изменяться на геометрии или элементах сетки разбиения. 
    Поскольку установки источников и нагрузок на проводных сегментах 
требуют уникальные метки, CADFEKO экспортирует портовые сегменты с 
уникальными метками. Эти метки созданы, приобщая имя порта к 
обозначению провода. Например, если Port1 находится на среднем сегменте 
линии Line1.Wire1, этот средний сегмент будет обозначен Line1. Wire1. 
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Port1, в то время как остающиеся сегменты будут иметь обозначение Line1. 
Wire1.  
    Для портов на вершине, сегмент более короткий, соединенный с 
вершиной.  POSTFEKO, может использовать его для проверки, какой сегмент 
был переобозначен.  
     Поскольку каждая область/ фаска / край имеют уникальную метку, модель 
может содержать большое количество меток. Реквизиты установки такой 
характеристики, как потерь, требуют большого количества карт.   
   Чтобы упростить это, в PREFEKO можно сделать кратное число 
переименований, маркирующих использование групповых символов * и # 
(где * расширяется до любой строки, а # до любого символа).  
   Например, при переименовании Wheel.Face* к . Face*, в Wheel  
переименует фаску Wheel1. Face1 и Wheel2. Face17 (и все другие, 
соответствующие этой модели, но не Wheel10. Face1 или Wheel1. Wire1) к 
Wheel. Они могут быть тогда упомянуты с одним именем. После 
переименования этих элементов, первоначальные имена больше не 
существуют, то есть ссылка на объекты с этими именами, не даст результата.  
     Осторожность должна, однако, принята, чтобы не переименовать 
обозначения - типа портов - которые должны быть уникальными.  
 
6.11.2.Использование переменных  и поименованных точек 
в EDITFEKO 
 
    При экспорте файла  *. cfm, CADFEKO включает все переменные и 
названные точки с их текущими значениями. Эти значения тогда 
импортированы PREFEKO и могут быть включены в файл *.pre - в любой 
точке после карты IN (рис. 6.39).  

 
Рис . 6.39. Последовательность карт в EDITFEKO 
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   Заметим, однако, что все выражения, используемые в конфигурации реше-
ния, рассчитываются перед записью файла *.pre. Следовательно, изменение 
этих переменных переопределяет их после карты IN в EDITFEKO, и не будет 
иметь никакого влияния.  
 
6.11.3.Установка параметров диэлектрика 
 
     Если решение заблокировано, диэлектрические среды можно все еще 
определять и применять к областям. Однако, параметры каждого 
диэлектрика должны быть определены картой DI, использующей имена 
диэлектрика, в разделе управления файл *.pre. Имена диэлектриков 
иерархические не подобны именам метки, и тот же самый диэлектрик может 
быть применен к нескольким полностью разделенным областям.  
 

6.12.Использование симметрии 
 
     CADFEKO в настоящее время не описывает симметрию. Но она может 
быть описана с помощью карты SY в EDITFEKO. Тогда в CADFEKO 
чертится только одна половина модели. Обычно создается полная модель, а 
затем она разбивается по одной или большему числу плоскостей симметрии.  
    Структуры на плоскости симметрии требуют особой осторожности. При 
разбиении твердого объекта, в плоскости разбиения создается новая фаска. 
Если модель объединена, эта фаска будет включена. Эти элементы будут 
тогда дублированы операцией симметрии, приводящей к недопустимому 
разбиению на ячейки. Самое простое решение - это преобразовать твердый 
объект к его поверхности перед разбиением его, но эта операция не всегда 
может быть возможна (например, если твердое тело - диэлектрик). 
Альтернативно эти элементы могут быть удалены после объединения, или в 
карте IN, чтобы не включать их.  
     Более сложная задача включает модели, которые содержат структуры, 
лежащие в плоскости симметрии. Они должны быть импортированы после 
определения плоскости симметрии. Сначала карты IN с обозначением 
импортированной  метки должны использоваться для импортирования всей 
геометрии, лежащей не в плоскости симметрии; затем определяется карта 
SY, и наконец импортируются структуры в плоскости симметрии.  
     FEKO поддерживает диапазоны меток, если линии оканчиваются числами 
- нужна только одна карта, чтобы включить все метки, например, от 
Assembly.Part.Face3  до Assembly.Part.Face12. Области не включают объек-
ты с полностью различными метками, метки, которые не имеют номера или 
имени, где номер находится снаружи области. Заметим, что используется 
номер в целом, а не отдельные цифры. Пример будет включать 
Assembly.Part.Face4 и Assembly.Part.Face11, но не Assembly.Part.Face и 
Assembly.Part.Face44. 



 173 

     Меньшее количество карт IN требуется, если элементы получают другие 
метки, нежели в CADFEKO. Элементы, относящиеся к различным частям, не 
могут принадлежать к той же самой метке, так что формование 
объединенной модели перед разбиением на ячейки может упростить решение 
задачи.  
 

7. Постпроцессорная обработка результатов в 
POSTFEKO 

 
        После выполнения расчета в ядре FEKO и нахождения результатов 
решения – токов на поверхности, запускается POSTFEKO. POSTFEKO 
автоматически загружает файлы геометрии файла текущей задачи *.fek и 
файла результатов *.bof. В одном сеансе могут быть загружены несколько 
файлов *.fek и *.bof, и информация в них отображается в нескольких окнах. 
Если то же самое имя файла загружено из различных каталогов, модели 
различаются, прибавляя номер к имени файла. Полный путь может быть 
определен, выбирая модель в браузере базы данных и выбирая Properties из 
всплывающего меню щелчком правой кнопки мыши.  
 

7.1. Интерфейс POSTFEKO 
 
   Интерфейс POSTFEKO (рис. 7.1) подобен CADFEKO. Экран вывода 
результатов автоматически изменяется, когда модель или результаты 
модифицируются. Сверху находится главное меню и основная инстру-
ментальная панель. Панель управления находится слева, и управляет видом 
активного окна. Область вывода данных может содержать несколько 
трехмерных представлений и двумерных графиков. Строка состояния (снизу 
справа) показывает текущие углы обзора и результат вычисления расстояния. 
Все окна на экране и их параметры настройки сохраняются в файле сеанса 
*.pfs. 
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Рис. 7.1: Главное окно POSTFEKO. Здесь отображена только геометрия 
одной  модели, и панель управления – показывает информацию модели 
 
    Панель управления может быть скрыта или показана командой View → 
Control panel из основного меню POSTFEKO (рис. 7.1), или нажимая <Alt> < 
P>. Эту панель можно поместить сверху или снизу основного окна или 
свободно перемещать, перетаскивая за сдвоенные линии. 
    Сеансы могут быть сохранены и загружены из меню File или панели рис. 
7.2. Новый сеанс закрывает текущий сеанс, разгружает всю модель и файл 
результатов и открывает новый незаполненный сеанс. Команда Open session 
закрывает текущий сеанс, и загружает новый сеанс. POSTFEKO загружает 
файлы *.fek и *.bof , чтобы создать среду при сохранении Save session.  
 

 
Рис. 7.2. Управляющая часть главной инструментальной линейки 

 
     Если загружен только файл *.fek, отображается только геометрия. 
POSTFEKO, однако, автоматически загрузит требуемый файл *.bof, если 
нужно показать результаты расчета.  
    Обычно POSTFEKO запускается из CADFEKO или EDITFEKO. Если 
имеется сохраненный сеанс с текущим именем, он будет загружен. Иначе 
создается новый сеанс и текущая модель загружается из файла результата, 
если он доступен. 
     POSTFEKO может также быть запущен из командной строки postfeko, из 
меню Start или нажатием на файле *.pfs, *.fek или *.bof. При запуске 
POSTFEKO нужно задать имя файла как параметр командной строки. Если 
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расширение не дается, POSTFEKO будет искать последовательно файлы 
*.pfs, *.pre, *.fek и *.bof. Когда имеется файл  с расширением *.pre и далее 
идет параметр, POSTFEKO будет пытаться загружать связанный с файлом 
*.fek и *.bof . 
     Меню Run используется для запуска других программ в комплексе FEKO 
и задания опций этих компонентов. Если только одна модель загружена и 
открыто трехмерное окно, компонента запускается с данной моделью. 
Компоненты, которые используются наиболее часто, можно запустить из 
основной инструментальной панели (рис. 7.3). 

 
Рис. 7.3: Запуск отдельных подпрограмм из инструментальной линейки 

    Новое трехмерное окно создается после нажатия <Ctrl> < V>  или 
кнопки Add a new 3D view на инструментальной панели. Тогда POSTFEKO 
открывает новое трехмерное окно и загружает новый файл модели *.fek. 
Каждое трехмерное окно может показывать только одну модель (геометрия и 
результаты) одновременно. Выбранная модель показывается в поле, а имя 
файла показывается сверху панели управления. 
 

7.1.1. Изменение масштаба изображения, вращение и 
панорамирование модели 

 
     Модель вращается, захватывая её и перемещая мышь. Можно также 
изменять масштаб изображения, нажимая <Shift> и перемещая мышь. 
Вращение колеса мыши также изменяет масштаб изображения (нажимая  < 
Shift > и вращая колесо мыши, изменяется масштаб изображения). 
Прокручивая колесо мыши, при удержании курсора мыши у края экрана, 
можно выполнить панорамирования. Наконец, изображение может 
изменяться по размеру при нажиме клавиши <Ctrl> и перемещая мышь с 
нажатой левой кнопкой.  
   Большинство этих параметров доступно конкретным способом. Как и в 
CADFEKO, блокировка Z оси и вращение модели выполняется так, что 
верти-кальная ось z остается на экране.  
    Можно изменить изометрический вид, согласуя размер модели с окном и 
возвращая направление к θ=65◦, ϕ=35◦). Кроме того, инструментальная 
панель может использоваться для изменения масштаба изображения, 
вращения модели с дискретными приращениями. 
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Рис. 7.4. Инструментальная линейка управления 3D видом 
 
 Инструментальная линейка может быть показана или скрыта, нажимая 
<Alt><T> или выбирая View → Toggle 3D toolbar из главного меню 
POSTFEKO (рис. 7.4). 
 

7.1.2. Панель управления видом модели 
 
   Некоторые страницы и группы в POSTFEKO имеют опции Visible, которые 
позволяют скрывать отдельные элементы и группы (рис. 7.5). В большинстве 
случаев, POSTFEKO показывает результат сразу при переключении на новую 
страницу. Например, если пользователь отмечает опцию View 3D far fields,  
будет отображена модель с трехмерным полем в дальней зоне. Если это не 
нужно, нужно снять опцию Visible. 

 
 

7.2.Описание страниц POSTFEKO 
 
   Контрольная панель открывается в главном меню Main display options, как 
показано на рис. 7.5. Эта контрольная панель показывает геометрию, и на ней 
можно проверить, верно ли смоделированы диэлектрические и металические 
покрытия. 
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Рис. 7.5. Станица Main display options  панели управления видом модели 

 

7.2.1. Главная страница опций POSTFEKO  
 
      Выбирая режимы в боксах сверху страницы (рис. 7.5), можно показать 
отдельные объекты и группы объектов. Кроме того, перемещая элемент из 
списка Visible в список Hidden внизу страницы, объекты становятся 
невидимыми. 
   Опция Named Poiте показывает поименованные точки, Element Direction 
направление элемента на поверхности,  Normals – направление нормалей, 
Label No и Element No – номера меток и элементов. 
    Группа Geometry colour позволяет видеть компоненты проекта в цвете, 
разделяя метки, области, типы элементов и поля.  
     В поле Legend, можно ввести заголовок графика. Цвета, используемые 
для каждой метки в активной модели могут изменяться, нажимая кнопку 
Label colours. Это открывает диалог устройства выбора видимости. 
Пользователь может прибавлять или удалять цвета как требуется. Первый 
цвет относится к элементам с первой меткой, второй – к элементам со второй 
меткой и т.д. 



 178 

    Цвет можно также изменить на странице Transformation , включая опцию 
Depth lighting. Цвета на модели тогда будут те же самые, но не будет 
восприятия глубины. Например, сфера будет выглядеть как плоский диск. 
Также возможно переместить источник света далеко от точки просмотра. 
Например, в случае сферы, можно видеть, как изменяется теневая сторона. 
 

7.2.2. Страница дополнительных опций просмотра  
 
   Эта страница управления свойств показывает некоторых дополнительные 
свойства (например видимость бесконечных плоскостей), но главным 
образом используется для управления видимостью. Слайдер Enlarge radius 
регулирует радиус всех сегментов, чтобы сделать их более видимыми. 
Можно увеличить размер сегментов, кубоидов и тетраэдров, чтобы сделать 
более видимыми границы. Эти элементы отображены в их истинном размере, 
если слайдер находится справа. Слайдер Label/normal scale используется для 
изменения длины нормальных векторов и используется для отображения 
дополнительной информации (например номеров элементов) в трехмерном 
виде. 
 Геометрия делается полупрозрачной слайдером Geometry transparency 
(рис. 7.6). Земляные платы и плоскости, описываемые функциями Грина 
(установленные в разделе Infinite Planes в CADFEKO) могут быть скрыты, 
снимая опцию Visible в разделе Ground plane. Если модель была создана в 
EDITFEKO, она может содержать карты многократного отражения от земли 
(карта BO) и / или функции Грина для плоских или сферических 
многоуровневых носителей (карта GF). Они отображены по одному, выбирая 
в соответствующее поле карты GF или BO.   
    С помощью опций в разделе Green’s functions, можно видеть слои с 
промежутками между ними, при расчете которых используются функции 
Грина.  
   Наконец опция Anisotropic layers используется для показа тонких листов 
диэлектрического материала с характеристикой анизотропной среды (карта 
SK). 
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Рис. 7. 6. Станица дополнительных опций POSTFEKO 

 
 

7.2.3. Страница установки осей  
 
  На странице Axis settings (рис. 7.7) устанавливаются свойства главных, а 
также малых осей, находящихся в левом нижнем углу трехмерных окон. На 
осях могут быть нанесены отрезки, чтобы показать размеры модели. 
Количество их, Number of ticks включает метку в начале координат. Если 
это значение равно 2, в конце каждой оси выводится одна метка. Если 
выбран режим Autoscale, длина оси будет связана с размером модели. Если 
этот режим выключен, длина оси может установлена вручную. 
      Если отмечен флажок рядом с одной из трех координатных плоскостей в 
разделе Grid options, POSTFEKO показывает сетку (со значениями позиции) 
в этой плоскости. Передвижение слайдера перемещает сетку по 
направлению, ортогональному к плоскости сетки. 
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Рис. 7. 7. Страница осей POSTGFEKO 

 

7.2.4. Страница трансформации просмотра  
 
    Эта страница (рис. 7.8) позволяет изменить вид модели, и её размер. 
Обычно, ориентация представления управляется мышью. Эта страница 
используются, когда нужно рассмотреть модель под конкретным углом или 
синхронизировать два представления. Поля Origin показывает часть модели, 
которая находится в центре экрана. Эта точка становится началом координат 
при любых вращениях трехмерного вида. Поля Theta и Phi в разделе View 
direction определяют позицию просмотра относительно модели, и изменение 
Model rotation вращает модель. Опция Zoom distance управляет размером 
модели на экране.  
 

 
Рис. 7.8. Страница просмотра модели в любом направлении 

     Кнопка Update view  нажимается для подстановки данных после 
изменения любой из переменных. 
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    Можно сделать запись изображения (Rec) и сохранить представления в 
нескольких направлениях. В окне появляется имя CameraN, которые можно 
выбрать, чтобы восстановить записанный вид. 
 

7.2.5. Страница требуемых полей  
 
     На странице Requested fields (рис. 7.9) устанавливаются опции вывода 
ближнего поля, дальнего поля, а также положение и ориентация приемных 
антенн. Эти три опции могут быть скрыты и показаны раздельно (используя 
соответствующие поля Visible) в списке, позволяющем выбор требуемых 
характеристик для каждого типа. 
 

 
Рис. 7.9. Страница требуемых полей 

 
   По умолчанию, ближние поля показываются желтыми маркерами  ‘+’ , а 
дальние поля зеленым маркером ‘x’ (Они называются Points в группах рис. 
7.9). Размеры этих маркеров управляются слайдерами внизу 
соответствующей группы, а цвет - кнопкой Set colour. Если выбрана опция 
Lines, требуемые точки соединяются линиями, а если выбрана Surface - 
поверхностями, заданными точками. Для расчета ближних полей 
используется только внешняя поверхность, когда выбраны Lines или  Surface. 
Точки дальнего поля показываются на окружности конечного радиуса, 
охватываемой модель. 
  Идеальные приемные антенны показываются в конкретных точках с тремя 
цветными осями, идущими в том же направлении, что и малые оси внизу 
страницы слева. 

7.2.6. Страница источников возбуждения  
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    Эта страница управляет всеми опциями, касающимися видом источников 
возбуждений в трехмерном представлении. Установки относятся ко всем 
источникам, которые являются активными, а поле Source облегчает выбор 
отдельных источников из набора. 

 
Рис. 7.10. Страница источников возбуждения 

 
    Номера источников идут последовательно. Если модель имеет четыре 
источника, и еще три источника добавлены для дальнейших вычислений - 
источники во втором наборе будут пронумерованы от 5 до 7, когда “All” 
выбрано в разделе Set, но они будут от 1 до 3 при только просмотре второго 
набора. Если один источник выбран, его величина и фаза отображена в двух 
полях ниже поля Source. 
   Для некоторых источников можно показать цвета, согласно их величине. 
Для этих случаев, также возможно поместить условные обозначения в любой 
из этих четырех углов. 
  Слайдер AI/AV/A5/A6 length (рис. 7.10) регулирует длину проводов токов и 
элементов вибратора. Если AI/AV уменьшить, намного проще отличить 
отдельные сегменты источника. 
 

7.2.7. Страница нагрузок  
 
    Если разделе Loads отмечено поле Visible, то показываются ребра и 
провода, на которые поставлены нагрузки (рис. 7.11).. Различные типы 
нагрузок могут быть показаны или скрыты отдельно (Заметим, что 
распределенные нагрузки показываются как дискретные нагрузки на каждом 
сегменте). 
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Рис. 7.11. Страница нагрузок 

       
     Нагрузки перечисляются в списке Load number в порядке создания в 
файле модели. Можно просмотреть все нагрузки, или выбрать и просмотреть 
по одной нагрузке. 
      Поля Visible,  относящиеся к Transmission lines и Cable paths 
используются для показа и скрытия линий передачи и кабельных линий (если 
задан расчет и анализ кабелей). 
 

7.2.8 Страница нахождения и выбора элементов  
 
     Нажмите Find/select elements, чтобы найти объект и расположить 
элементы с определенными номерами. В группе Options выбираются опции 
показа текущего выбора. Нажмите левой кнопкой мыши на любом элементе 
– включая геометрические элементы, источники, результаты, и т.д. - на 
трехмерном дисплее, чтобы выбрать их. Если отмечена опция Highlight, 
выбранные объекты будут отличаться цветом.   
     Если выбрана опция Show info, POSTFEKO показывает информацию о 
выбранных объектах – номера элементов, размеры, значение поля, и т.д. - в 
тексте на трехмерном представлении. Если отмечено Always on top, этот 
текст выводится сверху геометрии, иначе он может быть скрыт за 
геометрией. Текстовое поле связано с выбранным элементом стрелкой. 
Слайдер Line length управляет длиной этой стрелки и если отмечен режим 
All sides, описание элементов выводятся с нескольких сторон. Эти опции 
помогают видеть скрытые объекты. Выбор может быть снят, нажимая кнопку 
Clear. 
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Рис. 7.12. Страница поиска компонентов структуры при постпроцессорной 

обработки результатов расчета квадрифилярной антенны 
 
    POSTFEKO может показывать информацию о геометрическом элементе 
или его самой близкой вершины, когда пользователь нажимает на элемент. 
Средство управления является выбор соответствующего элемента в группе 
Locate Geometry. Раздел Locate Geometry используется для поиска элементов 
сетки с конкретными  номерами. Несколько значений отделяются запятыми и 
диапазонами с черточкой. Например, чтобы найти треугольник 6 и весь 
диапазон треугольников с номерами 13, 14, 15 и 16, нужно ввести 6, 13-16 в 
поле Triangles и нажать Search.  
    Если теперь в трехмерном виде нажать на дополнительные ячейки, они 
добавятся в списке. 
 

7.2.9. Страница информации о модели  
 
    Эта страница показывает информацию о модели. Опции  Extents включает 
операции просмотра дальнего поля, плоской волны и осей  (т.е. объектов, 
которые фактически простираются на бесконечность). Заметим, что просмотр 
можно включить так, чтобы источник был видим на сегменте, находящемся 
на границе. Увеличение радиуса провода до видимого приведет к 
увеличению размера конструкции. Поэтому желательно скрыть все 
источники и использовать линейный режим, чтобы показать ближние поля 
при использовании этой особенности. 
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Рис. 7.13. Страница информации о модели POSTFEKO 

 
     Число элементов каждого типа дает информацию о размере модели и 
требуемого времени решения. (Это также зависит от выбранного метода 
решения, числа частот и числа рассчитываемых характеристик.) 
    

7.2.10. Страница плоскости сечения  
 
    Сечение в плоскости Cutplanes используется, чтобы открыть или скрыть 
элементы геометрии и показать результаты на одной стороне плоскости 
сечения.  
   Это используется, когда нужно, например, открыть часть геометрии, чтобы 
видеть ближние поля внутри объекта. POSTFEKO поддерживает несколько 

секущих плоскостей. Кнопка  вверху панели добавляет новую плоскость 

сечения. Кнопка  удаляет текущую плоскость. Плоскость сечения можно 
снять, без удаления ее полностью, снимая галочку в поле Active. Кнопки 
Shaw all и Hide all устанавливает показ или снятие показа всех плоскостей 
сечения. 
    Плоскость сечения может лежать ортогонально к одной из осей 
прямоугольной системы координат или произвольного направления, 
указанного в терминах углов θ and ϕ  в этой строке. Слайдер управляет 
положением плоскости сечения по этим параметрам или строке. Если 
плоскость сечения используется для зеркального отражения (Flipped,), то 
геометрия с другой стороны плоскости сечения скрыта. Также возможно 
задать типы объектов, которые нужно разрезать. 
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Рис. 7.14. Страница плоскости сечения 

    
    POSTFEKO автоматически показывает расстояние между последними 
двумя выбранными объектами в строке состояния. Это может быть любой 
выбранный элемент, например рассчитанное ближнее поле, вершины 
элементов или любого типа элемента. Для некоторых объектов, например 
поля в дальней зоне, которые чертятся на произвольном радиусе снаружи 
модели, это число в общем случае не играет важной роли. 

7.3. Показ трехмерных характеристик 
 
    Можно рассмотреть результаты вместе с геометрией в трехмерном 
представлении. Если файл *.bof не загружен, POSTFEKO автоматически 
загрузит его. POSTFEKO также автоматически создает первый результат, 
когда нажата конкретная кнопка результата. Несколько характеристик 
выводится кнопкой Add  ниже поля file name. Заметим, что для токов и 
зарядов - которые отображены непосредственно на модели - только один 
результат может быть отображен одновременно. Каждый результат может 
быть удален снятием Visible или щелкая кнопку Remove. Режим Show all 
инициирует (а Hide all снимает) все поля на теку-щей странице. 

 
Рис. 7.15. Линейка добавления, удаления, скрытия и показа результатов 

 
   Вид изменяется немедленно, если что-нибудь изменено на панели 
управления. Кроме того, все результаты автоматически модифицируются 
каждый раз, когда FEKO запущен на решение. Если файл результатов 
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изменен таким способом, что он содержит другую структуру (другие 
частоты, дополнительные запросы характеристик, и т.д.), POSTFEKO 
выводит новые модифицированные данные.  
 

7.3.1. Выбор 3D результатов 
 
    Все страницы результатов содержит группу выбора результатов, 
показанную на рис. 7.16. Выберите соответствующую частоту из списка 
Frequency. Заметим, что новый ввод добавляется к этому списку каждый раз, 
когда меняются частоты расчета. Таким образом, если расчеты были 
выполнены на частотах 1 ГГц, 1.1 ГГц и снова на 1 ГГц, будут иметься три 
цифры в списке. Список Solution содержит вывод для каждого решения на 
данной частоте. Например, если решение вы-полнено с двумя наборами 
источников на данной частоте, будут иметься два выво-да в этом списке. 
Расчет параметра RCS с несколькими падающими плоскими волнами также 
приводят к нескольким решениям. 
 

 
 

Рис.  7.16. Выбор результатов в частотном диапазоне 
      
Последняя группа (Block no) перечисляет результаты, доступные для 
выбранной частоты и решения. Например, если модель имеет три запроса 
ближнего поля - или имеется карта FE в файле *.pre - будут иметься три 
вывода данных.   
   Поле Use continuous frequency возможно отметить, если файлы *.bof  
содержат адаптивные данные, или непрерывную интерполяцию. Тогда 
можно нажать кнопку Sampling,  чтобы задать интерполированные частоты, 
на которых должны быть выведены результаты. Интерполированные частоты 
могут быть в любой частотной точке диапазона, но на заданных выборках. 
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7.3.2. Общие установки 
 
    При выборе опции Instantaneous на любых этих страниц показываются 
результаты в виде функции ωt (в градусах). Для ωt =0 это - вещественная 
часть и для ωt =90  это – мнимая часть комплексной величины. 
    В режиме Instantaneous вид мгновенных значений токов и ближних полей 
управляется из группы Arrows, указывающие вектор в конкретной позиции в 
заданной величине ωt. которая зафиксирована в закладке Options токов и 
зарядов и отдельно в закладках Surfaces и Wires орто-секторов страницы 
ближнего поля. Отметьте Visible, чтобы показать стрелки. Если отмечено 
Fixed size, все стрелки чертятся с той же самой длиной (которая может 
изменяться слайдером Scale). Это использует показ стрелок в областях, где 
поля / токи очень малые. Обычно поле Colour также отмечается, для лучшей 
видимости стрелки согласно величина поля / ток. 

 
    POSTFEKO может показывать анимации результата как функцию ωt. Этот 
процесс управляется в разделе Animation, которая находится в закладке 
Options. Это только допускается для режима Instantaneous. Пользователь 
может определить приращение Increment (как ωt в градусах) и установить 
слайдер на желательный период обновления. 
    Все результаты могут быть отображены в линейном масштабе и в dB, что 
выбирается в группе Scale. Возможно прибавить смещение и масштабный 
множитель к данным. Это применяется после преобразования к dB. 
Например, прибавление смещения 60dB изменяет dBV на dBmV. (Заметим, 
что при использовании логарифмического масштаба, данные чертятся, 
используя смещение и масштаб.). Минимальные и максимальные значения, 
используемые в условных обозначениях видимости, даются в группе Scale.  
     Слайдеры Min и Max ограничивают диапазон значений результата. Если 
отмечено Manual limits, стержни слайдера заблокированы и требуют ввода 
значения. Если отмечено Normalised, значения нормализуются к самому 
большому значению в выбранном результате. 
    Надписи могут быть отображены для любой характеристики, от одного до 
четырех условных обозначений на дисплее. Если отображаются несколько 
результатов того же самого типа, отдельные условные обозначения могут 
использоваться для каждого результата.  
    Однако, становится трудно разделяться между ними. Поэтому 
рекомендуется использовать согласованные условные обозначения типов 
результатов и одинаковый масштаб для всех результатов. 
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7.3.3 Типы трехмерных результатов 3D result 
 

7.3.3.1 Страница токов и зарядов  
   
  На этой странице можно вывести токи и заряды на металлических формах. 
Для этого нужно выбрать опцию Currents and charges на главной странице 
(рис. 7.18). Можно выбрать электрические токи на металлических 
поверхностях и магнитные токи Magnetic currents, применимые только к 
диэлектрическим поверхностям, которые моделируются на основании 
теоремы эквивалентных поверхностей. 
 

 
Рис. 7.18. Вывод токов и зарядов на металлические поверхности 

квадрифилярной антенны 
 

7.3.3.2. Страница дальнего поля  
     В этой страницы (рис. 7.19) выводятся результаты расчета поля в дальней 
зоне в трехмерном представлении. При выводе значения поля на двумерный 
график, величины Quantity выводятся как составляющие дальнего поля в 
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зависимости от направления излучения. Характеристика в виде комплексного 
числа может иметь отрицательные реальные и мнимые части, модуль и фазу.  
    POSTFEKO также показывает величину осевого отношения Axial ratio, эта 
величина обычно вещественное число. Информация о знаке может быть 
получена, выводя Handedness. Знак отражается на сфере, в виде различных 
цветов для поля, имеющего левую поляризацию, линейного и с правой 
поляризацией. 

 
     Закладка Options управляет видом модели. Если опция Surface снята, ДН 
отображается только в виде линий. Эти линии, с другой стороны, могут быть 
скрыты, снимая опцию Mesh. Если отмечено Close, POSTFEKO стремится 
завершить ДН, связывая результаты с самым большим ис самыми малыми 
значениями ϕ. Размер ДН может изменяться слайдером Scale factor. 
Смещение Offset может использоваться изменение положения ДН 
относительно геометрии. Это используется, например, для показа ДН 
антенны, установленной на транспортном средстве (которая обычно не лежит 
в начале координат). 

 
Рис. 7.19. Рассчитываемые характеристики дальнего поля 

7.3.3.3. Вывод ближнего поля в сечениях  
 
    Ближние поля в сечениях отображаются, используя цвета, показывающие 
значения поля в каждой точки поверхности, на которой одна из трех 
координат остается постоянной.  
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Рис. 7.18. Вывод ближнего поля в секущей плоскости 

 
     Если расчетные результаты содержат трехмерные данные, пользователь 
может выбирать ориентацию секущей плоскости в группе Ortho-slice position 
и установить значение постоянной координаты z с помощью слайдера 
Position. 
   Например, в случае вывода данных в декартовых координат, выбирается (x, 
y), чтобы показать ближние поля в плоскости при постоянной координате z. 
   Если ползунок Extrusion (рис. 7.18) сдвинут от левого предела, вид 
ближнего поля деформируется со значением поля в направлении координаты 
единичного вектора, создавая искривленную вытянутую поверхность. Если 
поле отрицательно, орто-сектор деформируется во встречном направлении. 
     Когда выбраны E-field and Magnitude , POSTFEKO показывает модуль 
вектора всех выбранных Components. Например, если выбраны θ и ϕ  (сфери-
ческие координаты), то POSTFEKO вычисляет   

22
 EEE      (7.1). 
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    Если только одна компонента выбрана, POSTFEKO может показать её 
реальную, мнимую часть, или фазу. Комплексный вектор Пойнтинга рас-
считывается как 

 *Re
2
1 HES


     (7.2). 

 
     Если отмечена опция Instantaneous, рассчитывается действительная 
составляющая вектора поля и модуль выбранной компоненты. Например, для 
электрического поля 

 tjeEte  


Re)(    (7.3), 
 

)()()()( 222 tetetete zyx     (7.4). 
 
    Вектор мгновенного поля может быть показан как стрелка. Мгновенный 
вектор Пойнтинга рассчитывается как  
 

)()()( thtets 


    (7.5), 
 

который может быть больше, чем амплитуда комплексного вектора ( комп-
лексный вектор представляет усредненную по времени плотность мощности). 
    Величина удельной мощности поглощения (SAR) рассчитывается из выра-
жения 
 




2

2
1 E

SAR



      (7.6), 

где σ - проводимость, а ρ - плотность среды. 
   Закладка Options предоставляет некоторые опции управления: опция 
Smooth дает непрерывное распределение цвета, опция Flat - затенение, 
используя дискретные цвета. Если поле Number under Contours > 0, 
POSTFEKO показывает несколько контуров (линий с постоянными 
значениями) на орто-секторе. Дисплей может быть сделан прозрачным, 
отмечая Transparency. Опции  Lines  и Surface и Other используются для 
черчения оси и сетки на секторе вывода ближнего поля. Если отмечено 
Bounding box, POSTFEKO показывает, дополнительно, где может быть 
начерчен орто-сектор. 
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7.3.3.4. Страница ближнего поля в виде линий равного 

поля  
 
  Изо-поверхность ближнего поля Near field iso-surfaces соединяет все точки, 
где значение поля равно значению, указанному в слайдере. Заметим, что 
пределы масштаба управляют расширением (и следовательно 
чувствительностью) слайдера Iso-value. Значения различных Quantities - то 
же самое, как для ближнего поля орто-секторов выше.   
   В закладке Options можно установить видимость и проницаемость 
изоповерхности. Если отмечено Bounding box, POSTFEKO показывает 
расширение выбранного результата - изоповерхность может иметь грани на 
этой границе. 
 

7.3.3.5. Уровень поглощения мощности SAR 
 

    POSTFEKO может рассчитать и вывести уровень удельного 
поглощения (SAR), пропорциональный интенсивности ближнего поля, но в 
большинстве случаев может потребоваться его усредненное значение или 
максимальный SAR. FEKO выполняет такие расчеты, если задан расчет SAR 
в CADFEKO или используется карта SA в EDITFEKO. 
     Для вычисленного максимального значения SAR положение показывается 
в виде кубика в трехмерном представлении. Заметим, что он виден только в 
том случае, если геометрия прозрачна или срезана.  
 

7.3.3.6 Страница лучей UTD    
 
     В этой странице управляется видимость UTD лучей дифракции. Заметим, 
что лучи не заносятся по умолчанию в файл *.ray, поскольку файл *.ray 
может быстро стать очень большим. Их нужно явно задать в диалоге 
параметров настройки Solution в CADFEKO или карте UT в EDITFEKO. 
   Визуализация лучей UTD может быть очень информативна, чтобы видеть 
рассеяние СВЧ поля и точки отражения. Это может быть полезно для анализа 
развязки внутренней антенны, нарушение диаграммы направленности 
излучения и т.д., например радиоантенны на кораблях или антеннах 
мобильных телефонов на зданиях. 
    Опции для Ray lines, Ray group number, Ray numbers и Intersection point 
устанавливают параметры для отображения каждого луча. Закладка Selection 
используется для выбора конкретных лучей. 
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Траектории лучей, падающих на структуру Рис. 7. 19. Закладка выбора 

лучей 
 
Каждая группа лучей включает все лучи, которые начинаются и 
заканчиваются в той же самой точке. Опция Ray Type (рис. 7.20) 
ограничивает показ некоторыми типами лучей. Наконец Field type облегчает 
выбор лучей, полученных во время отдельных вычислений - это, например, 
делается, чтобы скрыть все лучи, рассчитанные при определении связи 
между областями MOM и UTD. Слайдер Far field crop может использоваться 
для ограничения поля в дальней зоне в пределах видимой геометрии. 
     POSTFEKO включает функциональные возможности, чтобы показать 
относительную величину вкладов из-за различных UTD лучей. 
 
       Выберите этот пункт, если задача FEKO решается при включении 
области UTD  — с опцией, чтобы сохранить файл лучей. В этом случае, 
загружаются данные в файле *.ray (см. карту UT) и активизируется панель 
Ray display options. Данные лучей отображены на геометрии модели. 
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Отражение; дифракция от угла; сгибающие 
(поверхностные) волны; дифракция не ребре/клине  

Ближнее электрическое, ближнее магнитное, 
дальнее, MOM и FE, включая совместный расчет 

Рис. 7. 20. Выбор типов лучей в методе UTD 
 
Замечание 1. Файл лучей может быстро стать очень большой, что может 
очень долго загружать лучи. Если больше, чем 4000 линий луча находятся в 
файле *.ray, появляется предупреждение. Выберите Yes, чтобы продолжить 
загружать все данные лучей и No, чтобы отобразить только первые 4000 
лучей и игнорировать остальную часть данных в файле *.ray. 
 
Замечание 2.  Выберите или снимите выбор параметра Display ray file info, 
для показа информации файла *.ray. Нажмите кнопку Clear ray file, чтобы 
очистить память (и связанные данные), распределенную для файла луча. 
Под Visibility (Видимостью) выбирают информацию луча, которая должна 
быть отображена. 
     Можно выбрать тип лучей, чтобы показать и определить максимальное 
число отражений в группе Ray Tipe. Если, например, снять опцию Corner 
diffraction (дифракция на углу), такие лучи не будут отображены. Заметьте, 
что дифракция только относится к одной дифракции, и лучи будут все еще 
показываться, если не отмечено поле Double diffraction (двойная дифракция). 
Лучи с большим, чем заданное число отражений, не будут показываться. 
    Каждая группа лучей включает все лучи, которые начинаются и 
заканчиваются в той же самой точке. Параметры Selection могут 
использоваться, чтобы отобразить индивидуальные группы лучей Ray type. 
Отметьте поле Ray groups, чтобы отобразить только группу с числом лучей, 
выбранным из раскрывающегося списка. Если группа Ray не отмечена, все 
лучи отображены одновременно — это может требовать очень большое 
время выполнения. Поля числа лучей может использоваться, чтобы 
рассмотреть лучи в группе, один за другим. Планка Far field crop может 
использоваться, чтобы ограничить дальнее поле, указанное в пределах вида 
геометрии. 
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    Данные луча также рассматриваются, при вычислении свойств модели 
(используемых для нормализации модели). Это могло таким образом быть 
необходимо заново нормализовать вид геометрии модели, после очистки 
файла информации о луче. 
 

7.4. Вывод двумерных графиков 
 
    Вывод в виде трехмерного графика дают ясный вид и понимание, но 
двумерные графики даются возможность количественного сравнения 
данных.  Во-первых, данные от различных моделей могут быть начерчены на 
одном графике. На  двумерном графике данные относятся только к отдельной 
строке данных, названных одиночной серией.   
      Во-вторых, POSTFEKO может модифицировать график или копировать 
значения, когда результирующий файл (*.bof) изменяется. 
   Новые двумерные графики созданы в двумерной части основной инстру-
ментальной панели, показанной на рис. 7.21. 
     Это допускается, если по крайней мере один файл *.bof загружен. Каждый 
пункт создает удельный тип графика, и может быть не возможно чертить 
различные характеристики (поле в дальней зоне, S параметры, и т.д.) на той 
же самой диаграмме. Если файл результата не содержит никаких данных 
выбранного типа, в окне отображается «No data». 
  

 
Рис. 7.21. 2D часть главной инструментальной линейки 

 
Аналогично панели управления видимости модели, панель двумерных 
графиков содержит некоторое число страниц, на которые выводятся 
последовательно графики характеристик. 

     Страница Series data управляется данными для каждой серии 
(рис.7.22). Эта панель отличается для каждого типа чертежа результата, но 
всегда имеет инструментальную панель управления серии наверху, где 
показан тип результата, и область страницы для каждой серии. Поле File 
name сверху каждой из этой серии страницы применяет только к этой серии. 
     Двумерные графики автоматически приводятся к удобным единицам, 
например график, идущий между 2 x 1011 и 4 x 1011 Герц, отображается 
между 200 и 400 GHz. 
    Заметим, что заголовки графика, надписи оси и условные обозначения 
серии каждый используют флажок Automatic update. Если он отмечен, 
POSTFEKO подставляет правильный текст в связанном поле. (Это 
определено от селекций на панели управления.) Если текстовое поле 
изменено (это случается нажатием в поле, или нажатием < Enter > при 
набирании поля), поле модификации автоматически. Для комплексных 
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данных, пользователь может выбирать между Real, Imag, Мag или Phase (в 
градусах) в группе Part. Опция Unwrap phase используется только для 
расчета фазы. Если она отмечена, POSTFEKO избегает переходы на 360?, 
прибавляя фазы, кратные 360?. 
 

7.4.1. Линейка последовательных данных 
 
   Эта линейка предназначена для вывода на график нескольких 
характеристик, в том числе с использованием алгебраических действий 
между ними. 

 
Рис. 7.22. Инструментальная линейка последовательного управления 

Кнопки реализуют следующие действия: 
1. Кнопка Delete the current series удалит текущую серию из диаграммы.  
2. Кнопка New series добавляет новую серию данных на график. Это нужно 
использовать только в том случае, если все серии на текущем графике были 
преобразованы к новой серии. 
3. Кнопка Copy series копирует текущую серию. Это будет идентично 
созданию новой серии, и затем изменение всех параметров настройки серии, 
чтобы быть тем же самый как текущая серия, но эта опция предпочтена, 
поскольку это поддерживает параметры настройки типа независимой 
переменной. 
4. Copy to value series создает новую серию значения по серии текущих 
данных. Это копирует первоначальные данные и любое смещение или 
масштабный коэффициент  
5. Convert to value series преобразует текущую серию к серии значения. Эта 
кнопка преобразует первоначальные данные, и так это та же самая серия – 
можно выполнить смещение и масштабирование данных. График поэтому 
остается неизменным, но серия больше не зависит от файла результата и 
больше не могут изменяться на панели Series settings. 
 6. Perform calculations on series открывает диалог, когда можно выполнить 
дополнительный расчет между сериями данных. Правила те же самые, как 
при использовании переменных в EDITFEKO. Например, чтобы 
просуммировать две серии данных, запишем #series 1 + #series 2. (Заметим, 
что #-character перед названием серии как дается в закладке на панели 
управления). Результат этого вычисления сохраняется как серия значений. 
Если отмечено Limit operations to the common region, вычисление только 
выполнено в области, где вся серия имеет значения (между значениями 
выполняется интерполяция). Если не отмечено, принимается значение 0 там, 
где серия используется вне этого диапазона. Если эта операция была 
выполнена на непрерывных данных, то рекомендуется использовать то же 
самое фиксированное число выборок для каждой серии. Так как непрерывная 
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интерполяция серии вообще приводит к различным элементам выборки для 
каждой серии, использование этой серии без фиксации и интервалов 
интерполяции приведет к большому количеству элементов выборки для 
операции серии. 
7. Rename series открывает диалог для изменения имени серии данных. 

7.4.2. Страница установки последовательности данных  
 
   Эта страница (рис. 7.24) управляет видом, условными обозначениями и 
масштабными множителями каждой серии. Основной список использует 
маркер, толщиной и типом линии. Доступные цвета могут быть 
сконфигурированы из меню Options. 
    Если поле в начале строки отмечено, серия чертится на графике. Снятие 
галочки удаляет его из графика без снятия параметров настройки. 

 
Рис. 7.24. Установка параметров последовательной серии 

 
        Группа Series settings содержит дополнительные свойства для каждой 
серии. Это только допускается, если в списке выбрана одна серия. Легенды 
для серии могут быть автоматически модифицированы или указаны вручную. 
Если серия содержит большое количество знаков - символов, маркеры могут 
накладываться, и рекомендуется увеличить значение Marker every . . . 
points. Увеличение Line thickness также увеличивает и толщину маркера. 
   Может случиться, что пользователь должен сравнить результаты с 
импортированными данными, которые не используют те же самые единицы, 
как текущий график. POSTFEKO позволяет прибавлять смещение Offset  и 
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масштаб Scale  к данным также как независимая  переменная (который 
используется по нижней оси) каждой серии. Они применены к данным как 
начерчено, после любого dB преобразования. Если график - диаграмма 
Смита, можно добавить только Phase (в градусах), изменяя референсное 
положение. (Заметим, однако, что опорная фаза остается постоянной с 
частотой.) 
 

 
Рис.  7.23. Диалог подстановки графиков по данным файла. 

 
   После нажатия на кнопку Serialise (рис. 7.23), получаем данные в виде 
таблицы 
 

7.4.3. Выбор цветов серий 
 
     Список доступных цветов может быть установлен, выбирая Option → 
Graph series colour  из основного меню POSTFEKO. Пользователь может 
добавить и удалить цвета, как требуется. Цвет может быть изменен двойным 
нажатием на нем в списке цветов и выбором в диалоге Select colour. 
    Изменение этой опции не изменяет никаких существующих графиков, но 
заносится в файл инициализации POSTFEKO. Это применяет ко всем новым 
графикам, открытым на этом компьютере, включая открытие существующие 
сеансы. Это подразумевает, что сохраненный сеанс может использовать 
различные цвета на различных компьютерах. Первоначальные цвета на всех 
системах могут быть восстановлены, нажимая Restore defaults. 
 

7.4.4 . Страница опций графика  
 
    Эта страница управляет глобальными параметрами графика. График может 
быть нанесен в декартовой, полярной системе координат или на диаграмме 
Смита. Для полярных графиков, перевод графика в Vertical сдвигает его 
положение до 0, а если отметить Mirror , то выполнятся вращение по часовой 
стрелке, а не против часовой стрелки. Условные обозначения могут быть 
помещены на любую из четырех сторон, выбирая соответствующую опцию в 
разделе Legend. Это может также быть скрыто, снимая опцию Visible. 
     Пользователь может управлять именем шрифта и сортировать по величине 
для заголовка графика, нижнего колонтитула и условных обозначений. 
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Заголовок и нижний колонтитул могут быть автоматически модифицированы 
или указанный вручную. 

 
Рис. 7.24. Установки графика 

 
     Если опция Visible не отмечена, график отображается в черно-белом. Цвет 
фона может быть изменен, выбирая Option -> Graph background colour. Эта 
опция сохранена в POSTFEKO файле инициализации и применяется ко всем 
открытым и новым графикам на компьютере. 
 

7.4.5. Страница левой оси  
 
     Эта кнопка открывает страницу управления пределами, масштабом и над-
писями на левой оси. Единицы установлены POSTFEKO в зависимости от 
диапазона значения данных, но могут быть изменены. Если Autoscale не 
отмечен, пользователь может вручную установить минимум, максимум, 
число делений и точность, используемые для оси (поле Digits в группе Value 
labels). Данные могут быть начерчены на вставке, в логарифмическом или dB 
масштабе и могут быть нормализованы в серию или в диаграмму. Надпись 
оси может быть автоматически модифицирована или указана вручную. 
 Если опция Add unit не отмечена, то к величинам не будут прибавляться 
единицы - пользователь может ввести их самостоятельно. Базовые единицы  
определены POSTFEKO в зависимости от данных графика.  
 

7.4.6. Страница нижней оси  
     
     Страница Bottom axis setting управляет размером, масштабом и надписью 
на нижней оси, и очень похожа на страницу левой оси, но нижняя ось не 
может быть нормализована, и невозможно использовать масштаб dB на этой 
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оси. Величины на нижней оси - например частота – обычно не выражаются в 
dB. Шкала Log, однако, возможна. Это обычно используется для очень 
широких диапазонов частот. 

 
Рис. 7.25. Опции нижней оси 

 
    Начиная со значений, используемых, когда независимые переменные 
обычно не выражены как отношения, нижняя ось также не позволяет 
черчение в dB. Значения могут, однако, иметь очень большой диапазон (типа 
частотного анализа от нескольких кГц до нескольких сотен МГц). Такие 
переменные можно вывести в логарифмическом масштабе.  

7.4.7. Изменение размеров графика  
 
     После расчета часто нужно выделить часть графика, в области, близкой к 
резонансу. POSTFEKO позволяет выделить конкретную часть графика 
(изменение масштаба изображения не поддержано для полярных графиков, и 
для диаграммы Смита). Чтобы расширить область, нажмите кнопку Zoom box 
слева панели управления, и переместите мышь в требуемое положение. 
(Альтернативно, удерживайте < Shift> и перемещайте курсор). Во время 
перемещения мыши, красный пунктир указывает область, которая будет 
расширена, как только кнопка мыши отпущена. 
    Перемещать график можно при удерживании <Ctrl>. Это особенно полезно 
одновременно с изменением масштаба изображения. 
  После раскрытия на графике новая кнопка Reset zoom/pan показывается 
ниже кнопки Zoom box. Нажмите ее, чтобы вернуться к исходному виду. 
    Заметим, что при автомасштабирование для оси допускается, параметры 
наст-ройки корректируются при изменении масштаба изображения 
(например, количество меток может быть увеличено). Когда выключено 
автомасштабирование, это не выполняется автоматически, но может быть 
сделано вручную. Может быть нужно увеличить точность меток. Это 
выполняется в панели параметров настройки оси. 
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7.4.8. Выбор 2D результатов 
 
    Страница двухмерных графиков содержит те же самые группы 
(показанные на рис. 7.7), как и страницы с трехмерными результатами. 
Двумерные результаты могут быть начерчены как функция частоты, номера 
решения и номера блока. Следовательно, несколько характеристик могут 
быть выбраны из всех трех списков, но возможно только выбрать несколько 
характеристик в одном блоке. Если есть независимая переменная (а список 
содержит несколько характеристик), то можно вывести график зависимости 
от этой переменной. 
     Если список не имеет несколько выбранных вводов, независимая 
переменная по умолчанию является переменной положения или угла. Если 
график содержит параллельно-последовательное соединение, выбор должен 
быть сделан так, чтобы они имели ту же самую независимую переменную. 
Если несколько вводов выбраны в любом из списков результата, самый 
большой знаменатель дроби входов используется в остающихся списках. 
Например, если FEKO рассчитал входной импеданс в диапазоне частот, и 
ближнее поле на одной частоте, то можно выбрать все частоты, 
перечисленные в третьем блоке, даже при том, что они рассчитаны только на 
одной частоте. Отсутствующие вводы только что игнорируются при чертеже. 
Заметим, что расчет эффективной площади рассеяния RCS ведет себя по-
другому.  
    Источники, отдельные блоки нагрузки, кабели, линии передачи и запросы 
решений теперь имеют названия, используемые в CADFEKO (или 
определенный комментариями после карты '**', если пользователь редак-
тирует файл *.pre). Эти названия отображены как подсказка, если мышь 
зависает над окном в группе выбора. 
 

7.4.9. Непрерывные (адаптивные) частотные выборки 
 
       Опция вывода в диапазоне частот Use continuous frequency допускается, 
если файл *.bof содержит адаптивные (непрерывные) данные. В двумерном 
случае, устанавливается независимая переменная частота. Однако можно 
нажать Sampling, отметить Single frequency и задать одну частоту. Это 
позволяет чертить результаты на конкретной частоте относительно другой 
переменной.  
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Рис. 7.26. Спецификация частотных параметров 

 
Если отмечена опция Automatically determine sampling depth в диалоге Specify 
sampling (рис. 7.26), FEKO задает фиксированное число частотных выборок. 
Таким образом возможно интерполировать результат в ряде дискретных 
частот. 
 

7.4.10. Графики токов и зарядов 
 
     POSTFEKO может вывести двумерные графики распределения токов или 
зарядов по сегментам (ток  на поверхности не может быть отображен на 
двумерном графике). Когда выбрана одна частота и решение, можно выбрать 
несколько сегментов. Имеется опция, чтобы начертить графики токов 
относительно номера сегмента или по координатам x, y или z сегментов, 
выбранных в Independent variable. 
      При выводе графика как функции частоты или решения, должен быть 
выбран конкретный элемент. 

 
Рис. 7.27. Зависимость тока в сегменте 3 в диапазоне частот 

 



 204 

      Выбирая набор установок под Label, можно значительно уменьшить 
число вводов в разделе Segment, упрощая нахождение правильного 
сегмента. 
    Заметим, что для токов и зарядов, могут только быть получе-ны несколько 
блоков, если несколько карт OS используется в EDITFEKO. Когда тот же 
самый сегмент включен в несколько блоков (для той же самой частоты и 
решения) это будет иметь то же самое значение в каждом блоке. 
 

 
Рис. 7.28. Страница токов и зарядов 

 

7.4.11. Графики характеристик в цепи источника 
 
     Для каждого источника, в POSTFEKO можно вывести импеданс, 
адмитанс, входное напряжение Input voltage (для генераторов напряжения, 
это напряжение постоянное, если пользователь не масштабировал входную 
мощность), ток, S11, КСВ, мощность источника (мощность, поставленная 
источником, включая возможные потери на рассогласование) или потери на 
рассогласование (что применяется только в том случае, если мощность 
масштабировалась, чтобы учесть рассогласование).   
   Активная мощность Active power  (полная мощность, снабженная 
источниками), потери мощности (все потери типа скин-эффекта, потери в 
диэлектриках, на рассогласование, и т.д.) и КПД применяется ко всем 
источникам вместе. 
     При расчете импеданса и адмитанса, а также S11 и VSWR, из расчета 
можно исключить произвольную нагрузку, если отметить поле Subtract 
loading (это требуется, например, когда пользователь нагрузил порт, чтобы 
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моделировать импедансы передатчика / приемника, и нагрузка была 
определена как Impedance или Admittance).  
     Если источник - генератор напряжения, нагрузка вычитается, как будто 
она расположена последовательно с источником; а для источника тока она 
вычитается, как будто она находится параллельно с источником. Опорный 
импеданс (Reference ) Zo используется (независимо для каждой серии) при 
графике полного сопротивления или полной проводимости на диаграмме 
Смита. Это значение также используется, чтобы рассчитать S11 и КСВ: 
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   Если отмечено Subtract loading , Zin представляет входной импеданс после 
вычитания нагрузки. 
  

 
Рис. 7.29.  Реальная часть входного импеданса антенны 

    
   Если источник один, частота и решение выбраны, выбранная характерис-
тика Quantity также показывается в текстовом поле внизу графика. 
     Когда выбран расчет S параметров, POSTFEKO загружает S-параметры, 
аналогично запросу карты SP и открывает панель Antenna S-parameters. 
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    Различные частоты, на которых решение FEKO было получено, 
отображены в поле Frequency. Поле Card nr перечисляет карты SP для 
каждой частоты.  
   Нажмите одну частоту, или выберите весь диапазон частот. Если диапазон 
частот имеет не то же самое частот, как и выбранное в карте SP, то 
оставшиеся частоты не выбираются. 
    Если больше чем одна карта SP используются для каждой частоты, 
пользователь может также составлять график результатов как функцию 
номера карты. (В этом случае только одна частота может быть выбрана.). 
Полезно составить график S-параметров как функцию других параметров в 
файле *.pre, например от сопротивления нагрузки. 
    В разделе Scale  можно выбрать линейную или логарифмическую шкалу 
(чтобы использовать логарифмическую шкалу, параметр должен быть 
больше 0). 
    Поле Subtract Z load исключает полное сопротивление, которое 
используется для расчета S11 и S21. Например, требуется расчет S21, а порты 
источника и нагрузки состоят из 2-х сегментов. Если это так, нужно отметить 
опцию Subtract Z load. Если порты не нагружены, эта опция должна быть 
оставлена без отметки, но тогда графики S21 не возможны. 
     Поле Quantity позволяет вывести следующие параметры: 
 
• S11 — коэффициент отражения S11 в системе Z0.  S11 рассчитывается для 
ис-точника, выбранного под номером источника, и принимается, что только 
один источник активен. 
 
• S21 — коэффициент передачи S 21 в системе Z0.  При расчете S21 
вычисление в двухантенной системе с линией питания Z0, сегмент питания 
каждой антенны должен быть нагружен на Z0  — тогда должно быть 
отмечено поле Subtract Z load. S21 рассчитывается по формуле 

in
o V

IZS 2
21 2 ,    (7.9), 

 
где Vin   напряжение, приложенное к передающей антенне и I2 - ток на 
приемной антенне (с нагрузкой Z0) сегмент как рассчитано FEKO. 
    S21 рассчитан для передающей антенны, сегмент питания которой выбран в 
номере источника внизу окна списка, и приемная антенна, приложенная на 
сегмент, выбранный в окне списка Segments в разделе Selection. Больше чем 
один сегмент в окне списка Segments может быть выбран для составления 
графика на той же самой диаграмме. Абсолютные числа сегмента 
перечислены, и пользователь должен гарантировать, что выбрано верное 
число сегментов, отмечая номер сегмента в CADFEKO. 
  Графики S-параметров задаются в CADFEKO, или с помощью карты SP в 
EDITFEKO.  
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Рис. 7.30. Реальная и мнимая часть входного импеданса, представленные в 
виде таблицы 

7.4.12. Графики мощности 
 
       Эти графики Active power, Loss power и Efficiency (КПД) характеризуют 
работу источника. Это требуется, чтобы показать мощность, принятую 
изотропной антенной или когда модель только содержит источники (типа 
точечных источников) для которого график данных источника не доступен. 
     График данных мощности также показывает результат расчета идеальной 
приемной антенны. Он может быть задан как характеристика в CADFEKO 
или с помощью карты RA в EDITFEKO.  
    POSTFEKO может начертить график зависимости Voltage, Current, 
входного Impedance и входной  мощности Power на каждом порту линии 
передачи и пути анализа кабеля. При анализе кабеля это применяется для 
получения переходного импеданса, т.е. импеданса между двумя отрезками 
кабеля. Если имеет место нумерация портов, то можно видеть файл *.out, в 
котором общая информация по каждому пути кабеля перечисляется вдоль 
числа портов, используя каждый порт. 
 

7.4.13. График дальнего поля 
 
     Для полей в дальней зоне группа Quantity включает электрическое поле и 
осевое отношение Axial Ratio. Если модель не содержит никакие 
возбуждения плоской волны, также возможно вывести  направленность D и 
усиление G. Если это содержит одиночное плоское возбуждение (по одному), 
возможно вывести эффективную площадь рассеяния RCS (радиолокационное 
поперечное сечение). Заметим, что в электрическом поле в дальней зоне, 
коэффициент 
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e−jkr / r    (7.10) 
 
не учитывается. Здесь r - расстояние, которое стремится к бесконечности и k 
–постоянная распространения волны. Электрическое поле в дальней зоне 
выводится в Вольтах. 
    Эффективная площадь рассеяния RCS для каждого направления падающей 
волны имеет разное решение. Поэтому нужно выбрать соответствующие 
решения для нужной модели. Если числа решения не известны, самый 
простой метод найти правильные решение состоит в том, чтобы выбирать их 
один за другим, принимая во внимание углы, отображенные в группе 
Independent variable.  
     Поле Part только допускается для вертикальной и горизонтальной  
составляющих электрического поля. Все другие характеристики, кроме 
осевого отношения, всегда чертятся как модуль. Осевое отношение, 
выводимое на линейный график – отрицательное для левой поляризации. На 
чертежах в dB, знак игнорируется. 
 
 

 
Рис. 7.30.  Двумерный график осевого отношения 

     
   Если выбрана одна частота, решение и блок (или запрос), поле в дальней 
зоне чертится как функция или θ  или ϕ. Если расчеты содержат двумерные 
данные (больше чем одно значение для каждого угла), конкретная величина 
может быть выбрана для зависимой переменной в списке ниже угла. Если 
установлена опция Wrap, POSTFEKO будет пытаться чертить 360o сечение, 
используя тот факт, что направление (θ, ϕ) тоже самое, как при (-θ, ϕ+180◦). 
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7.4.14. Поляризация 

 
     Имеются несколько опций дальнего поля, относящиеся к поляризации, 
причем их названия следующие: 
• Total: Общая величина, независимая от поляризации. 
• Vertical: Вертикальная (или θ) компонента дальнего поля. 
• Horizontal: Горизонтальная (или ϕ) компонента дальнего поля. 
• LHC: компонента с левой круговой поляризацией. Вектор поляризации вра-
щается против часовой стрелки, когда просматривается от фиксированной 
точки, в направлении поляризации. 
• RHC: правосторонняя компонента круговой поляризации. Этот вектор 
поляризации вращается по часовой стрелке, как видно с фиксированной 
точки в направление распространении. 
 
• Z (+45 deg): Когда выполняется просмотр в направлении распространения, 
точки единичного вектора θ  загружается и единичный вектор ϕ направлен 
влево. Единичный вектор Z-поляризации равен тогда 
 

2/)(  eeez


 ,    (7.11), 
 
который лежит вдоль оси вращения на  +45? от горизонтали (в контуре в нап-
равлении по часовой стрелке — в соответствии с направлением линии оси Z. 
 
• S -поляризация (-45 deg): Единичный вектор S-поляризации равен 
 

2/)(  eeeS


 ,    (7.12), 
 
который вращается на угол -45 ? от горизонтали и лежит в направлении 
диагонали S. 

 
Рис. 7.31. Поляризация рассматривается из фиксированной точки в 
направление распространения электромагнитной волны 
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7.4.15. Графики ближнего поля 
 
    Ближнее поле Quantities включает электрические и магнитные поля, вектор 
Пойнтинга Poynting 

 *Re
2
1 HES


     (7.13) 

 
а удельная мощность поглощения (SAR) 




2

2
1 E

SAR



      (7.14), 

где σ -проводимость и ρ - плотность материала. 

 
Рис. 7.32. Электромагнитное поле, рассчитываемое в неоднородной 

биологической среде, для расчета параметра SAR 
 
     Если выбраны одна частота, решение и Block no (или запрос), ближнее 
поле чертится как функция положения. Пользователь должен выбрать 
независимую переменную и конкретные величины из двух списков после 
названий координат. 
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Рис. 7.33.Страница относительной мощности поглощения 

 

7.4.16. Описание в видеValue series 
 
     Группа Value series – это серия данных, в которой записываются его 
собственные значения, а не результирующие данные, в файл. Серия 
сохраняется как серия чисел, и не обязательно касается любого конкретного 
типа данных. Напротив, когда данные читаются из файла  *.bof, POSTFEKO 
может устанавливать тип данных. 
    Можно преобразовать серию к серии значения, когда целостность данных 
в файле *.bof не обеспечена - например, пользователь может сохранить 
график входного полного сопротивления антенны в диапазоне частот для 
нескольких вариантов антенной конструкции. Та же самая модель 
используется для каждого варианта конструкции. В таком случае, входное 
полное сопротивление начерчено и преобразовано в серию значения прежде, 
чем изменяется файл *.pre, и задача заново моделируется. 

 
Рис.7. 34.  Диалог модификации графиков данных 

 
   В трехмерном представлении все результаты модифицируются немедленно, 
если результат изменяется. Для двумерного графика, однако, появляется 



 212 

запрос, перезагружать или преобразовать данные в последовательную форму. 
Если серия преобразуется в последовательную форму, она преобразуется к 
серии значений, которые больше не зависят от файла результатов. Это также 
подразумевает, что серия не может изменяться, по сравнению с 
первоначальным результатом. Можно, например, переключить dB к linear, 
если требуется вывод величины токов, но не возможно переключаться между 
электрическими и магнитными полями. Панель управления, которая 
ссылается на файл результата, тогда заменяется таблицей значений данных.   
    Если выбрана опция модификации, POSTFEKO загрузит новую информа-
цию из файла *.bof и модифицирует график. 
 

7.4.17. Загрузка и сохранение данных построчно 
 
    POSTFEKO сохраняет все характеристики и параметры настройки в файле 
сеанса. Это означает, что конкретно графики или изображения явно не 
сохраняются. Все, что POSTFEKO требует, чтобы воспроизвести все 
результаты - файлы *.fek, *.bof и *.pfs,. В некоторых случаях может быть 
желательно экспортировать данные. Выберите File → Export → Data. Эта 
опция экспортирует двумерное представление в текстовый файл, который 
может читаться внешними программами, типа MATLAB. Заметим, что 
экспортируются необработанные данные (без масштабных множителей или 
смещений). Если требуется сохранить масштабируемые данные, нужно 
делать вычисление серии и затем экспортировать получающуюся серию 
значения. 
     POSTFEKO может также читать данные в этом формате, используя File → 
Import → Data. POSTFEKO делает запрос, если данные были импортирова-
ны в новый или существующий график. 
     POSTFEKO также делает запрос переводного множителя dB для данных 
(20 для величин поля и 10 для величины мощности) и если данные в dB. 
    Данные должны быть в столбцах, отделенных одним или большим числом 
пробелов. Данные во втором и последующих столбцах чертятся против 
первого столбца. Таблица ниже показывает текстовый файл, с данными для 
двух строк, готовых к импорту в POSTFEKO. Первая строка состоит из 
нижней надписи оси (связанной с первым столбцом), сопровождаемой 
условными обозначениями для каждого из остающихся столбцов данных. 
Заметим, что надписи должны быть в первой строке и каждая надпись в 
кавычках. Если никакая строка надписей не присутствует, POSTFEKO будет 
все еще импортировать данные (первый столбец дает позицию на нижней 
оси, последующие столбцы - на левой оси).  
     Если есть в наличии (столбец данных не имеет того же самого числа вхо-
дов, как первый столбец) пустые знаки – символы, они представляются текс-
том NAN:  

"Frequency [MHz]" "mag{S_11}" "mag{S_21}" 
 

1.00000E+02  -4.74462E-01  -2.83472E+01 
2.00000E+02  -1.46055E+00  2.66604E+01 
3.00000E+02  -7.46769E+00  2.06073E+01 
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4.00000E+02  -2.19462E+00  NAN 
5.00000E+02  -6.12814E+00  NAN 

 
   Для черчения диаграммы Смита, первый столбец должен содержать фазу (в 
градусах), а следующий столбец - модуль. 
 

7.4.18. Графики POSTFEKO *.pfg и экспорт графиков 
 
     Любой двумерный график может быть сохранена в графике *.pfg. 
Заметим, что это - кадр графика в момент сохранения. Файл *.pfg сохраняет 
данные в виде графика, а не исходные данные в соответствующем файле 
*.bof. Если график изменяется впоследствии, команда Save сохранит 
изменяемый график как часть сеанса; график *.pfg не изменяется, если он 
явно не сохранен снова. Наконец, нужно отметить, что загрузка отдельных 
нагрузок графика *.pfg - это активный сеанс. Файл *.pfg может только быть 
модифицирован, явно снова экспортируя график. 
     При экспорте графика в dB, принимается логарифмическое 
преобразование по мощности. График dB в POSTFEKO будет корректным, 
но если он переходит в линейный масштаб. Это происходит вследствие того, 
что GraphFEKO не сохраняет эту информацию - так как он не выполняет 
преобразования linear/dB, когда только график создан. 

 
7.5. Экспорт изображений 3D / 2D 

 
     Для экспорта текущего вида в файл изображения используется команда 
File → Export → Image. В настоящее время поддерживаются форматы  BMP, 
JPG, PNG, XPM и EPS. Файлы EPS основаны на векторе, для вида 3D это 
эффективно использует растровый экран. Важно убедиться в том, что весь 
дисплей видим при экспорте этих данных в виде изображения. Если другое 
окно перекрывает часть изображений, это также накроет экспортируемое 
изображение. File → Export → Image to clipboard экспортирует текущее 
изображение к буферу обмена. 
    Можно экспортировать анимированый (AVI) файл из трехмерного 
представления. Заметим, что это использует операцию Animation Increment 
для каждого результата. Если указанные приращения ωt любых результатов 
отличаются, POSTFEKO последовательно циклически меняет окна. Поэтому 
приращение для всех результатов должно быть тем же самым. Также важно 
использовать физические пределы в разделе Scale, иначе POSTFEKO 
использует автоматическое масштабирование, которое будет отлично для 
каждого шага. Только результаты, для которых выбрана опция 
Instantaneous, анимированы в AVI файле. Важно не запускать анимацию,  
при экспорте AVI файла, чтобы ничто не затеняло окно POSTFEKO во время 
генерирования  файла AVI. 
 

7.6. Быстрые клавиши 
<F1> Кoнтекстно- чувствительная помощь для диалога, который 
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находится на столе. 
<Ctrl><Ins> Копирование выбранного текста. 
<Shift><Del> Вырезать выбранный текст. 
<Ctrl><C> Копирование выбранного текста. 
<Ctrl><M> Загрузка новой модели *.fek. 
<Ctrl><N> Создание новой сессии. 
<Ctrl><O>   Открытие сессии. 
<Ctrl><P> Печать текущего окна. 
<Ctrl><Q> Завершение работы POSTFEKO 
<Ctrl><R> Загрузка нового файла результатов *.bof 
<Ctrl><S> Сохранение сессии 
<Ctrl><V> Добавление нового 3D вида 
<Ctrl><B> Переключение между видимостью базы данных 
<Ctrl><P> Переключение между функциями контрольной панели 
<Ctrl><T> Переключение между видимостью 3D инструментальной 

панели 
 

7.7. Просмотр выходного файла 
 
   Текстовый файл *.out имеет обычный текстовый формат. Это - 
единственное место, где можно видеть текст предупреждений и сообщений 
об ошибках. Файл *.out отображается, щелкая кнопку View the *.out file на 
основной инструментальной панели. Можно искать конкретную фразу в 
файле, вводя ее в поле Phrase и нажимая Search. Выбор слова в 
раскрывающемся списке Keyword слова вводит фразу, связанную с этим 
ключевым словом.  Если только одна модель загружена или в трехмерное 
окно (которое показывает одну модель) то открывается файл *.out связанной 
модели. Иначе POSTFEKO сделает запрос относительно модели. Заметим, 
что файл *.out, посланный на печать, не модифицируется автоматически, 
когда файл *.out изменяется. Редактор нужно закрыть и открыть снова, 
чтобы модифицировать этот файл. 
 

8. Редакторы EDITFEKO и PREFEKO 
 
     
   Первоначально программа FEKO формировала задачу в виде набора 
перфокарт. Этот профессиональный подход, широко развитый в 70-е – 90-е 
годы 20 века, позволил компании EMSS решить ряд важных научных задач. 
Не все узкоспециализированные модели переведены сейчас в интерфейс 
CADFEKO. Поэтому самые сложные задачи можно решить, привлекая (рис. 
8.1) программы EDITFEKO и PREFEKO, которым посвящен данный раздел. 
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Рис. 8.1. Структура FEKO и состав подпрограмм 
 
       Программа PREFEKO создает и обрабатывает файл с расширением *.pre 
–стандартный текстовый файл ASCII, который может быть создан в любом 
текстовом редакторе. Геометрия модели и установки на расчет вводятся в 
линии текста, в виде карт. Каждая карта может иметь ряд параметров. 
Редактор EDITFEKO был разработан, чтобы упростить процесс создания 
файла *.pre. 
     Интерфейс EDITFEKO включает редактор, в котором может быть открыто 
несколько файлов, каждый в его собственном окне. Инструментальные 
панели обеспечивают доступ к функциям редактирования. 
EDITFEKO может быть запущен с командной строки, вводя editfeko 
example.pre. Если параметр не содержит расширение, добавляется *.pre. 
Если файл открыт в EDITFEKO, создается lock-file (в виде filename.ext.lock) в 
том же самом каталоге, как и файл. Интерфейс программы EDITFEKO 
показан на рис. 8.2 и состоит из поля программы, и кнопок, каждая из 
которых вызывает диалог, который нужно заполнить и перевести в тело 
программы в виде строки.  
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Рис.8.2. Интерфейс программы EDITFEKO с программой анализа падения 

радиоволны на плоскость 
 
   Инструментальные панели в EDITFEKO находятся сверху окна EDITFEKO, 
но их можно перемещать или закреплять на любой из этих четырех сторон. 
Они могут также быть выключены, выбирая File → Preferences из главного 
меню и закладки Appearance. 
 

8.1.1.Меню File 
 
     В меню File можно, нажимая на New, создать файл  *.pre для PREFEKO, 
*.opt для OPTFEKO, или *.time для TIMEFEKO.     Если идет работа с 
файлом, то функции кнопок следующие: 

1. Создание нового файла *.pre и переключение в режим PREFEKO. 
2. Создание нового файла *.opt и переключение в режим OPTFEKO. 
3. Создание нового файла *.tim. 
4. Открытие файла (и переключение в соответствующий режим). 
5. Сохранение текущего файла. 
6. Печать текущего файла. 

 
8.1.2. Меню Edit 

 
     Это меню содержит команды редактирования. Во время редактирования, 
можно использовать несколько раз команду отмены и восстановление. 
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Можно использовать редактор для конкретного текста, чувствительного к 
регистру или нет. Имеется также быстрый поиск карты. Нажимая правую 
кнопку на панели, выполняется следующий поиск (начиная с текущей 
позиции курсора). Поиск всегда начинается от текущей позиции курсора. 
Если нужно запустить поиск с начала файла, курсор должен быть перемещен 
туда (используя  < Ctrl > < Home >). 
  Имеется удобная опция Goto line, чтобы найти строки с сообщением 
PREFEKO. (PREFEKO всегда сообщает номер строки, где имеются ошибки). 
 

      
Рис. 8.3. Диалоги конфигурации редактора EDITFEKO 

 
     Опции Comment и Uncomment  позволяют прокомментировать блоки 
текста или удалить комментарии. Это часто полезно при отладке большого 
файла. Комментарии вставлены как строки **, сопровождаемый пробелом и 
удаляются, если этот эпизод присутствует. Например, в строках 
 

** ** выбор метки 
** LA 1 
*** следующий комментарий 

символы комментария не будут удалены из третьей строки, используя эту 
функцию. Это не было также сгенерировано функцией Comment. Эти 
команды - доступны “горячими клавишами” <Alt> <C> (для комментария) и 
<Alt> <U> (для некомментария) или могут быть активизированы правой 
кнопкой в редакторе и выбирая из всплывающего меню. 
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8.1.3. Меню карт геометрии и карт управления 
 
    Эти два меню обеспечивают путь открытия панелями диалога редактора 
различных карт при встраивании режима PREFEKO. Карты сгруппированы 
по функциям. 
 

8.1.4. Меню Run 
    Это меню используется для запуска различных программ системы FEKO^ 
OPTFEKO, TIMEFEKO и др. Если другая компонента графического 
интерфейса пользователя запущена из меню Run, она автоматически 
открывает ту же самую модель. Однако CADFEKO автоматически не создает 
новую модель, если файл *.pre с тем же названием уже существует.  

Рис. 8.4. Опции программы FEKO                
 
    Если CADFEKO запускается из 
EDITFEKO с моделью, для 
которой имеется только файл 
*.pre, CADFEKO откроется с 
новой неназванной моделью. 
Если эта модель сохранена с тем 
же именем, это запишет поверх 
существующего файла  *.pre. 
Следовательно, лучше создавать 
модели в CADFEKO и затем 
решать задачу в EDITFEKO. 
Заметим, что при выполнении 
PREFEKO или FEKO, текущий 
файл сохраняется без 
подтверждения. 
  Выберите Run → Component 
parameters, чтобы установить 
параметры команд-ной строки 

для различных компонентов. 
     Возможно запустить решение на удаленном компьютере. Если заполнен 
пункт Remote execution, EDITFEKO запускает решение на главном 
компьютере, указанном в группе Remote Host (рис. 8.4). Решение можно 
запустить на параллельном кластере, как определено в группе Parallel 
execution. Если параллельное задание не удаленное, локальная машина 
должна быть первое имя хоста в конфигурации.  
 

8.2. Установки в EDITFEKO 
 
   Выберите File → Preferences,  чтобы открыть диалог Configure EDITFEKO . 
Опции затем группируются в разделенные таблицы (рис. 8.3). 
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8.2.1. Закладка Appearance 
 
     В этой закладке (рис. 8.3) можно 

• Отключить верхнюю инструментальную линейку, 
• Установить шрифты принтера. 
• Установить размер шрифтов на экране 
• Установить формат карт. 

    В колонке разделенного формата, опции могут быть размещены 
фиксировано и занимать не больше, чем 5 или 10 полей. Если EDITFEKO 
использует поколоночную форму ввода данных, колонки отделены знаком 
«:». Этот формат позволяет произвольные длинные вводы. Если EDITFEKO 
использует формат на основе столбцов, это автоматически переклю-чит на 
формат в виде отделенных колонок, если есть в наличии. 
 
8.2.2. Закладка Options 
 
     В закладке Options (рис. 8.3) выполняются следующие установки: 
 
• Выбор параметров суперпользователя (программиста), если это позволяет 
лицензия. Режим программиста используется только во время разработки 
программ и не доступен общему пользователю. Если пробуете редактировать 
существующую карту, содержащую параметры программиста, EDITFEKO 
также запросит пользователя и переключит на режим программиста, если 
этому позволяют. Если лицензия не позволяет режим программиста, 
параметры программиста будут удалены. 
• Включить опции автосохранения и/или резервирования и определить 
интервал автосохранения. 
• Установить читающее устройство PDF, требуемое для справочников. 
 

8.3. Описание задачи в PREFEKO 
 
   Основная структура входного файла следующая: 
 

** Комментарии в начале входного файла 
... Карты геометрии 
   EG - конец геометрии 
... Карты управления, которые определяют возбуждение и указывают, 
какие поля должны быть рассчитаны 
   EN - конец файла 

 
8.3.1. Генерирование карт 
 
     Карты могут быть введены и редактироваться непосредственно в окне 
редактора. В большинстве случаев пользователь вызывает один из диалогов 
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карт, нажимая на соответствующую кнопку на панели или выбирая из меню 
карты геометрии и карты управления. Кнопки сгруппированы согласно 
функциональным возможностям, а именно в следующие группы. 
 
• Задание точек узла, меток, параметров сегментации и переменных (кнопка 
#). 
• Карты, которые генерируют поверхности, которые будут разбиваться на 
треугольные элементы. 
• Карты, генерирующие сегменты проводов. 
• Карты для описания диэлектрических/ магнитных объемов, которые будут 
подразделены в кубоиды, или диэлектрические области. 
• Карты, используемые для включения в решение метода PO. 
• Карты, которые задать методы MLFMM и FEM и их параметры. 
• Карты, используемые для включения структур с решением UTD. 
• Изменения к геометрии, типа трансляции, масштаба и зеркального 
отражения. 
• Карта EG, обозначающая конец описания геометрии. Вообще кнопки выше 
её должны использоваться перед картой EG и ниже её должны быть после 
карты EG. Исключение –карты DP и IN и блоки " FOR–NEXT» и «IF-ELSE». 
• Карты, имеющие дело с реквизитом среды и земляными платами конечного 
размера. 
• Карты, в которых определяется тип возбуждения, частоты и мощность 
возбуждения. 
• Карты, используемые для управления, и записи данных в выходные файлы. 
• Карты, в которых задаются расчет ближних и дальних полей. 
• Карта конец входного файла. 
 
     Когда диалог редактора карт выбран или из панели кнопки или меню, то 
имеется кнопка, чтобы прибавить карту. Эти новые карты записываются без 
закрытия диалога. Это полезно при определении ряда подобных карт, 
например, при определении первой группы из карт DP в начале модели. 
Часто только один или два параметра отличаются между картами. При 
щелчке OK выполняется запись новой карты и диалог редактора 
закрывается. 
    В диалогах редактора карт, перемещая указатель по меткам можно 
получать подробную информацию о конкретном поле ввода. Если 
пользователь сомневается относительно значения или единиц данного поля, 
всегда желательно переместить указатель в метку, чтобы установить, есть ли 
в наличии и доступна ли дополнительная информация. 
      Все поля ввода данных в FEKO имеют фиксированный размер. В 
диалогах редактора карт невозможно ввести более длинные строки, чем 
позволено для конкретного поля.  
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8.4. Карты описания геометрии 
 

    В программе PREFEKO обрабатываются две группы карт, и первая - группа 
создания геометрии. Эти карты появляются ранее карты EG в файле *.pre2. 
Карты геометрии включаются в файл PREFEKO с расширением *.fek. 
 
Карта Описание 
** Комментарии 
BL Создание линии 
BP Создание параллелограмма 
BQ Черчение четырехугольника 
BT Черчение треугольника 
CB Изменение уже назначенных меток 
CL Создание линии круга, используя сегменты 
CN Изменение направления нормального вектора 
DK Восьмая часть сферы с диэлектрическим или магнитным 

материалом 
DP Задание узловой точки 
DZ Диэлектрическая цилиндрическая оболочка 
EG Конец ввода геометрии 
EL Генерирование сегмента элипсоида 
FO Определение области Фока 
HE создание спирали из сегментов проводов 
IN Чтение внешнего файла, содержащего информацию о геометрии  
IP Параметр разбиения на ячейки 
KA Определение границ области PO 
KK Создание круглого конического сегмента 
KL Установка клиньев в области PO 
KR Создание плоского круга  
KU Создание сферы 
LA определение метки для сегментов, треугольников, полигонов, и т.д. 
ME Описание среды 
NU Определение поверхности NURBS по заданным контрольным 

точкам 
PB Создание параболоида 
PH Создание плоской платы с эллиптическим проемом 
PM Создание многоугольной формы, разбитой на треугольники 

                                                        
2 Все геометрические карты должны появиться перед картой EG. 
Исключения - карта IN, которая включается в файлы *.pre с командами 
управления; и карты DP и TP, которые задают точки для карты AP. 
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PO Применение аппроксимации физической оптики 
PY Многоугольная поверхность для расчета методом UTD или PO 
QU Создание диэлектрического или магнитного куба 
SF масштабный коэффициент, на который умножаются все размеры  
SU переключение программы в режим программирования 
SY использование симметрии в конструкции геометрии 
TG преобразование и вращение геометрических структур 
TO Создание тороида 
TP Преобразование точки 
UT Параметры для однородной теории дифракции (UTD) 
UZ Создание цилиндра для использования в области UTD 
WG Создание параллелограмма, состоящего из проводной сетки 
ZY Создание элемента цилиндра 
 

 

Рис. 8.5. Геометрические карты сосредоточены в разделе Geometry Cards 

 
    Программа FEKO управляется картами подобно программе NEC [7], в 
которой реализован метод моментов для тонких проводов. Входной файл 
состоит из карт, которые можно разделить на карты геометрии и карты 
управления. Геометрия и характеристики поля, которые будут рассчитаны, 
определены, используя эти карты. Некоторые геометрические карты 
интерпретируются и фильтруются в предпроцессоре PREFEKO и 
преобразуются в другие карты. Основная форма входных карт 

 
   Верхние числа указывают столбцы. Поле имени в столбцах 1 и 2 
определяет тип карты. Далее идут пять целочисленных параметров I1  до I5  
(когда читается в PREFEKO, эти поля ввода могут также содержать строки 
типа названий узла) содержащий пять цифр каждый, и восемь реальных 
параметров R1 до R8, содержащих десять цифр каждый. 
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   При вводе данных в карты нужно убедиться, что все параметры введены в 
правильные столбцы. Редактор IDITFEKO помогает пользователю помещать 
параметры в правильные столбцы с помощью диалоговых окон. Все 
параметры вводятся в единицах СИ, т.е. длина в метрах, потенциал в Вольт, 
углы в градусах и т.д. FEKO включает различные параметры 
масштабирования (см. карты SF, TG и IN) так что размеры могут быть 
введены в различных единицах и  масштабироваться к метрам. 
    Первая линия входного файла должна содержать имя файла (без 
расширения). Полное имя файла, включая тракт, может быть длиной до 254 
кодовых знаков дли-ной.  
 

8.5. Карты управления 
 
   Карты управления вводятся в тексте задачи вслед за картами геометрии, за 
картой EG. Карты управления используются, чтобы задать частоты, 
возбуждение и другие опции, необходимые для завершения описания задачи. 
В эту группу карт входят также задание ближнего поля, дальнего поля и 
других рассчитываемых характеристик. Следующая таблица включает все 
карты управления PREFEKO и FEKO. 
 

Карты Описание 
Ax Тип возбуждения (например, падающая плоская волна или генератор напряжения) 
BO Коэффициент, вносимый как коэффициент отражения от земляной платы 
CG алгоритм решения матричного уравнения 
CM Расчет поля в режиме расчета линий передачи CableMod 
CO Вставка элемента диэлектрической и-или магнитной поверхности 
DA создание дополнительного файла результатов 
DI введение свойств диэлектрика при использовании метода поверхностного тока 
FE вычисление ближнего поля 
FF вычисление поля в дальней зоне 
FR установка частот, на которых должны быть выполнены  расчеты  
GF установка функций Грина 
L4  Прибавление нагрузки между металлическим треугольником и земляной плоскостью для 

плоской многослойной функции Грина 
LD определение распределенной нагрузки последовательного соединения, состоящего из 

сопротивления, индуктивности и емкости 
LP определение параллельной нагрузки, состоящей из сопротивления, индуктивности и емкости 
LS определение нагрузки последовательного соединения, состоящего из сопротивления, 

индуктивности и емкости 
LZ определение комплексной нагрузки 
OF замена координат при вычислении ближнего поля 
OS Сохранение токов на поверхности 
PS Установка общих параметров управления 
PW определение мощности излучения передающей антенны 
SK Использование конечной проводимости для определения омических потерь из-за скин-эффекта; 

также для тонких диэлектрических слоев 
SP вычисление S-параметров для активных источников 
TL определение неизлучающей линии передачи 
 
    Как уже сказано, карты управления формируют вторую часть входного 
файла EDITFEKO. Карты управления обрабатываются строка за строкой, 
причем нижние карты управления недоступны, пока не обработана очередная 
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карта. Число карт управления может быть любое, но нужно строго 
придерживаться их последовательности.  
     Например, частота (карта FR) и возбуждение (карта Ax) должны быть 
определены перед картой расчета ближнего поля FE. 
    Кроме того, верный порядок карт управления может привести к 
значительному уменьшению времени вычисления. Например, для карты SK 
вся матрица должна быть повторно рассчитана, в то время как карта Ax 
только переопределяет правую сторону матрицы. Эти зависимости даются в 
таблице ниже: 
 

Действие Выполняется картами 
Повторное вычисление 
матричных элементов 

BO, CO, DI, FR, GF, LD, LP, LS, LZ, SK, TL 
 

Повторное вычисление правой 
стороны уравнения 

Ax, BO, DI, FR, GF 
 

Решение матричного уравнения CG 
 

 
     Имеются также другие зависимости. Если элементы матриц повторно 
переопределены, то матричное уравнение должно быть решено снова.   
   Фактически расчет начинается при включении карт FE, FF, OS и SP. Все 
другие карты служат для сохранения данных. 
    При решении на ряде частот (параметр NFREQ в карте FR) все карты 
управления после карты FR (до следующей карты FR или карты EN) 
читаются в буфер. Для каждой частоты все эти карты обрабатываются 
последовательно. Время вычисления может быть значительно уменьшено, 
если карты идут в правильном порядке. Если, например, структура должна 
быть исследована на двух частотах и с двумя различными возбуждениями, 
тогда карты управления могут идти в одном из следующих порядков: 
 

FR FR карта для этих двух частот 
Ax первое возбуждение 
... 
Ax второе возбуждение 
... 
EN  Конец входного файла 
 
      или 
 
... 
FR FR карта для этих двух частот 
Ax первое возбуждение 
... 
FR FR карта для этих двух частот 
Ax второе возбуждение 
... 
EN  Конец входного файла 
 

    В первом формате, два возбуждения обрабатываются один за другим для 
каждой частоты (карты выполняются в порядке FR Ax ... Ax ... FR Ax ... Ax 
..., где вторая карта FR запускает выполнение частотного цикла для второй 
указанной частоты.) 



 225 

    Во втором формате первое возбуждение обрабатывается для обеих частот 
перед обработкой второго возбуждения для обеих частот (здесь карты 
выполняются в порядке FR Ax ... FR Ax ... FR Ax ... FR Ax ....EN). В 
процессе расчета можно видеть, что в первом случае матричные элементы 
должны быть рассчитаны дважды (это должно быть полностью пересчитано, 
каждый раз, когда частота изменяется), а во втором случае - четыре раза. 
 

8.6. Работа программы при использовании EDITFEKO 
 
     В дополнение к построению моделей в CADFEKO, пользователь может 
использовать язык созданий сценария в EDITFEKO. Это включает циклы 
«next» и " if else ". Инструкции дают пользователю гибкость и контроль над 
ходом работы программы. Можно также импортировать сетку разбиения 
геометрию в FEMA, NASTRAN, PATRAN, AutoCAD *.dxf, STL, ANSYS 
*.cdb и форматы ABAQUS; причем линии сетки можно видеть в файле *.dxf.  
   Оптимизация и анализ во временной области могут выполняться только 
через EDITFEKO. Пользователь может создавать модель полностью в 
EDITFEKO или может создавать модель в CADFEKO (которые создают 
файлы *.pre и *.cfm от модели) и редактируют впоследствии файл *.pre. 
Заметим, однако, что невозможно возвращаться и редактировать параметры 
управления в CADFEKO без перехода к файлу *.pre. 
     После редактирования файла *.pre, пользователь запускает PREFEKO 
(обычно из EDITFEKO) чтобы подготовить ввод в ядро файла *.fek. Этот 
файл должен быть проверен в POSTFEKO. Затем задача решается, запуская 
FEKO. Результаты сохранены в файле *.bof, которые могут просматриваться 
в POSTFEKO.  
    Далее, для того, чтобы показать, как работает EDITFEKO совместно с 
скриптами, рассмотрим пример оптимизации, которые реализуется в 
EDITFEKO. Оптимизация является важным инструментов при 
проектировании антенн и СВЧ структур. Оптимизация улучшает 
определенные характеристики, изменяя параметры устройства. Например, 
усиление антенны может быть оптимизировано,  изменяя геометрию. 
     Как обсуждено ранее, в PREFEKO могут быть использованы переменные. 
Поэтому может быть создан входной файл *.pre, используя переменные, 
которые будут изменяться. 
  Кроме параметров, необходимо задать целевую функцию, чтобы определить 
цель оптимизации. В OPTFEKO имеется несколько методов оптимизации.  
Программа OPTFEKO требует создания двух входных файлов. 
 
1) Входной файл *.pre  
    В файле *.pre определены переменные, которые изменяются во время 
оптимизации. OPRFEKO многократно создает новые файлы *.pre, в котором 
назначаются новые параметры оптимизации. На эти переменные можно 
назначить значения (например, чтобы запустить PREFEKO и рассмотреть 
геометрию), используя функции DEFINED.  
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 2)Входной файл *.opt  
    Метод оптимизации, его параметры и цель оптимизации сохраняются во 
втором файле с расширением *.opt. Этот файл состоит из трех или четырех 
разделов: 
 
1) Назначение изменяемых параметров, их минимальных и максимальных 
значений; 
2) Необязательное назначение штрафной функции; 
3) Выбор параметров оптимизации (т.е. размер шага, конечное значение); 
4) Выбор целевой функции. 
     Для создания нового файла .opt, нажмите New, а затем на кнопку Edit в 
поле оптимизации (рис. 14.1). 
     В файле *.opt  линии комментария (начинающиеся с **) позволяются 
между разделами, но не позволяется появление их в разделах непо-
средственно. Параметры пространственно разграничены, т.е. они отделены 
пространствами и могут быть помещены в любой столбец, но они должны 
быть введены в правильном порядке. 

 
Рис. 8.6. Интерфейс программы EditFEKO 

 
     Ключевые слова, используемые в файле *.opt существуют и на немецком, 
и на английском языке (например, RASTERSUCHE и GRID_SEARCH). 
OPTFEKO распознает ключевые слова на любом языке, независимом от 
языка, выбранного переменной среды FEKOLANG 
 

8.7. Задание параметров оптимизации 
 

  Нажмите кнопку с изображением #  (рис. 14.2). Появляется таблица, 
показанная на рис. 14.3. 
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Рис. 8.7. Четыре кнопки для написания файла оптимизации 

     
   Параметры оптимизации определены в форме для печатания таблиц. 
Каждый параметр оптимизации имеет имя (переменная в файле *.pre) . Для 
каждого параметра, нужно задать начальное, минимальное и максимальное 
значение. 
     Пример параметров оптимизации: 

** Имя Начальная величина  Максимум Минимум  
    #alpha  20     -80   80 
    #a   0.75     0.25   2.0 
 

 
Рис. 8.8. Задание изменение параметров 

 
     Обычно минимальные и максимальные значения параметров оптимизации 
в файле *.opt используются только для нормализации пространства 
параметров. Чтобы гарантировать что параметры при изменении будут 
находиться в заданных пределах, добавляется штрафная функция. Это даёт 
плавность целевой функции при оптимизации. 
       В некоторых случаях, однако, нужно использовать строгие границы, 
чтобы избежать недопустимых конфигураций (например, расстояние между 
точками не может стать отрицательным). Если в файле *.opt находится 
установка ENFORCE_MIN_MAX, то задаются строгие границы, когда 
OPTFEKO создает файл *.pre. Прибавлять штрафную функцию нужно для 
того, чтобы сформировать алгоритмы оптимизации, чтобы при оптимизации 
передвинуться обратно в допустимый диапазон параметра. 
 

8.8. Определение штрафной функции 
 
     Чтобы гарантировать, что изменяемый параметр x остается в диапазоне 
[xmin … xmax ], к целевой функции должна быть добавлена штрафная 
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функция. Тогда целевая функция резко ухудшается, если параметры выходят 
за допустимый диапазон их изменения. Штрафная функция P определена 
уравнением 
 





























max
minmax

max

maxmin

min
minmax

min

10

,0

10

xxпри
xx

xx
P

xxxпри

xxпри
xx
xxP

P

U

o

. 

 
    Два параметра PU и Po определяют значение штрафа при переходе 
параметра x на 10 %. Штрафная функция добавляется к целевой функции и 
нужно обеспечить, чтобы обе они имели одинаковую размерность. 
    Штрафная функция определена ключевым словом PENALTY_FUNCTION. 
В линиях, которые следуют далее, определяются параметры оптимизации PU 
и Po. В первой строке PU и Po связаны с первым параметром в разделе 
параметров оптимизации. PU и Po в следующих строках связаны с 
параметрами оптимизации, определенными в соответствующих строках. 
Если штрафная функция не была задана, нужно установить PU и Po =0. Если 
никакие штрафные функции не должны быть назначены вообще, то весь 
раздел может быть опущен. 

 
Рис. 8.9. Задание штрафной функции 

Пример штрафной функции: 
 

PENALTY_FUNCTION 
100  100 
10  10 

 
8.9. Определение процесса оптимизации 

 
    Имеется методов оптимизации, которые могут использоваться в 
OPTFEKO. 
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Метод дискретных точек (параметрическая оптимизация) 
 
   Этот метод, строго говоря, не метод оптимизации. Параметры оптимизации 
линейно изменяются между минимальным и максимальными значениями. 
Значение целевой функции рассчитывается в n дискретных точках. Метод 
выбирается, используя ключевое слово GRID_SEARCH, число дискретных 
точек определяется в линейном диапазоне. 
 

 
Рис. 8.10. Задание параметрической оптимизации 

    Пример: 
GRID_SEARCH     
8  9 

   В этом случае целевая функция будет рассчитана 8 ·9 =72 раза. (Восемь 
дискретных точек для первого параметра оптимизации и девять дискретных 
точек для второго параметра оптимизации). Целевая функция задается в 

разделе, который появляется после нажатия на  и может включать 
несколько критериев, включающих согласование антенны, усиление и др. 
характеристики. 

 
8.10. Выходные файлы FEKO 

 
   Таблица ниже дает краткий обзор наиболее важных файлов и их 
соответствующих функций.  
 

Имя 
файла 

Описание 
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*.aus Выходной файл TIMEFEKO 
*.bof Бинарная версия выходного файла, который используется для постпроцессорной обработки 
*.dxf файл геометрии AutoCAD, который может быть импортирован картой IN. (Только линии и 

разбиваемые на сетку полигоны импортированы.) 
*.fek Выходной файл от PREFEKO — служит как входной файл для FEKO. 
*.geo Дополнение к файлу *.pre, файл *.geo требуется со специальной, низкочастотной программой 

LFFEKO. 
*.mod файл модели FEMAP модели файл. 
*.nas файл геометрии NASTRAN, который может быть импортирован с картой IN  
*.neu Геометрический файл данных, который экспортируется программой FEMAP. 
*.opt Входной файл для программы OPTFEKO. 
*.out Выходной файл от FEKO, в котором результаты всех вычислений и сообщений могут быть 

найдены. 
*.pre Входной файл для PREFEKO. 
*.ray Для UTD может потребоваться этот файл, чтобы видеть пути лучей в POSTFEKO. 
*.snp файл S-параметров в формате Touchstone, создаваемый картой DA.  
*.tim Входной файл для программы TIMEFEKO 
*.wfg Рисунок, созданный и сохраненный в POSTFEKO 
. 
   Карты DA и PS могут потребовать файлы *.efe, *.hfe, *.ffe и *.os, но вся 
информация в этом файле также имеется в файле *.out. Формат этого 
избыточного файла можно использовать для дальнейшей обработки. 

 
Рис. 8.11. Параболическая антенна, отдельные части которой рассчитыва-
ются разными методами. Подобный пример можно рассчитать в 
EDITFEKO 
 

8.11. Динамическое управление памятью 
 
    FEKO управляет требуемой памятью динамически, т.е. эта память, 
требуемая для данных геометрии и матричных уравнений определяется и 
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распределяется во время выполнения. В некоторых случаях блоки памяти 
должны быть распределены для хранения данных прежде, чем FEKO точно 
знает, насколько большие эти блоки памяти должны быть. В этих случаях это 
использует расчет PREFEKO. Если оцененный размер слишком маленький, 
FEKO остановит выполнение и даст сообщение об ошибке.  
    Подходящий размер должен быть объявлен в файле *.pre. Это 
выполняется,  вводя, например, строку #maxnv = 100 в файле *.pre. 
     Обычно не нужно объявлять эти переменные, и это должно только быть 
сделано в случаях, где имеется явное сообщение об ошибке, заявляющее, что 
требуются большие блоки памяти. 
    Одно исключение устанавливает переменную #maxallocm, чтобы 
ограничить количество ОЗУ, которое может быть распределено и, таким 
образом, избегать использовать системную перестановку как обсуждено в 
комментариях в общей главе инструкции для пользователей.  
     FEKO управляет ЗУ динамически, то есть ЗУ, требуемое для данных 
геометрии и матричных элементов распределяется во время выполнения. 
    Когда FEKO пробует распределять ЗУ, операционная система предлагает 
неко-торое адресное пространство, которое могло бы или быть физически 
установленное ЗУ (то есть оперативная память), но также и виртуальное ЗУ 
(система меняет доступную память, записывая  на жесткий диск). 
     Если FEKO начинает использовать виртуальную память, то весь процесс 
реше-ния может быть весьма существенно замедлен, и это не рекомендуется. 
FEKO также имеет решение " в процессоре " который использует диска 
намного более эффективно (также используется метод подкачки, если задача 
требует большее количество ЗУ, чем было доступно и в оперативной памяти 
и виртуальной ЗУ.) 
    Для решений, которые не вписываются в доступную оперативную память, 
но вписываются в оперативную память плюс виртуальном ЗУ, пользователь 
должно сообщить FEKO что фактическое, физически установленное ЗУ, 
меньше некоторого резерва для операционной системы. В FEKO v.4.2 для 
этой цели использовались переменные #maxalloc или #maxallocm, причем 
#maxallocm устанавливает максимально возможное ЗУ в МБ.  
   Например установка #maxallocm = 400 позволяет распределять максимум 
400 МБ ЗУ. Если это не достаточно, матрица будет сохранена на жесткий 
диск или программа остановится. Для параллельных постановок FEKO этот 
лимит памяти применяется к каждому процессу. Заметим, что если  
используется  #maxallocm, то #maxalloc будет игнорироваться, если это 
используется в том же самом файле *.pre. Переменная  #maxalloc подобна 
переменной #maxalloc, но только определяет ЗУ в  байтах, а не в МБ. 
    Эти две переменные #maxalloc и  #maxallocm всё еще находятся в FEKO 
4.2 и поздних версиях, но в обратном направлении возможна 
несовместимость. В системах Windows и Linux работа FEKO по управлению 
памятью полностью автоматические и работа с виртуальным ЗУ избегается. 
На системах UNIX (типа - UX или SUN Solaris) во время инсталляции 
определяется переменная среды FEKO_MAXALLOCM и имеется опция в 
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сценарии initfeko, которая определяет физически установленную RAM, 
меньшую резерва операционной системы для отдельной PC. Преимущество 
тогда состоит в том, что FEKO файл *.pre являются независимым от PC, то 
есть если Вы имеете два различных компьютера с различным ЗУ, никакая 
переменная #maxallocm не должна быть изменена в файле *.pre, а 
полностью автоматически определяется базисом машины. 
 
    В некоторых случаях блоки памяти должны быть распределены для 
хранения данных прежде, чем FEKO точно знает, насколько большие эти 
блоки памяти должны быть. В этих случаях используется расчет PREFEKO. 
Если рассчитанный размер слишком малый, FEKO остановит выполнение и 
даст сообщение об ошибках. Подходящий размер теперь должен быть 
объявлен в файле *.pre. Это выполняется, вводя, например, строку #maxnv = 
100 как нормальную переменную, где-нибудь в файле *.pre.  
 
 #maxnp - максимальное число столбцов и строк, в матрице алгоритма Гаусса 
решения матричного уравнения. Динамически 3*#maxnp*#maxnp*16 байт 
распределены для 3 блоков в матрице. 
 
 #maxnv - максимальное число точек соединения между проводами и 
треугольниками на поверхностях. 
 
 Переменные, которые автоматически устанавливаются корректно 
 
     Заметим, что обычно PREFEKO распознает переменные правильно и они 
должны быть объявлены только в случаях, где  имеется сообщение об 
ошибках. В нормальных обстоятельствах эти переменные не нужно 
объявлять, это может иметь отрицательное влияние на работу FEKO: 
 #maxaeedges - максимальное число граней между треугольниками, которые 
могут быть возбуждены с помощью карты AE; 
 #maxanr - максимальное число источников; 
 #maxapo - размер блока памяти, который используется, сохраняет 
коэффициенты в физической аппроксимации оптики. Для #maxapo=0 
необходимое количество будет динамически распределено;  
 #maxarang - максимальное число углов  ϑ или  ϕ , используемые в карте 
AR (возбуждение точечным источником с указанной диаграммой направ-
ленности излучения); 
 #maxarpat - максимальное число возбуждений диаграммы направленности 
излучения (карта AR), позволенные одновременно; 
 #maxbsobnr – переменная разделения области на боксы, применяемая для 
ускорения поиска траектории луча в методе PO.   
 

8.12. Предпроцессор PREFEKO 
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    Поверхность структуры, которая будет проанализирована программой 
FEKO, должна быть разделена на элементарные поверхности (в этом случае – 
треугольники). Провода должны быть подразделены на сегменты. Размер 
разбиения зависит от длины волны в среде, окружающей структуру. 
Программа PREFEKO может сделать всё разбиение. Она автоматически 
генерирует геометрические данные, в форме, требуемой FEKO, по данным 
пользователя. 
    Плотность сетки разбиения управляется связанными, зависимыми друг от 
друга параметрами. PREFEKO также импортирует сетку разбиения, 
например созданную в CADFEKO, объединяя это с окончательным входным 
файлом FEKO.  
    Этот раздел описывает принцип работы  программы. Пользователь сначала 
задает размещение точек в пространстве с помощью карты DP. 
  Затем структуры определяются в терминах этих точек. Например, две точки 
могут быть соединены, чтобы формировать линию (карта BL), или четыре 
точки для параллелограмма (карта BP). 
  
    PREFEKO запускается, используя следующую команду: 
 

prefeko example 
 
    После успешного исполнения создается файл example.fek. Это - входной 
файл для FEKO. 
    Программа PREFEKO имеет некоторое число опций, которые главным 
образом используются для отладки. Ввод prefeko без аргументов даст общий 
обзор синтаксиса и поддержанных параметров. Если, например, определен 
параметр - fek, то PREFEKO создает файл *.fek, используя x-й формат файла. 
    Опция - ignore-errors делает ошибки нефатальными, т.е. PREFEKO 
продолжает обработку после встречающихся ошибок. Это может приводить к 
большему количеству ошибок как следствие первой, но в этом случае 
полезно увидеть всю геометрию, и многие ошибки сразу, а не только первую 
ошибку. 
    PREFEKO также позволяет даже задать переменные из командной строки, 
например вызывая PREFEKO  
 

prefeko filename -#variable1=value1 -#variable2=value2 ... 
 
   Устанавливает переменные #variable1 и #variable2 так, чтобы они могли 
использоваться в файле *.pre. 
    Можно использовать команду !! Print_to_out, чтобы записать эти 
переменные в выходной файл, чтобы сохранить отчет их значений.  
 

8.13. Символические переменные 
 
    Вместо использования численных значений в разных картах, можно 
использовать заранее определенные переменные. Имя переменной всегда 
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состоит из знака #, и строки, состоящей из символов a-z, A-Z, 0-9 и символа 
подчеркивания _. Следующие имена переменных верные: #height, #a, 
#STARTINGFREQUENCY, #a_1 или #P5_7f, в то время как неправильны: 
#a_1 или #value2.1. Не имеется различия между символами верхнего и 
нижнего регистра. Например, #a и #A интерпретируются как одна и та же 
переменная. 
    Важно заметить, что в CADFEKO переменные используются без знака « # 
». Еще отметим, что PREFEKO требует различия между переменными и 
функциями (типа sin). Когда CADFEKO записывает переменные в файл 
*.cfm, то включается знак  # так, чтобы переменные могли использоваться 
после карты IN в файле *.pre. Так как эти переменные определены в файле 
*.cfm, они не могут использоваться как переменные оптимизации в 
OPTFEKO. 
    Выражения и функции могут использоваться при определении 
переменных, так, чтобы прямые вычисления могли быть выполнены. 
Переменные должны быть определены прежде, чем они могут 
использоваться в соответствующих картах. Можно вводить выражения 
подобные 2*#radius в поля, с учетом максимальной длины 10 символов для 
реальных значений и 5 символов для значений целых чисел. Для больших 
выражений должны быть определены дополнительные переменные. 
Переменная определяется следующим способом: 
 

#2pi = 2*#pi 
#vara = 1 + sqrt(2) 
#varb = #vara * 2.3e-2 * (sin(#pi/6) + sin(rad(40)) + #vara^2) 
#sum = #vara+#varb 

 
     Заметим, что знак # должен появиться в первом столбце. Переменные 
могут также быть определены из командной строки, как описано в 
предыдущем разделе. 
     В дополнение к простым переменным также можно задать переменные с 
индексами, типа #a[5] или, более сложно, #am_0[3*#i+ceil(#r^2)]. Выражение 
между квадратными скобками должно быть целым числом, которое может 
быть отрицательным. Выполнение использования массивов - то, так, чтобы 
они не должны быть распределены, однако они должны быть 
инициализированы. Так, например, использовав команды 
 

!!for #i = 10 to 20 
#array_a[#i] = 3*#i-10 
#array_b[-#i] = 0 
!!next, 

 
можно будет использовать #array_a[10] или #array_a[17] или также #array_b[-
12] в других выражениях. Но попытка использовать  #array_a[5] или 
#array_b[0] приведет к сообщению об ошибке, что используется 
неопределенная переменная. 
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    С правой стороны любого выражения, переменные, которые уже были 
определены, могут использоваться вместе с любой из следующих функций: 
 
1 () Скобки 
2 + Сложение 
3 - Вычитание 
4 ∗ Умножение 
5 / Деление 
6 ^ powers Возведение в степень, например 2^3=8 
7 SIN синус (аргумент в радианах) 
8 COS косинус (аргумент в радианах) 
9 TAN tangent (argument в радианах) 
10 COT cotangent (argument в радианах) 
11 ARCSIN arcsine (в радианах) 
12 ARCCOS arccosine (в радианах) 
13 ARCTAN arctangent (в радианах) 
14 ATAN2 this function has two arguments atan2(#y,#x) it yields arctan(#y/#x) in the range −π . . 

. π 
15 ARCCOT Арккоангенс 
16 SINH Гиперболический синус 
17 COSH Гиперболический косинус 
18 TANH Гиперболический тангенс 
19 SQRT Корень квадратный 
20 LOG Логарифм по основанию 10 
21 LN Натуральный логарифм 
22 EXP Экспоненциальная функция 
23 BESJ(n,x) Функция Бесселя Jn(x) целого порядка n ≥ 0 и реального аргумента x 
24 BESY(n,x) Функция Неймана Yn(x) целого порядка n ≥ 0 и реального аргумента x 
25 BESI(n,x) Модифицированная функция Бесселя первого порядка In(x)  целого порядка n ≥ 

0 и реального аргумента x 
26 BESK(n,x) Модифицированная функция Бесселя второго порядка Kn(x) целого порядка n ≥ 

0 и реального аргумента x 
27 ABS Абсолютная величина 
28 DEG Преобразование радиан в градусы 
29 RAD Преобразование градусов в радианы 
30 STEP Функция переключения, т.e. STEP(x) = 0 for x ≤ 0 

STEP(x) = 1 for x > 0 
31 CEIL Наименьшее целое число, которое равно или больше аргумента 
32 MAX Наибольшее из двух аргументов, называемого max(#a,#b) 
33 MIN Возвращение наименьшего из двух аргументов min(#a,#b) 
34 FMOD Эта функция также имеет два аргумента fmod(#a,#b) и возвращает результаты 

деления  #a/#b 
35 RANDOM Эта функция возвращает случайное число в диапазоне 0 . . . 1. Если аргумент  X 

функции RANDOM() равен -1,  тогда случайное число возвращается.  
36 X COORD Эта функция возвращает x координату точки, определенной картой  DP. Имя 

этой точки, метку проходит как аргумента функции, например 
            DP PNT01 1.234 0.4567 #z 
            #x = x_coord("PNT01") 
Будет установлен параметр #x = 1.234 

37 Y COORD Возвращает y координату ранее определенной точки подобной функции  X 
COORD обсужденной выше.  

38 Z COORD Возвращает z координату ранее определенной точки подобно функции X 
COORD. 

 
Функция FILEREAD читает численные величины из произвольного файла 
ASCII. Общий синтаксис это читаемый файл ("Filename", Line, Column) и 
содержит имя файла, номер линии для чтения из столбца для чтения. 
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Например, рассмотрим файл данных содержащий список частот и 
импедансов нагрузок для каждой частоты: 
 

Frequency in MHz Re(load) in Ohm Im(load in Ohm) 
100    22.54   -12.56 
150    25.07   -6.54 
200    27.42   0.23 

 
Частота и нагрузка могут быть импортированы непосредственно из этого 
файла 
 

#numfreq = 3   ** число частотных точек 
!!for  #i = 1  to  #numfreq 
** Определение частоты (преобразование от MHz к Hz) 
#freq = 1.0e6*fileread("datafile.dat", #i+1, 1) 
FR   1   0   #freq 
** Задание нагрузки 
#Zr = fileread ("datafile.dat", #i+1, 2) 
#Zi = fileread ("datafile.dat", #i+1, 3) 
LZ   0   #Zr   #Zi 
** расчет ... 
!!next ** конец частотного цикла 

 
    В дополнение к этим функциям PREFEKO позволяет использование 
логические операции. Он поддерживает функцию NOT () - который 
возвращает TRUE, если параметр является FALSE и FALSE, когда параметр 
TRUE - и разделители >, <, > =, < =, =, < >, ENDи OR. 
   Когда булевы действия применены к переменным, значение 0 принимается 
эквивалентом FALSE, и все остальное интерпретируется как TRUE. 
Аналогично в результате логической операции FALSE = 0 и TRUE = 1. 
    PREFEKO также поддерживает логические функции DEFINED(#variable) 
которые возвращают TRUE, если переменная #variable была определена, и 
FALSE, если нет. Это полезно в файле *.pre, для запуска OPTFEKO, 
TIMEFEKO или ADAPTFEKO. Эти переменные вставляются в файл, но 
может потребоваться задать переменную в файле для предварительного 
просмотра. Например, если файл *.pre будет оптимизирован относительно 
переменной #a, можно использовать конструкцию 
 

!!if (not(defined(#a))) then 
#a = 200.0e-3 
!!endif 

 
    Приоритет операций (сначала рассчитывается нижний уровень) 
следующий: 
 

OR 
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AND 
= and <> 
>, <, >= and <= 
+ and - 
* and / 
^ 
+ and - (когда используется знак) 

 
   Некоторые переменные предопределяются в PREFEKO, но могут быть 
перепи-саны при переименовании. Это: 
Имя Величина Описание 
#pi 3.14159265358979 Постоянная π 
#eps0 8.85418781761 · 10−12 Диэлектрическая постоянная  ε0 

свободного пространства 
#mu0 4 π · 10−7 Магнитная проницаемость ?0 

свободного пространства 
#c0 00/1   

 
Скорость света в свободном 
пространстве 

#zf0 00 /  Внутренний импеданс свободного 
пространства 

#true 1 Использование логического true 
#false 0 Использование логического false 
      Имеются три других специальных переменных  #!x, #!y и #!z, которые по-
лезны для подключения сложных проводных структур. Эти три переменные 
определяют координаты конечной точки проводного сегмента. Это обеспечи-
вает правильное и простое подключение прямого провода к изогнутому 
длинному проводу: 
 

CL ..... 
DP  A  #!x  #!y  #!z 
#z = #!z + 0.5 
DP  B  #!x  #!y  #z 
BL  A  B 

 
      Следующий пример показывает применение переменных. 
 

** диэлектрическая сфера в поле падающей волны 
** определение переменных 
#r = 1             ** радиус сферы 
#betrad = 1    ** электрический размер сферы 
#epsr = 15    ** относительна диэлектрическая 

проницаемость 
#maxlen = 0.7   ** максимальная длина ребра разбиения 
** определение параметров сегментации 
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IP  #maxlen 
 

** Точки угла 
 

DP  A  0  0  0 
DP  B  0  0  #r 
DP  C  #r  0  0 

 
** Выбор среды 

 
ME  1  0 
** Генерирование восьмой части сферы 
KU  A  B  C  0  0  90  90  #maxlen 
** использование симметрии в время трех координатных плоскостях 
** yz-plane:  идеальная электрическая стенка 
** xz-plane:  идеальная магнитная проводящая плоскость 
** xy-plane: только геометрическая симметрия 
SY  1  2  3  1 
**Конец геометрии 
EG  1  0  0  0  0 
** Описание свойств диэлектрика 
DI  #epsr   1.0 
** Возбуждение в виде падающей волны 
#freq = #betrad * #c0 / (2*#pi*#r) 
FR  1  0  #freq 
A0  0  1  1  1.0  0.0  -180.0 
** Ближнее поле вдоль оси z 
FE  1  1  1  25  0  0.0  0.0  -1.98  0.0  0.0  0.04 
FE  4  1  1  50  0  0.0  0.0  -0.98  0.0  0.0  0.04 
FE  1  1  1  25  0  0.0  0.0  1.02  0.0  0.0  0.04 
** Конец программы 
EN 

 
    Использование переменных делает исследование структур с 
изменяющейся геометрией (например, с переменным расстоянием антенны 
перед рефлектором) простым процессом, потому что только одна переменная 
должна быть изменена. Это также позволяет использовать циклы FOR и  IF. 
 

8.14. Цикл FOR/NEXT 
 
    Некоторые карты в FEKO косвенно используют циклы (типа карты FR с 
несколькими частотами). Это, однако, не всегда удобно, может 
потребоваться, например, изменять важные параметры внутри цикла. Другой 
пример использования цикла, применяется при создании сложной геометрии. 
    Для общих циклов, PREFEKO предполагает конструкцию 
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!!for #var = #start to #end step #delta 
!!next, 

 
    где простой пример будет иметь вид 
 

** цикл для относительной диэлектрической 
проницаемостью 

!!for #eps_r = 1 to 5 step 0.5 
** установить параметры материала 
GF 0 #eps_r 1 
** Расчет поля. 
FE 
** Конец цикла 
!!next 

 
    Правила синтаксиса циклов FOR/NEXT: 
 
• Символы !! должны находиться в первых двух столбцах строки. Это 
сопровождается рядом пробелов, и ключевым словом FOR (не 
чувствительным к регистру, так FOR или for принимаются одинаковыми).  
• ключевое слово сопровождается циклом с именем переменной.  
    Имя переменной заканчивается пробелом или знаком =. 
• Затем следует выражение для первоначального значения цикла (постоянная, 
переменная или состав, см. пример ниже). 
• Это сопровождается ключевым словом для завершения переменной цикла 
(снова используя постоянную, переменную или формулу). 
• заданное по умолчанию приращение переменной цикла равно 1, но это 
может быть изменено, используя ключевое слово для шага, следующее из 
выражения. Отрицательные приращения позволяются. 
• цикл заканчивается !!next  (пространства позволяются между !! и  next, но 
не перед!!). Все команды и входные платы между !! for  и !! затем 
оцениваются неоднократно внутри цикла. 
• Несколько циклов могут быть вложены один в другой.  
    Более сложный пример, приводится ниже: 
 

#end = 3+sin(4) 
!!for #x1 = sqrt(5) + 2*3 to 2*#end step -#end/10 
!! for #x2 = 1.23 to 2*#x1  ** внутренний цикл 
#x3 = #x1 + #x2 
DP .... 
.... (другие команды) 
!! next 
!!next 

      Здесь один цикл вложен в другой. 
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8.15. Конструкция IF/ELSE/ENDIF 
 
     Эта конструкция использует различные карты управления при различных 
условиях. Необходимые условия синтаксиса конструкций IF/ELSE/ENDIF: 
 
• символы «!!» должны быть расположены в первых двух столбцах строки. 
Это сопровождается произвольном числом пробелов;  
 
-выражение для расчета и ключевые слова не чувствительны к регистру, THEN 
или Then принимаются; 
 
• блок заканчивается строкой в форме !!Endif (снова пробелы позволяются 
между !! и endif но не перед !!); 
 
• строка по желанию, в форме  !!else (снова !! должен быть в первых двух 
столбцах, и пространства позволяются перед ключевым словом, которое не 
чувствительно к регистру); 
• все команды и входные карты между !!If и !!endif (или !!else если имеются) 
обрабатываются, если выражение TRUE. Иначе обрабатываются все строки 
между !!Else и !!Endif, если выражение FALSE. 
 

Команда EXIT 
 
    PREFEKO также поддерживает команду !!exit для остановки расчета. Это 
может также быть полезные команды для проверки типа 

 
!!if #a < 2*#b then 
!! exit 
!!endif 

 
Символические имена узлов 
 
    При определении имен узлов, можно использовать имена переменных в 
форме A#i. Тогда имя переменной можно изменять в цикле. Имя округляется 
к самому близкому целому числу. Таким образом, если мы имеем выражение 
#k=15 и используем или определяем точку P#k, тогда это эквивалентно 
использованию P15, как имени точки. Длина имени ограничивается 5 
символами. 
    Тогда можно выбирать точки в цикле от P1 до P20: 
 

!!for #k = 1 to 20 
DP  P#k ..... 
!!next 

 
и использовать этот цикл либо самостоятельно, либо внутри другого цикла. 
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Заключение 
 

Тенденции, методы и стратегии проектирования сложных СВЧ 
устройств с использованием современных программ 

 
     Современные радиотехнические устройства фактически состоят из волно-
вого канала распространения, преобразования и усиления радиоволн и циф-
ровой части. Цифровые компоненты – цифровые фильтры, усилители, 
генераторы, компараторы, обнаружители и распознаватели сложной 
последовательности цифровых сигналов, системы разделения полезных и 
вредных сигналов – переходят в разряд микросхем и программируемых 
процессоров, созданные как отдельные радиотехнические узлы, в будущем 
все чаще будут входить в канал распространения СВЧ радиоволн. 
     Поэтому проектирование систем приема и обработки радиоволн включает 
анализ коммутационных, модуляционных и прочих узлов, управляемых на 
уровне цифры. Эти и другие особенности современных радиосистем требуют 
разработки, выбора и исследований и развития новых методов анализа, 
синтеза и проектирования как всей системы, так и отдельных узлов.  
    В условиях высокого темпа производства, когда нужно быстро ответить на 
возникающий вопрос, как организатор научной работы, так и исполнители от 
научных сотрудников до инженера, должны принимать решение о 
соотношении аналитических и численных методов для решения 
поставленной задачи, и получить однозначный ответ: какой метод нужно 
выбрать для решения конкретной задачи с заданной степенью точности. 
     Отметим тот факт, что необходимый темп исследований и разработок 
бортовых и наземных антенных систем, невозможен без создания новых 
информационных технологий проектирования устройств произвольной 
топологии на электродинамическом уровне. Подобные технологии не 
сводятся только к усовершенствованию распространённых методик 
аналитического и параметрического синтеза, использующих для анализа и 
оптимизации на вычислительных системах электродинамические программы, 
созданные для конкретных топологий устройств на основе численных 
методов решения уравнений Максвелла.  
     Альтернативным подходом является методика топологического синтеза с 
использованием универсальных электродинамических программ, 
базирующихся не на решении уравнений Максвелла для конкретной краевой 
задачи, а на импедансных или потоковых дискретных сеточных операторах. 
В таком подходе имеется возможность нелинейного анализа СВЧ схем, 
используя алгоритм SPICE. 
    В основе топологического синтеза лежит разделение математических 
моделей: эвристических и компьютерных. Человек занимается проблемами 
поиска оптимального решения, используя предельно простой 
математический аппарат (теория на уровне инвариантов) и геометрическую 
(образную) интуицию. Решение краевых задач, полностью автоматизируется 
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и поручается компьютеру. Именно при таком подходе появляется 
возможность построения антенных систем с уникальными характеристиками. 
      При этом встает задача создания эффективных алгоритмов (и на основе 
их программ), позволяющих выполнить анализ электромагнитных процессов 
прямыми алгебраическими методами в частотной или временной областях. 
Построение таких эффективных алгоритмов возможно на основе метода 
импедансного аналога электромагнитного пространства. При подобном 
подходе возникает проблема увеличения вычислительной мощности 
программ и повышения точности анализа сложных систем. Несмотря на 
увеличивающуюся производительность современных компьютеров, 
универсальные программные средства, которыми располагает инженер, 
позволяют исследовать с требуемой точностью трехмерные задачи с весьма 
ограниченной областью анализа (объемом порядка  101010  ).  
    Современный этап проектирования радиосистем остро ставит следующие 
задачи, которые решаются только используя высокоскоростные компьютеры. 
1. Структурный синтез СВЧ устройств произвольной формы. В эту 
задачу входит освобождение понятия синтеза от любых ограничений, 
переход от структурно-параметрического к параметрическому и полного 
генетическому алгоритму синтеза, выполнение скалярной и векторной 
оптимизации и получение в результате решения задачи структуры 
произвольной формы.  
2. Сравнение и анализ особенностей методов моделирования СВЧ 
устройств. 
    Быстрое развитие различных методов моделирования, включая методы, 
основанные на теории цепей, метод Олинера, а также электродинамические 
методы в частотной и временной области, в которые входят метод моментов 
МОМ, методы FDTD, FEM, TLM, многомодовых блоков, требуют оценку 
точности расчета, времени и компьютерных ресурсов для реализации 
различных методах электродинамического решения поля.  
   Здесь возможны различные цели – либо выбор наиболее перспективого 
метода и отказа от других, либо объединение нескольких методов в одной 
оболочке, как сделано в FEKO, с объединением нескольких методов 
(оптических, радиотехнических и физических).  
3. Совместное моделирование (косимуляция) радиотехнических 
устройств, т.е. моделирование в одном процессе СВЧ узлов (каналов 
распространения, фильтров, линейных и нелинейных усилителей, 
антенн) и цифровых а также коммутационных узлов.  
    Эскизное проектирование по современным критериям искажения верхней 
и нижней границы динамического диапазона. Амплитудные и фазовые 
искажений в  тракта значительно зависят от характеристик антенн. Связь 
между характеристиками системы и характеристиками антенных и СВЧ 
узлов. Электромагнитная совместимость в различных сечениях 
радиосистемы.  
4. Методические подходы и рекомендации выбора методов расчета при 
проектировании радиотехнических устройств и сложных систем (система 
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радиоидентификации, сотовая телефонная и ближняя связь, беспилотный 
самолет, системы слежения и управления, медицинские приборы), включа-
ющих радиочасть и часть цифровой обработки. Пространственные подави-
тели помех. Управление и адаптация многолепестковой диаграммы направ-
ленности.  
5. Решение электродинамических задач совместно с задачами с 
физической формулировкой (моделирование на уровне нано и 
микроструктуры, включая  воздействие сигнала оптического диапазона, 
распространение радиоволн в плазме). В этих случаях нужно выработать 
подходы к решению физических задач, используя численные методы 
проектирования. К такие задачам можно отнести слабо разработанные пока 
методы расчета ферритовых устройств с учетом свойств магнитного 
смещения, опто-волоконных линий, диэлектрических резонаторов. 
6. Решение задач распространения объединенных с биологическими и 
физическими задачами (например, поглощение мощности в биологическом 
теле, которое может иметь полезное и вредное влияние на жизнь 
биологического организма). Биология и медицина продолжает ставить перед 
разработчиками антенн и СВЧ конструкций самых разнообразных объектов, 
необходимых для медицинских радиолокационных приборов, напр. 
измерителя сахара в крови, обнаружителя химических веществ и др. Анализ 
и оптимизация этих радиолокационных систем имеет специфичные 
требования и цели. Управление ДН таких излучателей ясно читает связь их с 
био- и нанотехнологией, созданием сложных управляемых излучаемых 
антенных систем. 
7. Композиция и декомпозиция сложных СВЧ устройств при решении 
задач анализ и проектирования. Решение этих задач актуально, например, 
при моделировании фазированных антенных решеток. Расчет связи между 
элементами антенной решетки охватывает моделирование нерегулярных 
антенных решеток. Уже сейчас ставится задача цифрового управления 
антенных решеток, в которых излучатели имеют сложную форму и 
расположены на неэквидистантных расстояниях. Современные системы 
требуют получения улучшенных фазовых и импульсных характеристик.  
8. Практические аспекты внедрения новых, численных методов 
решения электромагнитных задач в практику проектирования сложных 
радиосис-тем включают решение задач электромагнитной совместимости, 
разноса каналов передачи информации и создания сверхмалых антенн, 
проектирование систем локальной и глобальной радиолокации. Так, 
моделирование носителей многих каналов передачи переноса информации 
(самолеты, корабли) идут параллельно с внедрением дистанционно 
пилотируемых летательных аппаратов, изучением распространения 
радиоволн в комплексной среде.  
 
      К настоящему времени можно сказать, что идея внедрения в процесс про-
ектирования численных методов, реализованных на персональных компь-
ютерах, получает всё более полную реализацию. 
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    К концу 20 века все методы решения получили достойное воплощение в 
программы ведущих компаний мира. Это программы HFSS, CST, MWO, ADS 
и другие. Выход на коммерческий уровень программы FEKO был несколько 
задержан потому, что она была реализована в виде набора карт, что 
затрудняло внедрение её в университетские курсы. Однако появление 
CADFEKO, а главное, мультипольного метода MFLPP, усилило интерес к 
этому комплексу. Поэтому внедрение в процесс обучения системы FEKO  
можно считать завершением важного этапа инженерного образования. 
    Программа FEKO уникальна еще и тем, что освоение её предполагает 
глубокое знание теоретической базы. Всё это ставит FEKO в лидирующее 
положение как в плане обучения, так и в плане внедрения в процесс 
производства. 
  
   Решение одной и той же задачи методами, принципиально отличающихся 
друг от друга, например с помощью метода конечных элементов, метода 
FDTD и метода моментов, приводят нас к той мысли (если решение 
получаются близкими или точно равными), что чисто компьютерное 
моделирование – дает точное решение. Это, возможно, еще одно 
доказательство того, что мир устроен из одного центра, идеи создания мира 
принципиально переплетены и созданы по одним принципам. Надеемся, что 
очерчивание проблем, относящихся к задаче данной книги, будет полезно 
для студентов, научных работников и всех, от кого зависит решение проблем 
инженерного образования. 
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